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Welcome to Behold
 
 

Behold is a program for genealogy that I have designed to change the way genealogists record and use their family
history.

The concept is that you will no longer be input based, and forced to enter your data inefficiently on forms that control what
you do. Instead Behold is output-based giving you the report first - an Everything Report with all your data organized to
be usable, understandable, and useful for you in your genealogy research.

Rather than entering your data on input forms and generating inadequate reports from it, Behold will enable you to work
in your Everything Report and enter all your data  directly into the Report. Behold will provide tools and means to make
the your data entry fast and easy. Behold will work like a word processor that is customized for genealogy.

That's what Version 2.0 of Behold will be - it will be a full genealogy data editor.

However, we are not quite there yet.

Behold is currently a genealogy data reader. It will read your GEDCOM file and produce its Everything Report for you.
You'll find the Everything Report very useful, allowing you to see and use your data in ways you cannot with your current
genealogy program.

Try this version of Behold. If you like it, come along for the ride. You'll love Version 2.0 and editing when that's ready.

Behold runs on Windows 2000, NT, ME, XP, Vista, 7, 8 or 8.1, either 32 or 64 bit. Any computer able to run these operating
systems will be sufficiently powerful to run Behold.

Enjoy!

Louis Kessler
Winnipeg, Manitoba, Canada
e-mail: lkessler@lkessler.com

web: www.lkessler.com
gsr: www.gensoftreviews.com
behold: www.beholdgenealogy.com

mailto:Louis Kessler<lkessler@lkessler.com>
http://www.lkessler.com
http://www.gensoftreviews.com
http://www.beholdgenealogy.com
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The 7 Most Important Things You Need To Know About Genealogy

7. Genealogy Is a Hobby Everyone Can Do

It takes no special skills. You can be any age, any nationality or religion. You can do it for a while and then leave it alone for
awhile and then pick it up again, even years later. You can do it in your spare time, or you might take pleasure in studying
genealogical techniques, going to genealogy conferences, visiting your ancestral home towns, or doing major research.

6. Genealogy Is a Social Hobby

One thing it does is it gets you to talk to people. You talk to relatives to learn about the family. You talk to other researchers
to find out where you might look. You talk to librarians and archivists to get the real goods. You email and join social
networks to communicate to family online. There's nothing like genealogy when it comes to connecting with others.

5. Genealogy Is a Mystery You'll Never Solve

If you like mystery novels or mystery movies, then Genealogy is for you. You have 8 (or more) great-grandparents you
can research. Some you'll find lots about. Other's you'll find nothing. Don't get frustrated. Sometimes it takes years for
the clue to come that answers that one question. Genealogy is a never ending puzzle. Once you find out who that great-
grandparent was and where he lived, then that leads to the question: who were his parents and siblings and where did
they live?

4. You and Your Genealogy are Unique

Every person has their own unique family connections. Your own brother and sister may have the same family lines
as you, but if you marry, then you could very well become interested in your spouse's family as well. Your journey is a
personal one belonging to yourself and sharable in part with your closest relatives and friends.

3. There Is Nothing About Genealogy That Limits What You Search

Heck, you can even do your pet's pedigree, or keep track of your neighbors and their families, or do a study of all people
who lived in a certain town, or do the history of that town, or the history of a house, or research all the people with the
last name Gazorgenplatz, or a single ship crossing. It really is up to you and where your interests lie.

2. It's Your Absolute Duty To Pass On Your Memories - Or They Will Be Forgotten

The only way anyone will be remembered is if someone remembers them. Do your duty and remember your loved ones
and the people that were part of your lives. It's not just about dates and places. It's about the individuals and their lives and
their stories and all the great things that make they who they were. Make sure all your family memories and knowledge
gets recorded before it's too late.

1. Genealogy Is A Lifelong Activity That Is Fun and Addictive and Fulfilling

Once you get started, you'll get hooked. Start when you're young and interview all your great aunts and uncles. Continue
through middle age as you collect information from far and wide. Use your later years to compile everything thoughtfully
and pass on your enthusiasm to the younger generations.
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What Makes Behold Better?
 

 
It Is Report Based

Behold is different than other genealogy programs. Other programs are data-input centric. Behold is data-output
centric. Behold's main view is the Report. Whereas other programs require you to run a report every time you want
to see your data. With Behold, there is no flipping between input forms and output reports, because you are always
looking at all your data all the time.

It Includes Everyone

Most programs can produce Ancestor reports and Descendant reports. Some can do an All-Relative report. Very few can
do an Everyone report. Behold will allow you to view your relatives through marriage, all unconnected lines, and even
will load completely separate files together in the same report. Behold solves the task of displaying these related and
unrelated people in a logical manner. It includes powerful features that let you organize the families in many different
ways and allows you to select those you wish to include.

It Includes Everything!

Many programs produce reports and only export certain information to them. Maybe birth, marriage and death places
and dates. Often, notes and sources are not included. Behold has the capability of including absolutely everything in
your data file. You have the option of selecting what types of data to include and exclude. Since Behold can give you
everything about everyone, I have coined the term and refer to the window as: Behold's Everything Report.

Fully Indexed and Hyperlinked

Indexes of names, places, references, sources, source details, repositories and other custom structures in your data are
all included in the report. They are hyperlinked back to what they refer to. A simple click on the link and you're where
you want to be. The indexes are designed to help you when you research. All your information is presented the way
you'll want to see it.

Useful For Your Research

Behold's Everything Report includes everything you recorded about each individual. Their life interactions with their
spouses, parents and children (also referred to as "Life Events") are all shown together over the course of each person's
life. Events are ordered by date. Ages of each person at each event along with their marriage status and length of
marriage provides you with understanding of your relative's situation at the time. Their siblings are included. Their half-
family and step-family, often ignored in other software, are included. This information is presented like a mini timeline
describing the lives of each person.

Sources Are Very Important

All your sources are included and always shown throughout the Everything Report. The Source Details section of the
Everything Report lists all the sources you've recorded and each source lists every person and event that they were
used for. Recording your sources is one of the most important things you must do in your research. Behold presents
your sources in a useful, usable way that you will appreciate.

Print It All
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As easily as you can look at it on your screen, you can also print it and take it with you. The Everything Report is designed
to look the same in print and be as usable at the research library as it is on your computer. Behold allows a simple, but
flexible numbering scheme to allow you to find things on a printed page where hyperlinks just don't seem to work very well.

Show All of It Concisely

Getting everything is nice. Getting everything in the least amount of space is not easy. Behold's Everything Report
presents your data concisely in a logical manner.  It sure is nicer to print your data on 100 pages rather than 500, and
still there is enough white space that there is room for notes and nothing looks crowded.

Standard Windows Interface

Behold doesn't try to make you learn a new system. I put great care into providing Behold with a standard user interface
that will look like you expect a program to look. There are standard menus in standard places, toolbar icons you'll
recognize and shortcut keys you are used to using. Opening, closing, saving, finding, printing and generally using Behold
will be easy.

Efficiency

It is hard to produce a 500 page report and do it quickly. Even word processors and web browsers choke on documents
that large. But I've spent time much tuning Behold so that it works efficiently and quickly. Behold is one of the fastest
GEDCOM loading programs in the genealogy industry. I test Behold with trees of hundreds of thousands of people to
ensure it performs adequately.

It Has a GEDCOM Understanding

The genealogy software industry is lucky to have GEDCOM (GEnealogy Data COMmunication). That is the file format
that allows data to be transferred from one program to another. You are no longer locked into using one program for your
genealogy, but can transfer your data to another with a GEDCOM file. The problem is that all the genealogy programs
out there each have slightly different implementations of the GEDCOM standard. To be honest, some programs didn't
program all of GEDCOM exactly the correct way, both for input and output. As a result, given any two programs, some
genealogy data will likely not transfer correctly  There is a lot of discussion going on about making GEDCOM better
because of this, but maybe its really a matter of getting genealogy programmers to improve the job they are doing. None-
the-less, Behold is designed to read what I call "Extended GEDCOM". It will read any flavor of GEDCOM output from
any program and display every bit of data that the GEDCOM contains. With Behold, you no longer have to worry that
you are not getting all your data out of your GEDCOM.

Behold's Ultimate Design

The Everything Report was designed with a bigger purpose in mind. Instead of using forms-based data entry of other
programs, Behold will ultimately allow you to enter your data directly into the Everything Report. This will potentially save
you hundreds to thousands of hours by making your data entry as efficient as a word processor. This capability won't be
available until Version 2.0, but when it comes it will be revolutionary ... especially for me, since I'll finally be able to properly
and efficiently enter the masses of genealogical information I've accumulated over the past 20 years. I can hardly wait!
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How Will Behold Help You With Your Genealogy?
 
 

Behold is designed to get you organized, save you time, and help you to do further research.

Get Organized

If you are researching 12 different ancestral lines, 6 possibly related families, all the people from one of your ancestral
towns and your son's wife's family as well, then you already are doing something that most genealogy programs were not
built for. Add to that, the complexity of keeping your source materials organized adds even more complication to the task.

You should at least be able to have a genealogy program that can organize all that information into something usable
and understandable. Printing out 1000 family sheets won't do that for you. Printing all the descendants of one line doesn't
do that for you. Printing all 12 ancestral lines messes you up even more, since many people and the same information
will be on 2, 4, or even all of the 12 printouts. How will you find anyone? You need Behold and its Everything Report.

Save Time

When you can print out Everything and take it with you in a binder wherever you may need it, you have an immediate
reference that will put your facts at your fingertips. The alternative is to tote your laptop with you, start it up, and try to
find the info you need in your genealogy program. Even if you do this, it will still be faster finding your information with
Behold than with other programs.

Why is that? Well, Behold won't make you open different forms for each person, or generate reports to see what you
want, or make you do a complex search that requires you to open each note one-by-one until you've got the right one.
There is one Everything Report and it is easy to find what you want quickly.

Help You Do Further Research

Other than being able to have everything at your fingertips, Behold's will get you organized. It will put all you information
about certain people or families or surnames or places or sources together. You can contact a second cousin and quickly
get everything you've got on their relatives, and know what information you need from them. You can easily see what
records you've already found at a research library, and you will not waste time when you're there by repeating work
you did before.

Lots of Benefits

Behold will help you in many ways, including some that few other programs will do. Rather than list them all here, please
visit the "For You" page at the Behold website, where dozens of benefits are listed.

http://www.beholdgenealogy.com/foryou.php
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Behold's Website
 
 

Behold has an extensive website with a lot of information and resources available for you at: www.beholdgenealogy.com.

To get around the site, click on the items on the menu that you'll find at the top and bottom of each page. The page
you are on will be highlighted.

 

 

Navigation Menu

The menu is at the top of every page. The page you are on is highlighted. You'll find the same menu at the
bottom of every page. Pages include:
•  Home: Behold's home page, general info, current release
•  For You: Problems genealogists have, Behold's solutions and how you benefit.
•  Screenshots: See what Behold looks like.
•  FAQ: Frequently Asked Questions.
•  Download: Where you can download Behold and send for a trial key.
•  Buy Now! A secure page so you can purchase Behold quickly and easily.
•  History: What was added to each past version of Behold.
•  Future: What is planned for the next version of Behold and beyond.
•  Blog: My Behold Blog, where I talk about the development of Behold, programming, and genealogy in general.
•  Forum: Behold's user forum for Q&A, feature suggestions, bug reports and general discussion.

http://www.beholdgenealogy.com
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•  Feedback: Have some feedback for me? Send it from here, and see what others have to say about Behold.
•  ?: Behold's User Guide online.

The Header

This is the header at the top of every page at the Behold Genealogy site. It will let you know you are at the
correct place.

Download

You can download the latest version of Behold from here. You must register your name and e-mail address to
enable a free trial. Or come here if you need a new key.

Buy Now!

Don't wait! Click on this right now!!! Behold uses a third-party, FastSpring, to provide secure online credit card
transactions, and you can also pay by Paypal, Cheque, MoneyOrder or Wire Transfer. Behold has a 60-day
moneyback guarantee, so there is no risk to you.

User Guide

This entire User Guide is available at the Behold website, when you click on the question mark in the menu.
 

Box Shot

Behold is a download-only product right now, but one day you may find it on store shelves in a box like this.

The Way It Should Always Have Been

http://www.lkessler.com/behold/download.php
http://www.lkessler.com/behold/buynow.php
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Behold won't hold you back like other programs. Behold will let you do your genealogy simpler, faster, smarter
and better.

I Need A Name

This is my little Behold guy. He's cute and cheery and reflects my bright outlook towards Behold. I use images
of him throughout my software. I use his image on my postings on web sites. Anywhere you see him, it should
be a reference back to me or Behold.

He still needs a name. Let me know if you've got a good suggestion.
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User ID and License Key Needed
 
 

You must obtain a User ID and License Key to run Behold. Without a License Key, all you can do is view this help file.

Getting an ID and Trial Key

You can register online to get a free User ID and Trial License Key for Behold. This License Key will work for 45 days
and then it will expire.

Click here to register online now.

Better Yet: Consider Purchasing

You can get a permanent key, good forever, by purchasing Behold. You get several major benefits by purchasing Behold
as early as you can:

1. You won't have to put up with the initial info box every time you start Behold or the Buy Now button that is on the toolbar.

2. The current price is the lowest price Behold will ever be offered at!  Version 1.x is $40 US. Version 2.x will be
higher, probably $70. No need to wait. You won't get a lower price by waiting.

3. Behold comes with free upgrades for life. Unlike other programs, you will never have to pay when new versions are
released.

4. Behold comes with a 60 day money-back guarantee. There is no risk involved on your part.

5. I will do my absolute best to give you personal support and answer any and all questions.

6. Your support will do much to encourage me to take Behold to its potential.

Click Here to Buy Behold Now!

http://www.beholdgenealogy.com/download.php
http://www.beholdgenealogy.com/buynow.php
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Purchasing Details
 
 

Everything has been done to ensure that your purchase of Behold is safe and secure.

Secure Transaction

Behold uses the registration service company FastSpring to securely collect payment and send out license keys. Every
transaction is a secure transaction. Your browser should show a small key symbol at the bottom to indicate this.  Your
personal information cannot be intercepted or read by anyone else during a secure transaction.

Privacy Policy

Your name and e-mail address is kept strictly confidential and will only be used to contact you on matters related to
Behold. All other personal information is needed by FastSpring to enable the transaction and is similarly kept strictly
confidential.

Methods of Payment

You can pay by Credit Card (either by secure online transaction, by phone, or by fax). FastSpring accepts Visa,
Mastercard, American Express, Discover and JCB. You can also choose to pay by PayPal, Wire Transfer or in the United
States, by check or money order. Full details about each option is given when you make your order.

If you don't have a PayPal account, then paying by Credit Card online via a secure transaction is a quick and safe method
and is recommended.

Click Here to Buy Behold Now!

http://www.fastspring.com/
http://www.beholdgenealogy.com/buynow.php
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Purchasing and Licensing Info
 
 

Purchasing Behold is a one-time thing. You buy it once and all upgrades are free forever. I want everyone who starts
using Behold to continue using Behold.

I have been quite liberal with how I allow you to use the copy of Behold you have purchased. Please see the licensing
info provided in the License File that comes with Behold. The Help menu of Behold has a link to it.

You can download the latest version of Behold

http://www.beholdgenealogy.com/download.php
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QuickStart
 
 

To start using Behold, you will need a GEDCOM file to open.

A GEDCOM file is a file your current genealogy program should be able to create. Usually, you will find a menu item
in the File menu of your program that will say something like "Export GEDCOM file". The file will usually be saved as
a file whose name ends with the .ged extension.

Once you have a GEDCOM file (it can be yours, or one given to you, or one you got from the Internet, or one of the
sample GEDCOM files that were included with Behold), you can start Behold.  Use the "Open" command from the file
menu and use that to find and open your GEDCOM file.

Behold will process the GEDCOM file and present you with a split screen containing a TreeView and the Everything
Report.

You'll quickly see that Behold is designed to look and feel like any standard Windows application. Most operations should
be obvious. Clicking on a tree item brings that item into view. Clicking on a hyperlink takes you to that link. Most keys
work as you expect: Page Up, Page Down, Copy and Paste, and there's a Find tool that works like you're used to, and
standard menus and toolbar icons that you'll recognize.

The Everything Report is the real gem in Behold. Here you'll see your family all laid out for you, in one comprehensive
indexed report.

There are many options available to customize this report to exactly meet your needs, but you should read the Behold
Tutorial to learn more about that. It covers most topics and gives a good overview of what you can do with Behold.

Behold is very different from all other genealogy programs. There are no forms to enter data into. There are no reports
to generate. Behold is designed to look and feel like a word processor, such as Microsoft Word. The Everything Report
is the report. When Version 2.0 comes out, you will be able to edit and add data directly simply by typing it where you
want - and that will make your data entry a hundred times easier.

So while you try Behold out, you'll see ways it can help you do your genealogy research that your current genealogy
program cannot.

When you're ready for a more detailed look at Behold, try the Tutorial (about 60 minutes). It begins on the next page ...



Behold's User Guide - Tutorial

- 17 -

Tutorial
 
 

Please use this tutorial to get an overview of the various ways Behold can be of use to you. It should take you about 60
minutes.
 
At the top of every page, just below the screenshot, you'll see the words:  "To follow along", which will tell you what to
do.  Or alternatively, just read the Tutorial.
 
Use the "Next page" link to continue ...
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Before You Begin
 
 

Behold is not yet a full-featured genealogy program. Currently it is just a utility program for genealogy. You will still require
another program to enter your genealogy data and export it to GEDCOM before Behold can work with the data.

A GEDCOM file is a type of file that was designed to allow different genealogy programs to transfer data from one to
another. Most genealogy programs can import data from a GEDCOM file and export data to a GEDCOM file. GEDCOM
file names usually have the extension: .ged

Please note what this version of Behold will and will not do:

What the Current Version of Behold Will Do

Behold will read in genealogy data from GEDCOM files, allow you organize the data and see it through the Everything
Report.

Behold will let you view, print and export your data to a few other formats like HTML and RTF (but currently not to
GEDCOM).

Behold will save your settings in Behold Organize files, so you can organize your data any way you want, and then recall
that exact view later.

Behold will allow you to see all your data like you've never seen it before!

What the Current Version of Behold Will Not Do

Behold will not read your data directly from your current genealogy program. You will have to use your program to export
your data to a GEDCOM file so that Behold can read it.  (Maybe this will be possible someday)

Behold will not save data into a GEDCOM file. (This will come in Version 1.1)

Behold cannot save any text editing changes you may make to your data.  (This will come in Version 2.0)

Behold does not allow you to create or add new genealogy data other than text editing changes.  (This will come in
Version 2.0)

Behold does not import pictures. (This is on my list and will come, but after Version 2.0)

Saving, editing, and pictures will all be added in future releases.  (After Version 2.0)

Work on a Mac or handheld.  (This will come as well)

Why is Behold Unique?

All other genealogy programs were designed to help you get your data in. That's great, but only if you can get your data
out again. Behold was designed, first to get your data out. Its Everything Report is a straightforward concept that no other
genealogy program decided to implement. The Everything Report will make working in Behold more like working in a
word processing program than in a genealogy editor.

Behold has powerful data organizing features. You can organize, select, and view families easily. Instant Organize and
Surname Organize or Reorder with a single mouse click. Add or remove Relatives through Marriage. Add or remove
Everyone Else.
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Behold handles the most complex family relationships imaginable. Half-families, step-families and adoptions are well
understood by Behold and are presented logically and understandably. Behold reads all the slightly different types of
GEDCOM files by being more lenient in the GEDCOM rules and not throwing anything away. So Behold will accept all
data in a GEDCOM generated by any program with the best interpretation possible.

But what will really differentiate Behold is when Version 2.0 is developed. That will include editing in-place right on
the Everything Report. Behold will be the world's first genealogy word processor. It will make those limiting and time-
consuming fill-in-the-blank data entry forms of other programs a thing of the past. Unfortunately, I've still got a bit of work
to get there, but I will make it happen. Now, back to today.

The hardest part of designing Behold was to try to make it very user friendly and easy to use. My goal is that you will
find the user interface very easy to learn and pleasant to work with. If you find anything difficult to understand or hard
to do, I'll want to know about it and improve it.

In addition, I've tried to optimize Behold and make it as fast as possible for those of you with large genealogy files
(hundreds of thousands of people) so you won't have to wait forever.

Let's take a look at Behold's main screen on the next page ...
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Starting Behold
 

 
First you need to start Behold.

The simplest ways are:

The Behold Icon

Double click on the shortcut to Behold on your desktop. When Behold is installed, it asks you if you want to
put a shortcut there.

Taskbar

Right-click on the program, and select "Pin to Taskbar" to put it there.

Start Menu
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Right-click on the program, and select "Pin to Start Menu" to put it there.
 
 
 

Note that all the screen shots shown in this Tutorial are from the standard theme in Windows 8.1. If you have another
version of Windows, or have installed your own desktop theme, then some of the windows will have a different style.
But the windows will each have the same content, and this tutorial should still be easy to follow.
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What you First See
 

 
When you first start Behold, you will be greeted by the screen shown above. This is how Behold will look with no data
loaded.

The interface of Behold is designed to meet Windows standards. You should find the layout, placement and use of most
of the controls to be similar to other Windows-based programs. This familiarity should make Behold simple and easy
for you to use.

The Title Bar

Windows programs have a title bar at the top. Ours shows Behold's cute little sun icon, the program name (Behold)
and the name of the file if one is loaded. To the right are standard Windows controls for minimizing, maximizing
and closing the window.
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The Menu Bar

The Menu should have entries that are familiar to you, and they lead to the actions of everything you can do in
Behold.

Two Rows of Toolbars

A lot of the menu items also have toolbar equivalents. Pressing a toolbar icon will do the same thing as its menu
item. Not all the menu items have a toolbar icon.

TreeView

The TreeView gives an outline of what's in the Everything Report. We'll show you it very soon. The TreeView
can be oriented to the left or to the top of the Everything Report, whichever you find more convenient.

The Everything Report



Behold's User Guide - What you First See

- 24 -

The Everything Report contains, well, everything - once your data is loaded. You can specify what not to include
if you don't want everything.

The Status Bar

The Status Bar show messages, tooltips (when you point your mouse over something) as well as some status
indicators on the right.
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Loading Data into Behold
 
 

To get started you will need to load some genealogy data into Behold.

The standard for transferring genealogy data between programs is known as GEDCOM. It is a format that most genealogy
programs can input and output. Please pronounce it as "Jed-com", with a soft-g and not a hard-g.

If you want to use your own genealogy data to test Behold, then you will have to use your current genealogy program
to export its data to a GEDCOM file. Normally, in your program's File menu, there should be an menu item to export
to a GEDCOM file. If it is not there, you will have to consult your program's documentation to see how to do it. Then
remember the directory the GEDCOM file is placed into.

For convenience, Behold installs with two sample GEDCOM files that you can use if you don't have a GEDCOM file of
your own. On Windows 8.1, these files are put into the "\Users\Public\Documents" section of your computer under the
"\Behold\Sample Files" directory. This Tutorial will use these sample files.
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Associating Files
 
 

 
Behold gives you the ability to change the program now associated with GEDCOM files so that Behold will be the default
program used. The advantage of doing this (other than getting those cute little icons) is that it will allow you to simply
click on one of those icons in Windows Explorer or other programs and Behold will start up and load that file.

You can change the association by selecting Associate... from the File menu, and the above window will appear.  Try
opening the associate window now. Close it once you're done.

Cute Icon

The icon represents the file or program that is associated with a certain file type, in this case, files with the .ged
at the end of their name. You may not see the .ged on the end of your file names because by default Microsoft
wants to hide things like that from you. But trust me, most files have extensions on their names to increase
their usefulness.

Behold Organize Files

You may not want to change the GEDCOM file association to Behold if you use another program for your
genealogy editing, since you may want that program to open when you click on a GEDCOM file icon. But you
probably should associate Behold Organize files (with the .bho extension), since there are no other programs
of any type that I know of that currently use the .bho extension.

Use Previous Association button



Behold's User Guide - Associating Files

- 27 -

Whatever your decision, Behold saves the previous association of both .ged and .bho files and you can go
back if you want to.
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Opening a GEDCOM File
 

 
Select the Open command from the File menu. If you prefer using the Toolbar or shortcut keys, the ones to use are
shown in the menu next to the command. For example, the Ctrl+O key (reads: hold the Ctrl key down and press the
letter O) will do the same as the Open command.
 
The above Window will then appear. If you are just starting Behold for the first time, it should open to the Sample Files
folder. If you have used Behold for other files already, it will open up to wherever it was that you last opened a file. In
the latter case, try to find the Behold Sample Files directory, and then you'll be able to follow along in this Tutorial.
 
When you're finished with this page, double click on the Steve McCarthy Legacy.ged file to open it, and go to the next
page of the tutorial (Data is Loading)
 

Sample Files

The sample files shown are normally placed in your Public Documents directory under "\Behold\Sample Files".
These are files supplied by users of Behold with their permission. They are wonderful examples of genealogy
data files produced using two different programs, Legacy and PAF, and contain a wide assortment of genealogy
constructs. They are great files to help illustrate what Behold does. Feel free to load them into other genealogy
software that you have and compare how you view the data in the other software to how you view the data
in Behold.
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The location of the Public Documents directory may vary depending on the version of Windows you have. In
Windows 8 and 8.1, it is the C:\Users\Public\Documents\Behold\Sample Files directory.

The "Customized McCarthy.bho" file won't be there when you first start Behold. It's a Behold Organize file. You
will create it later in this Tutorial.

Filetype Selection

You can select what files to display in the Open dialog. The dropdown list contains:

Normally, you'll want to select both Behold files and GEDCOM files to be displayed, since these are the files
that Behold can open. You may want to select just one of them, or maybe you want to see all files.
 

These Cute Icons

These cute icons will be shown in the Open box if you associated Behold with .ged and .bho files in the previous
step (Associating Files).
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Data Is Loading
 

 
Look at the right side of the status bar at the bottom of the screen. You will see a progress meter, a
small icon, and two dials:

Progress Meter

The progress meter will be useful for larger files that take longer to load. Files with a few thousand
people or less will load very quickly and the progress meter will go so fast you won't be able to
follow it. For very large files, the meter may prove useful.

Stop Button

If you try loading a very large GEDCOM file and see the progress meter and decide it is taking
too long, you can press the Stop button that is on the Toolbar.

Memory Dials

Hover your mouse over each of the two dials, and they will display more information. The left
dial shows the amount of RAM being used on your machine by all running programs, including
Behold. The right dial shows the amount of Swap file space used on your machine by all running
programs, including Behold.

If both of these dials turn red while Behold is loading, then your computer is out of memory and
may not be able to load the rest of the GEDCOM file or will do so veeeeerrrrrrryyyyyyy slowly.
Behold needs a lot of RAM and/or Swap file space to load its data. If that happens, then it may
simply be that your file is too big for Behold to load on your computer. Sorry. but your program
probably won't open a 5,000 page Word file either, which is sort of what Behold is trying to do.
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If you have at least 512 MB of RAM, which most computers do, then you should be able to load
extremely large GEDCOM files.

Oh and by the way: those little memory dials are fun to use. Behold with no data loaded takes
very little memory. You can run Behold in the background and see how much memory your other
programs take as you load them.

Internet Connected

The small icon between the progress meter and the two dials indicates if Behold has checked for
an internet connection. Behold will only retrieve information from the internet if you ask it to do
something requiring that (e.g. Link to Behold website, or check for new version.)  Behold NEVER
sends any information from your computer to the internet. While I mention that, I should also
mention that Behold is perfectly safe to run. It contains no adware, spyware, viruses or malicious
software of any type and never will.
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Log File
 

 
Behold produces a log file that reports any errors and warnings Behold encounters when it reads the data from a
GEDCOM file. It saves the log file in the same directory as the input file, and gives it the same name with ".log" appended
to the end.

Behold does not display the log file by default, since you will not need to see it too often. But it is useful to look at it
the first few times you load new data, so you can go back to the original data source and correct any problems Behold
might have found.

To view the log file, you can either select "View Log File(s)" from the View menu, click on the log file icon on the toolbar

, or press the F11 key. This will open up the log file using the default program for text viewing for your computer.
Usually that is Notepad.

If you have more than one GEDCOM loaded then several log files will open - one for each GEDCOM.
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Viewing the GEDCOM file(s)
 
 

 
You can view the GEDCOM files that were input. Normally, this is not something most people will want to do, but the
capability is there if you want to track down some of the warnings Behold may be reporting.

To view the files, you can either select "View GEDCOMs" from the View menu, click on the GEDCOM file icon on the

toolbar , or press F10. This will display the input files using the default program for text viewing for your computer,
as shown above. If more than file was input, then all of them will be displayed.
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Viewing Your Data
 
 

 
After you open the Steve McCarthy Legacy.ged file into Behold and you should see the screen above.

In order to display more on these small screen shots, the text size has been set to "smallest". You can set the text size
to what you want by selecting "Text Size" from the View menu.

TreeView
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Half of the main window contains the TreeView.

The TreeView should look familiar to you because many other Windows programs (but not too many genealogy
programs) make use of it. It is basically an outline of all the data in the Everything Report.

Any entries with a "+" before it can be expanded by clicking on the "+" or double clicking the text. Once expanded,
the "+" turns into a "-" and it can be collapsed.

The number in parenthesis after each entry shows how many entries in total are hidden under the "+" that can
be expanded. This is different than the number of items in a section, so don't think that there are only 52 names
in the Name Index.

The TreeView's main use is to quickly navigate through the Everything Report. When you click on any TreeView
line, the Everything Report will scroll to the corresponding information.

Tree on Top

The TreeView can be placed either above the Everything Report, or to the left of it, depending on your
preference.

You can flip it to the top by either selecting "Tile Top and Bottom" from the View menu, or by clicking on this
toolbar item.

Tree on Left

You can flip it to the left either by selecting "Tile Left and Right" from the View menu, or by clicking on this
toolbar item.

The Everything Report
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Behold's Everything Report is the central focus of Behold and is the tool that should help you in ways that other
program's reports cannot.

The Report has three parts:

1. The Heading and Table of Contents
2. The Information Area, and
3. Structured Indexes

Most genealogy programs have two basic reports and variations of them:
  (1) all ancestors of a given person, and
  (2) all descendants of a given person.

But very few programs can show you all relatives of a given person. To do this, you need to show all descendants
of every ancestor of a given person. This is what Behold does. In our example, Behold found that there were
eight ancestors of Stephen James McCarthy whose descendants would consist of all his relatives.

To do this example with other programs, you would have to print out 8 descendant reports - and then you would
find that a lot of the people would be repeated twice, three times, or even up to eight times. Stephen James
McCarthy and all his descendants would be in every descendant report, so he and his descendants would all
be repeated eight times. If you had a genealogy that started with 32 ancestors, then you'd have a real mess.

Behold doesn't do this. When Behold encounters the same person again, it simply lists the person and puts a
cross reference to the earlier occurrence, so the data is not repeated.

Also, Behold is not limited to showing only one family. Behold can show as many families as you want. In the
case above, Behold is showing two families: the relatives of Stephen James McCarthy, and the relatives of
his wife Dianne Marie [Jack] McCarthy. In this dataset, Dianne's relatives were not included in the GEDCOM.
But if they were, they would be listed here starting with all her ancestors. Any crosses between her family and
Stephen's family would be taken into account with cross references so no data would be repeated.
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Everything Report: Heading
 

 
At the top of the Everything Report is a Heading section. The heading shown here is a typical heading produced, but
you can customize the heading to say what you want.

Main People

The main people of the report are listed. By default, Behold starts with the first person in the GEDCOM file
and his/her spouse(s). Behold gives you powerful ways to easily change the main people (described later), but
usually the first person is the one who is central to the data and is of most interest.

This selection of the first person to organize about is Behold's "Auto Organize" function. When you get someone
else's GEDCOM, this functionality usually will allow you to immediately and easily see the important families
and central people who are being researched.

Author and Date

Your name and the current date is included.
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Everything Report: Table of Contents
 
 

 
The contents of the Everything Report is listed at the top of the Report. This is most useful when printing, as it will help
you quickly find who you want.

Families

 
Behold organizes people into useful groups that can vary depending on which method of organizing you do.
The above example shows the default Auto Organizing that groups all the relatives of Stephen James McCarthy
together and all the relatives of his wife Dianne Marie (Jack) McCarthy.

We refer to these two major groups as Families. We have the Family of Stephen James McCarthy, and the
Family of Dianne Marie [Jack] McCarthy.
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Within each of the major groups, there are subgroups. These subgroups can vary depending on which method
of organizing you do. The above example shows the default Auto Organizing that divides the major groups
(Families) into subgroups defined by their common ancestors. Each subgroup will contain the one branch of
the family beginning with the branch's earliest ancestors and including all their descendants. This is shown in
the Contents as: "Descendants of xxxxx".

For example, the relatives of Stephen James McCarthy (his family) are divided into:
- Descendants of ??? McCarthy
     (Stephen's great-great-grandfather on his father's father's father's side)
- Descendants of Jeremiah DONOVAN and [MARY] DONOVAN
     (Stephen's great-great-grandparents on his father's father's mother's side)
- Descendants of Albert W. BAILEY and Elsie L. [CHUTE] BAILEY
     (Stephen's great-great-grandparents on his father's mother's father's side)
- Descendants of Michael NORTON and Mary [BRENNAN] NORTON
     (Stephen's great-great-grandparents on his father's mother's father's side)
etc ...

This particular GEDCOM file does not include any ancestors of Stephen's wife, Dianne Marie, or they would
be listed with "Descendants of ..." following her name.

Hyperlinks

All items listed in blue in the Everything Report are hyperlinks. Clicking on them will take you to their location
in the Report.

You will find hyperlinks throughout the Everything Report, as they are used for all sorts of cross references.

Mouse over

When you place your mouse over a hyperlink, the cursor changes to a pointing hand and the link changes color.
Then you know you the mouse is positioned correctly and ready for you to click.

Numbering

People are assigned numbers by Behold. The numbering is designed to help you find the people in a printed
report, and to give you visual clues as to which family the person belongs to.

Later in this Tutorial, the Organize pages will be described where you can change what Behold shows in its
numbering.

What's Missing?

You will notice the ??? as the ancestor's first name. In this case, the GEDCOM has defined a family without
creating the individual for the family. Behold creates the individual and this becomes the ???.
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Sometimes you'll find ??? names, places, or record types should be. These are names, places or record_types
that were not specified in the genealogy data. By default, Behold replaces these with ???. You can change what
is displayed for these unspecified items in the Organize Report page.

The Name Game

Note that Behold, by default, displays names differently than other programs. The last surname a person has
is shown at the end of the name, and all previous surnames are shown in parenthesis ().

This is contrary to the way genealogy standards say it should be done. They declare that the only first surname
of a person should be shown and none of the others. Anne would be shown as Anne Connors. This may be fine
for purists, but if you are sending your information to relatives or even using it for yourself, you simply cannot
recognize many people by just their birth surname. If you only knew them after they were married or after they
changed their name, then that it the name you will know.

In the case of Anne, she was born with the last name of Connors, and then married William Lynch. If she had
married someone prior to her marriage to William, her previous name would be shown in the square brackets
following her birth surname. By presenting all known surnames, the different connections can be easily seen.
Also, each person is indexed in the Name index once for every surname, so you can always find them no matter
which surname you know them by.

If you want the traditional method of only including birth surnames, you can uncheck the "Surnames: Show
married names" setting on the Extra Info options for the Organize Report page. This will also prevent the married
names from being added to the name index.

The Rest of the People

If you really want everyone in your Everything Report, then you have to include those people who are not in
the Families you asked for.

Behold by default and as an option, allows you to group all those people who are related through marriage to
a relative to be included in a special Family appropriately called "Others Related through Marriage"

Behold also allows you to group all the remaining people together into an Everyone Else group, which is given
the heading "Other Families that are not Directly Related".

In the example above, Ruth ABRAMS is the mother of Maurice Michael BARRY. She is only related through
marriage because her son, Maurice Michael Barry married into Stephen's family.

This particular file has no other families that have not been included, so the heading "There is No One Else" is
shown instead of an "Other Families that are not Directly Related" section.

How you go about specifying what families to include will be described later in the Tutorial under Organizing
Your Data.
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What a Capital Idea

You will notice that the surnames in this file are capitalized. Behold does not change the way the names are
displayed. If they are capitalized in the GEDCOM file, then Behold displays them capitalized. If they are in
mixed case in the GEDCOM file, then they are displayed the same.
 
It just so happens that this sample file has capitalized all the surnames. Some genealogists enter them this
way with the idea that it will make the surname stand out. But it is not recommended, because it makes
it more difficult to ascertain the proper capitalization of the surname. In this example file, most surnames
were entered as all capitals. Howeer, the McCarthy name was entered as "MCCARTHY" but as a hybrid
"McCARTHY", likely because it looked better.
 
I had thought of adding an ability to show surnames decapitalized in Behold, but this is not simple to
implement because of differing rules in different cultures and the requirement to enumerate exceptions (e.g.
McCarthy, StAmant, BenAmi). I decided it is better to display surnames as given, and then any errors or
inconsistencies in the data will become apparent in the Index of Names. Then it can be corrected where it
needs to be corrected: in the data itself.
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Everything Report: Information Area
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From the Table of Contents, click on the Descendants of William Thomas LOCKNEY and Alice (HEMSWORTH)
LOCKNEY RM-5 line as highlighted in a violet color on the previous page of the Tutorial.

That willtake you in the Everything Report to the information about William and Alice and their descendants, as shown
above.

Behold has no internal limits on the amount of information that can be displayed. Notes can be any size. Names, places
and identifiers are shown as they are in the input file.

Descendant Title

Each Descendant section is listed in the Table of Contents. Each section begins with the two people (or one if
only one is known) who are the ancestors of this line.

Horizontal Lines

The horizontal lines delineate the information about a person and their partner/spouse (if they have one). To
the right of each line is the number assigned to that person and their partner/spouse.

The Individual

 
Each person has all their information shown below them. The person's IDs from the GEDCOM file are given
but are by default hidden.
 
Each person is followed by their partner/spouse and their children, children's partner/spouse and all other
descendants.
 

Hidden Tags

 
All information that has a grey color (rather than black), is information that is hidden. But you can see it!
Maybe you can, maybe you cannot. That all depends on what the setting is for the "Selected/All Tags" option
on the View menu, or the equivalent toolbar item that looks like a checkbox:

      
 
If that toolbar item is selected (pressed in), then all the hidden tags will be displayed in grey. If it is
deselected, then the hidden tags will truly get hidden.
 
However, you often don't care about many of the tags. You probably don't care about the duplicated name
information or internal ID numbers. So Behold allows you to hide the data that is not relevant to you with the
"Selected/All Tags" option.
 
Behold has by default set each tag as to whether it is selected or not. These settings are on the Organize
Tags page. You can modify them as you desire and save the settings you want into a Behold Organize file for
future use. Saving to Behold Organize files is described later in this tutorial under "Organizing Your Data".
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The reason why hidden tags are shown is so that Behold's Everything Report can truly show everything.
Nothing from your input data is omitted when hidden tags are shown. Also, when you print or export to a file,
*ONLY* the information displayed is printed or exported. You must be able to see the tags, even if they are
only in grey, for them to get printed or exported. That way you'll always know what you'll be getting.

 

Events and Facts

 
Each event and fact for the individual is shown, with the person's name, sex and birth event first, and the person's
death and post-death events (burial, cremation) last. Other events are between, ordered by date whenever a
date is given.

Events and facts about the individual are all presented together fore every individual. This provides each
person's life story almost like a personalized timeline.

"Family" information about the individual and their partner/spouse such as the marriage or the birth of the son
is also included. For the family information, the first indented line begins with the words: "With husband...",
"With wife..." or "With partner..." and then gives the information about the partner at the time. The shared family
information is also included with the partner/spouse, but the viewpoint there becomes that of the partner/spouse.

Behold gives you ways to customize how each item of information is displayed. In this example, a BIRT tag
is displayed as "Birth:". A REFN tag is displayed as "Reference:". The way you can change these options is
described later in the Tutorial in the section on Organizing Your Data.

Items in blue are all hyperlinks of individuals, places or sources. Clicking on them with the mouse takes you
to their location in the Everything Report.

Life Events

 
Behold can show what we call "Life Events". These are significant events in the life of the individual that are
important to them since it involves a spouse, parent or child. Often the source information for those events
also have important information about the individual, and it is good to cross check that information. This cross
check is often overlooked by many researchers because the information is not easy to compare with most
genealogy software.The events that are shown include birth, adoption, marriage, divorce, death, christening,
graduation, immigration residence, census and a few others.
 
Life events are shown from the perspective of the individual. The first line of each life event lists the
relationship of the person the event is about, e.g. the first son of the individual. It then lists the event that
person was involved in, e.g. the son's marriage. It then lists the date of the event, and the age (not of the son
but) of the individual at the time of the event. If the individual was married and the date of marriage is known,
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then the length of marriage and spouse's name at the time is also shown. This is followed by the place the
event took place.
 
The next lines are indented and contain the information about the person/people involved in the event and
their ages and marriage status at the time, and that is followed by the rest of the information about the event,
also indented.
 
Notes, sources and other information about each life event is displayed. Much of this information is relevent
to the individual, and may give you clues to help understand your relative's life.
 
The relationship and event type at the beginning of life events are in green text so you can easily identiy
them. You can turn life events on and off easily by pressing the red heart on the toolbar.

   
 

Notes, Objects and Sources

Any notes, objects or sources for an event are shown together at the end of the information for the event. Notes,
objects or sources for an individual or two partners are shown together at the end of the information for the
individual.

Survived by; Would have been

 
A very helpful section, known as "Survived by", is added after a person's death event when the death date
is known. This can be thought of as an "Obituary report". People who were known (due to death dates)
or presumed (due to generation) to be alive at the time are listed. They are listed in the order that most
obituaries would list them, with spouse followed by children and grandchildren. This is very useful if you have
the obituary, you can match the people in the listing and see who is extra and who is missing and use it to
correct your data about them..
 
If the person is still living, Behold gives the following line instead:

    
It gives the date of the run and the age and marriage status of the person at the time.
 
If the person's death date is not given, and the would have shown the person to be, say 183 years old, which
is really silly, then it shows the following instead:

     
 
The settings for what age to use can be set in the Report Options page, described later in this Tutorial.
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Last Update

If your genealogy software keeps track of the date it last updated this individual, then Behold shows it. This is
valuable to show in reports and makes it quickly apparent why recent events are not included. Once editing is
added to Behold, Behold will keep track of this for every individual whenever you edit them.
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Links Everywhere
 
 

 
In the Treeview, select Name
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Behold has no internal limits on the amount of information that can be displayed. Notes can be any size. Names, places
and identifiers are shown as they are in the input file.

The information above is shown with the display of hidden data turned off. If hidden information display is turned on,
then you would see additional lines in grey color.

People Links

Clicking on the link for any person will take you to that person in the Everything Report. 
 

Place Links

Clicking on the link for any Place will take you to that place in the Place Details section. The Place Details
section lists and links back to every referencing person/event for every place.
 
The default keyword for displaying a place is the word "in". You can change this on the Organize Report
Options page.
 

Source References

Source References are shown with a hyperlink to their location in the Source Details section. The complete
description of the source reference is shown. The Source Details section lists and links back to every
referencing person/event for every source.
 

Object Links

Links to objects on one's computer, website addresses, urls, or email addresses are all hyperlinked. Clicking
on the hyperlink opens the helper program to view that particular object. That might be your picture display
program, your web browser, or your email program. Behold sends the link to Windows, and Windows uses
the suffix of the file (e.g. ".jpg") to figure out which program to use.
 

Note Links

Most notes are usually unique, used once. Those are shown in normal text and are not linked to anything.
But some notes may be shared notes. Shared Notes are linked to the Note Details section. The Note Details
section lists and links back to every referencing person/event for each shared note.
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Marriages and Relationships
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Now go to the treeview. Click on the plus sign beside "Family of Stephen James McCarthy" to expand it. Then expand
"Descendants of ??? McCarthy". Then expand "1. Theodore and Margerett". Then expand "2. William and Mildred".
Finally, click on "s. Adelaide Helena and William Thomas". That should load them into the Everything Report and Behold
should look like the above screen shot.

Cross referencing is used to prevent duplicating the same data more than once in the Everything Report.

Re-marriages

If a person marries more than once or has multiple partners, then that person is shown again with an
"r" (remarried) before their name. This pairing is given a separate entry so that information about their other
spouse/partner and their children and descendants can be displayed. This allows half-families (one parent in
common) to be included and shown just after the associated marriage.

If a spouse/partner of a person remarries or has a new partner, then the spouse/partner is shown with an "s."
before their name. In the Everything Report, the marriage/partner of this "s." person will be shown as "sm.".
This allows step-families (parent of one married the parent of another) to be included and shown just after the
associated marriage.

Numbering and Labeling

In the Treeview and Everything Report, children are numbered by date of birth (first born to last born), or in
the order given in the data file when a birth date is not provided.

 
One entry in the Everything Report groups each person once with each of their spouses/partners. This way,
all their co-descendants can follow, and both parents information can be given together. The spouse/partner
is not prefixed by a child number, but is prefixed instead by "m." which logically means married. It is simply
identifying the spouse or partner, so you can alternatively think of it as meaning "married", "matched" or
"mated". Remarriages are prefixed by "r."
 
These are the various prefixes used:
     #. - a number indicates a child
     m. - the spouse or partner of the child
     m#. - the #'th spouse or partner of the child, where # > 1.
     r. - the child again in a remarriage or repartnership
     s. - the spouse or partner of the child in a remarriage or repartnership
     sm. - the person in a remarriage or repartnership of the spouse or partner of the child
 
Only the prefixes #, r and s are shown in the Treeview, because the spouse/partner is listed on the same line.
But all prefixes will be used in the Everything Report.
 
These prefixes may be changed in the Organize Report options.
 

Cross Referencing
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When one person is encountered a second time, their information is not shown again, but a cross-reference is
included for easy access back to where their information was given. You can see this in the above example.
The information about Adelaide Helena was first displayed where it was given the number MCC-12. For her
remarriage to William Thomas, she is displayed again as MCC-47 with the statement "see above" being a
hyperlink to take you to the earlier reference. But William Thomas was not displayed before, so all his information
is shown. Their children would follow.

But if William Thomas had been displayed before, then he would also be given a cross reference. In that case,
Adelaide and William's children also would have been displayed before, and they are not shown a second time.

To find every place that a person is referenced, you can use the Index of Names, which lists and provides
hyperlinks for every cross reference for each individual.

Relationships

 
When Behold refers to other people, it uses their relationship to the person in question.
 
The relationship will be generic if no sex is given for the relative, e.g.:

parent, spouse, child, sibling
 

Or it will be sex-specific if the sex is known for the relative, e.g.:
mother, wife, daughter, sister
 

If there is only one relative with a specific relationship, then no number is added on the end, e.g.:
father, husband
 

But if there is more than one relative with the same relationship, then numbers are added on to the end of all
of them to allow you to easily differentiate and identify one from another, e.g.:

father 1, father 2, husband 1, husband 2
 

The names of all relationships can be changed from their defaults on the Organize Report options page.
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Life Events and Ages
 

 
Let's look at another person.  Go to the treeview. Click on the plus sign next to "Descendants of James V. Lannan"
to expand it. Then expand "1. James and Ellen". Then expand "2. Nathanial and Margaret". Then "2. Thomas and
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Adelaide". Finally, click on "3. Eleanor and John Joseph". That should load Eleanor into the Everything Report and
Behold should look like the above screen shot.
 

Parents

 
Parents are listed after the person's birth. If the date of the birth is known and the parent's birthdate is known,
then their ages at the time of the birth are shown. If the date of the parents marriage is known, then the length
of their marriage at the time of birth is shown.
 
Other sets of parents (adoption, foster parents) included in the data will also be shown, along with the event if
the association is known, or after the first set of parents if the association is not known.
 

Older Siblings

 
Older siblings will be listed after the parents along with their age at the time of birth, if the age can be
determined.
 
If one spouse had children from a previous marriage, then the step-siblings will be listed, along with their age
if determinable.
 

Marriage and Children

The marriage and listing of children are always included (when known). They are not considered to be life
events, since they pertain directly to the main person Eleanor. This is Eleanor's marriage and Eleanor's
children.
 
Note that no dates or ages are given. In this dataset, the marriage date and birthdates of the children were
not included. Events are included in date order, but when no dates are provided, they are included in the
order they exist in the file, so these happen to be placed first.
 
The children in this file do not have birth events, so simple entries for the child are included and follow the
marriage. Behold will present as much information as it has. If something looks strange in its output, then
likely there is something left out or strange about your data that you should look at.
 
If no date exists for an event but you can estimate a date, e.g. ABT 1843, or BET 1840 AND 1850, that will
allow to add ages and lengths of time related to that event. This will give you comparisons (i.e. family ages)
that will help you evaluate the validity of the date and focus the years you might search for records. Just
remember to document your reasoning behind why you think those dates may be likely.
 
If a spouse had children from a previous marriage, then stepchildren and their ages at the marriage will be
shown following the marriage. You saw this on the previous page of this tutorial.
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Using Life Events

 
Above are four life events, two from the father and two from the mother. They are all on the same date and
Eleanor is shown to be 9 months old at the time. The father is 32 and the mother is 30. They were married 11
years. Missing is Eleanor's Census record. If she is supposed to be 9 months old, she should be listed in the
Census and that record should be checked again.
 
Information from life events, comparing dates, ages, places, notes and sources, will often turn up
inconsistencies that need to be checked and corrected, or may give clues as to additional research that could
be done.
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Everything Report: Structured Indexes
 
 

 
Following the Information Area are the Structured Indexes.

Other than the Index of Names, these are not indexes in the traditional sense, because they include extra details
pertaining to their objects. Places contain place information. Repositories specify where you find your sources. Sources
include all source details within each source. File Information and Submitter give GEDCOM specific info contained in the
GEDCOM headers combined with other information about the file.

Some genealogy programs add their own customized record types to their data. If they export this data as new GEDCOM
records, then Behold will also list them here, with each customized record type in its own section. The Event Definition
Details is a customized record type in this sample data.

The Note Details section will only appear in files with shared notes (notes that are used in more than one place).
They are not discussed in this short Tutorial but are defined, along with Object Details, in the Reference Guide of this
documentation.
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The Index of Names
 
 

 
The first structured index is the Index of Names.

Primary Reference

Every person will have a cross reference to each of their occurrences in the Everything Report.. If you want
to get to the first occurrence which has all the info about them, then clicking on the person's name will take
you there. The first occurrence is the primary reference, and that is where you will find the detailed information
about that person.   

Other References

If a person is in the report more than once, then references to the other locations will be shown. For these, you
click on the number to be taken to that location.

Every Surname Indexed

A person is entered into the index once for every surname they have. Esther Catherine [BAILEY MACKERRON]
McCARTHY is entered under Bailey, under MacKerron, and under McCarthy.
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Birth and Death Years

After each name in parenthesis are the birth and death year of the individual if they can be derived from that
person's data. Showing this in the index helps you identify the correct individual more easily when they have
identical or similar names.
 

First of the Line

People who are shown in bold blue text have no parents in the data file. This means they are the first one of
their family line. In the case of our example of Elsie, she would be the first one in her family with the surname
"Chute".
 
The people highlighted will not only include all the earliest ancestors in the file, but they will also include many
spouses who marry into the family and don't have their families included.
 
However, it is still a good indicator of who might be the earliest ancestor with a specific surname. For
example, it is easy to see under the Bailey surname that Albert W. Bailey must be the earliest ancestor.
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Place Details
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Place Details shows all the events and facts that occur at each place, and all the people that took part in each event.
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They are ordered in reverse hierarchial order and are listed alphabetically using a smart-address sorting algorithm to
order numbers and addresses correctly.

This will be very helpful when you do research on a specific place. You'll see what birth, marriage, death and other
information you already have.

Place Subdivisions

Genealogy programs subdivide place entries into 3 or 4 levels separated by commas, as in "City, County,
State, Country". Behold uses whatever format was entered for places in the genealogy data, and reverses them
according to the commas, and sorts the index that way.

Most programs do not have good tools to help you enter place names consistently. This is one of the many
ways Behold can help you identify problems with your genealogy data. You can easily scan your place names
to see which ones are not specified correctly. For now you have to fix them in the genealogy program you use
for editing. When version 2.0 of Behold comes out, you'll be able to fix them by just typing the correction once
in the Place List, and it will be immediately fixed for every entry given.

Events and Facts

 
Events and facts are listed in order of the date they happened or strarted on, beginning with undated events
and facts. The event or fact type is shown first, so that it can be picked out easily. This is the best format for
research, since you can use it to thoroughly compare the information you have with a certain set of records,
e.g. the marriage records for a town.

People Associated

 
All the people associated with the event or fact that took place on the given date at the specified place are then
listed. Their name is a hyperlink back to the information about them. Their age at the time of the event is shown
(if determinable) as well as their length of marriage and spouse name (also if determinable).

Event or Fact Details

The same details about the event/fact that are shown with the person's information is also shown here. It will
include all notes, sources, objects as well as everything else associated with this particular event/fact at this
place.
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Repository Details
 
 

 
A repository is where your source material originally came from and can be found. It may be a library, a public records
office, an old photo album at Aunt Judy's house, or a website on the Internet. I personally hate the word "repository". It
sounds like a certain pill you take to help you go to the bathroom ... but that's what genealogy calls it.

Repositories are listed in alphabetical order by the name of the repository.

Link to Sources

Each repository lists all the individual sources that came from that repository. Clicking on the source name will
take you to the Source Details for that source.
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Source Details
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When recording your genealogical information, it is very important to always document your sources. If you've done this
properly with your genealogy software and exported that information into a GEDCOM file, then Behold will produce a
complete list of sources and source details for you that you should find quite useful to refer to.

Each source provides you with information. For each bit of information that you use, you should have a source detail that
lists the specific location where it is within the source. The location may be as simple as a page number, or it may be
a detailed identification. For example: If a book is the source, then the book plus the page number might be the source
detail. If your great-aunt was the source, then she along with the date and place of the interview and you being the
interviewee might be the source detail.

Source Information

The information about each source is listed alphabetically using a smart sorting algorithm to order numbers
correctly. The sources are then numbered sequentially, S1, S2, ...

Repository for this Source

This is where the source was or can be found. Click on the Repository number (R11) to go to that Repository's
details.

Source Reference

A source may contain may different records, pages or items. A Source Detail refers to a specific record, location
or item within a source. Some refer to these as citations, but this documentation will call them source details.

Source details are shown for each source are shown indented and are sub-numbered, S1-1, S1-2, ...

The source details from each source are listed alphabetically using a smart sorting algorithm to order numbers
correctly.

Events and Facts

Each event and fact along with its date and place are shown for each source record.

People
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The people involved with the event are listed.

 

Notes, Analysis & Reasoning

 
The link from the event or fact to the source may contain an evaluation of the quality of the source, analysis
of the source material and/or reasoning used to come to the conclusion. If your genealogy software allows
you to attach notes to your source references, do it, and they should appear here. This is the perfect place to
document why you think your conclusions are correct.
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File Information and Submitter Details
 
 

 
The last sections of the Everything report contains File Information and Submitter Details. Most genealogy programs
store information about the program used, the author and the date of the file along with its genealogy information. Behold
lists that information in these sections for all the data files that have been loaded.

Input Files

 
Each file that is included in this Behold run is listed in the File Information and is numbered sequentially: F1,
F2, ...
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GEDCOM Header Info

 
Information from the GEDCOM HEAD record is listed.
 

File Details

 
This is information about the input file as determined by Behold. It includes physical file information, as well
as counts of the number of people, families, sources and repositories.  More detailed count information is in
the log file.
 

Message Summary

 
Important messages are then listed. These will indicate if Behold finds possible problems with your data. Click
on the link to the log file to get detailed information about each message.
 
Note the first message about the CONC tag. That is the GEDCOM tag to CONCatenate a line onto the
previous line. The GEDCOM spec says that a word must be split in two over the two lines, but some
programs do it incorrectly and concatenate at the end of a word. Unfortunately, the input file does not say
which way it is done and it is not possible to always determine from the file itself which way was used. So
Behold maintains a table of which programs do it which way. Some items in the table may be wrong, but
Behold gives you a way to fix it if it is, as detailed in the message.
 

Submitter Details
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This is the information from the SUBM (Submitter) record in the GEDCOM file. It usually contains information
about the author of the GEDCOM file.
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Navigating Around the Everything Report
 
 

There are several ways of moving through the report.

The simplest way with the mouse is to use the elevator bar at the right side of the Everything Report. It works just like
in other programs.

If your mouse has a scroll wheel, you can use that.

By way of keyboard, you can use the arrow keys, or PageUp and PageDown. To go quickly to the start of the report,
use Ctrl+Home. To go to the end, use Ctrl+End.

Single click on any hyperlink (blue underlined text) and you will be taken to the relevant information. To get to the parents,
other spouses, or children of a person, you'll find the appropriate links to click on with that person's information.

And don't forget about the TreeView. Clicking on any entry there will bring up that item in the Everything Report.

There's also one other nifty little navigation tool. It's similar to the forward/back tool you find in a web browser. See the
following diagram:

 

 

Back and Forward

There are "Back" and "Forward" selections on the Navigate menu to easily move you through the sections of
the Everything Report you have previously been to.. They will work just like an Internet Browser's Back and
Forward keys. There are toolbar icons as well (the backward and forward arrows shown above). Or you can
use the keyboard shortcuts of Alt+left arrow and Alt+right arrow.

Back and Forward History
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In addition, the toolbar arrows also have little dropdown arrows, which you can select to show the navigation
history and can jump directly to one of the sections you have previously visited.
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Searching Through Everything
 
 

 
Rather than implement a hugely complex search tool, Behold uses the same simple-to-use Find tool that is in most
Windows programs. Behold can do this because none of its data is hidden in fields. It is all there for you to search.

The Find toolbar item

The find toobar item will bring up the find window. Alternatively you can select Find from the Search menu,
or press Ctrl+F.

Find Next

This toolbar item will find the next occurrence, or you can select Find Next from the search menu, or press
F3. Seriously, F3 is rad!



Behold's User Guide - Searching Through Everything

- 74 -

Find Previous

This toolbar item will find the previous occurrence, or you can select Find Previous from the search menu, or
press F4. Even more rad than F3 is using F3 and F4 together!

Find History

Behold also maintains a Find History. Next to the Find toobar item there is a dropdown button that lists the last
searches. You can use this, or select Find History from the Search menu.

The Find Window

 
Enter what you want to search for and it will be found.

The Find window is non-modal, meaning it does not take control but can stay open while you do other work
in other windows.
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Organizing Your Data
 

 
Behold's Everything Report concept makes it possible to view and use all your data at once. Behold's organizing tools
take this a step further and make it easy to look at your data in different ways.

Behold Organize File icon/toolbar item

This icon represents a Behold Organize file. The Behold Organize file contains information about what
genealogy files to open and how to organize them.

On the toolbar, you will also see this icon. Now Click on this to open the Organize window. Alternatively, you
can select Behold Organize Info from the View menu, or press F9.
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The Organize Window
 

 
The Organize window is made up of five separate tabbed pages, and has 5 buttons on the bottom.

The 5 Pages

The five pages are:
1.  GEDCOMs - Defines the files Behold will use.
2.  Families - Defines the families that will be displayed.
3.  Numbering - Defines how the report will be ordered and numbered
4.  Tags - Lists all the GEDCOM tags, which you want to hide, and the text each should display.
5.  Report - Defines all your report options.

You can also get direct access to these five pages individually from the Organize menu.
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Individual Pages

Each of the 5 pages has a different appearance. This page is the GEDCOMs page. Each page has its own
set of buttons on the right.

Apply button

After you make changes to any of the pages, both the Apply and Cancel buttons will become active.

Press Apply to make the changes, and the Everything Report will be updated to reflect the changes.

Cancel button

Press Cancel to cancel any changes you made since the last time you pressed Apply.

OK button

Pressing OK is the same as pressing Apply except that it also closes the Organize window.

Help button

You know what this is for.



Behold's User Guide - The Organize Window

- 78 -

Save button

The Save button is special. It will save all your Organize Info that is on all the Pages into a Behold Organize file.

Now press the Save button ...
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The Save As Dialog
 
 

 
This will save your organize settings into a Behold Organize file.

Behold Organize files are special files used to save Behold Organize Info and a few other things like Instant organize
history, find history and back/forward history. These files should have the extension ".bho" at the end of them. They do
not contain any genealogy data, but do contain pointers to the files (GEDCOM or other) that have the genealogy data.

File Name

Give it a file name. In this case it will be saved as Customized McCarthy.bho and for the purpose of this tutorial,
make sure it will be saved in the Sample Files directory with the Steve McCarthy Legacy.ged file. The directory
Windows uses for sample files may depend on your version of Windows. On Windows 8 and 8.1 for example,
you'll find the sample files place in the "\Documents\Behold\Sample Files" directory.

Save button

Then press the Save button.
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Behold Organize Files (.bho)
 
 

 
In case you're curious, this is what a Behold Organize file looks like. They are simple text files that you can look at if you
want to. But it's better if you not worry about what is inside them. Their purpose is so that you can save your settings to
allow you to organize and view your files in many different ways.

In fact, you may load one or more GEDCOM files into Behold and save any number Behold Organize files for them that
will each provide a different way of viewing that file. You can include or exclude certain families and save that. You can
show or hide certain desired tags and save that. You can change your report options, or numbering system and save
that. If you give the saved Behold Organize file an appropriate name, then you can easily remember what that particular
customization was done for, e.g.: Aunt Jane's Family.bho, BirthMarriageDeathEventsOnly.bho, TheSmithSurname.bho
or AllFourGEDCOMsTogether.bho.

Any time you pick a different view of your data that you might want to easily come back to, save it as a Behold Organize
file. Then just load that Behold Organize file and you're back to that exact view and organization settings that you had
when you saved it.

One simple and excellent way you can make use of Behold Organize files is to change all the text on the Tags Page and
all the phrases on the Report page to the language of your choice. Then save that as a Behold Organize file, which will
in effect then become a language file for Behold. Give it an appropriate name, e.g. French.bho, or German.bho.  Later
in this tutorial, you'll see how to merge settings from a Behold Organize file into your current Organize settings, and that
would be how to load various languages.



Behold's User Guide - Open Again

- 81 -

Open Again
 
 

 

Now, select Open from the File Menu. The window above should appear.

Three Files

There are now two .ged files (that contain the data), and a .bho file (which contains Organize Info for Behold).

The difference between the two file types is that if you use Behold to open one of the GEDCOM files, then the
genealogy data will be opened and Auto Organized with default settings. But if you use Behold to open the
Behold Organize file, then the genealogy data will be opened with a set of Organize instructions that has been
pre-customized by you to your liking.
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As described on the previous page, there's no reason why you can't have multiple Behold Organize files that
open one GEDCOM file in many different ways. Just give each file a good descriptive name, like: "McCarthy
family for cousin John.bho".

Just remember the usefulness of Behold Organize files. They can be used to open multiple files at once,
organized the way you want.

Icons

If you associated both GEDCOM files and Behold Organize files to Behold (as described in the Associating
Files section), then you will see the icons shown above. The Behold Organize file is given a slightly different
icon so that you can tell it apart from the GEDCOM file.

Cancel

We don't want to open a new file now, so click on the Cancel Button to close the window.



Behold's User Guide - Add a GEDCOM

- 83 -

Add a GEDCOM
 
 

 
Go back to the GEDCOMs page in the Organize Window. If that Window is not visible, you can press F9 to make it
appear again.

Press the "Add..." button that is on the top right of the GEDCOMs page. That should bring up the "Add GEDCOM(s)"
window shown above.

Select

Select "Larry Cada PAF.ged"

Open

Then press the Open button.
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The GEDCOMs Page
 
 

 
The GEDCOMs page of the Organize window will now list the Larry Cada GEDCOM along with the Steve McCarthy
GEDCOM.

GEDCOM File Information

 
For each file, the GEDCOMs page shows the file name, the directory it is in, an assigned sequence number, an
ID that you can change, and how many spaces (0 or 1) it adds prior to concatenating a line. The number and
the ID are used for numbering. You can change the ID yourself with the Edit ID button or by double clicking on
the ID. You can change the CONC setting by double clicking on that setting.

You can reorder GEDCOMs with the Move Up and Move Down buttons or by using the mouse and dragging
a filename to where you want it.
The checkmark before each filename indicates whether or not to include that file when loading the Everything
Report. That way, you can quickly uncheck a file if you temporarily don't want to include it. The Select button
will change the checkmark or you can simply use your mouse and click.

If you really don't want the file in the list, you can press the Remove button and it will be taken off the list.

There are two other ways to include multiple GEDCOMs in Behold:
1. You can use the Add GEDCOM(s) item on the File Menu of the main form.
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2. You can select more than one GEDCOM file when you use Open... from the File Menu on the main form.

You cannot load more than one Behold Organize file at a time. And you cannot open GEDCOMs and a Behold
Organize file together. You must first open the Behold Organize file, and then add any other GEDCOMs you
want to it. If you open a Behold Organize file with other files open, then those files will be closed first (but you
will be asked to save if you made changes).

Apply

Press the Apply or OK button and both files will be loaded into the Everything Report.

Press F9 to go back to the Organize Info.

Then click on the Families tab at the top of the Organize window.
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The Families Page
 

 
 
Families define the grouping and the order that people are displayed in the Everything Report.
 
Each person listed starts a family. All the relatives of each person make up that person's Family. That includes all
their ancestors as well as the descendants of their ancestors. Relatives include half-family and step-family, but do not
include relatives through marriage other than the person who married into the family.
 
People may be in multiple families. But their information and all their descendants are only included in the first
occurrence. All others show just their name and a cross reference and link back to the first occurrence.
 

Families

By default, Behold starts with the first person from all files loaded, who usually are the people of interest. The
person and the person's spouse/partner(s) will be included as the initial families.
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GEDCOM ID

The ID of the GEDCOM the family comes from is listed here. By default, the ID is the first three letters of the
GEDCOM file name, but this can be changed on the GEDCOMs page.

Family Number and ID

Each Family is assigned a sequential number and an ID initially taken from their birth Surname.  These are
used simple to make identification easier.

You can edit the ID yourself by clicking on it

Add or Remove

Families can be manually added or removed.

Actually all the Add... button does is bring the Everything Report to the front so you can select people to add
a new families. This will be described on the next page of this help.

Move Up or Down

The order of the families can be changed. This can also be done by dragging and dropping the family name
to a new position.

Checkmarks

The checkmarks indicate which families will be included in the Everything Report.  Unchecking a family is a
simple way of excluding it without removing it. This way, the families you often organize around can stay on the
Families page so you don't have to keep searching for them whenever you need them again.
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Related Through Marriage and Everyone Else

There are two special family groups that are always at the bottom of the Families page: "Others Related Through
Marriage" and "Everyone Else".

You cannot remove these groups and you cannot move them up or down. But you can select or deselect them
and change their ID.

These give you the capability of including the other people that are not in the family groups you have selected.
If Others Related Through Marriage is not selected, then those people will be included in the Everyone Else
group if it is selected.

To make it easy for you to change whether RM and EE are selected or not, the toolbar on the main Behold
window has two icons that you can use:

   
Here you see RM as not selected (flat) and EE as selected (pushed in). By clicking with your mouse on one of
these icons, you will change its selection (without having to come into the Organize window) and Behold will
immediately recreate the Everything Report with the new setting.
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Adding Families
 
 

 

To add a family, move the mouse cursor to the the person/people you want in the Everything Report or TreeView, either
right click and select "Add Family of: ...",
or click on the family toolbar button (the one that has three tiny people in it):

    

If your mouse is over William Lockney, then he will be selected. If it is over Mary Lockney, then she will be selected.

If your mouse is over one of the hyperlinked people in blue, such as William and Mary's daughter Barbara, then Barbara
will be the one selected.

Try adding William Lockney and then Mary Lock. Then you press F9 to go back to the Families Page.
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The Familes Page with Added Families
 
 

 

New Families Added

The added families are put at the end, but prior to the Others Related Through Marriage line.
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A Bit About Numbering
 
 

Numbers are by default included in Behold for each person and also their spouse. This helps to easily identify who the
person is, and it allows you to quickly find the person from a printout of the Everything Report.

In formal genealogy, there are several different numbering systems. Some like ahnentafel numbers are designed for
ancestor reports and number a specific person as 1, the parents as 2 and 3, grandparents 4, 5, 6 and 7, and so on.
Others like the Register system are designed for descendant reports and give numberings such as 1.4.2 to represent
the 2nd child of the 4th child of the 1st child.

But there is no formal system that works well for defining all relatives of a person. You could theoretically combine the
two different systems together to give numbers like: 5-1.4.2, but there are several major problems when you do this.
  1. If there are many generations, the numbers can get long and become hard to use.
  2. It gets tricky to find the number you want with eye-twisting numbers such as 2.3.5.3.2.4 and 2.2.5.3.2.2.4.
  3. These numbers would be useful if each one was permanently assigned to a specific person, but that cannot happen
because many numbers may be forced to change if even one newly found relative is included.
  4. This will still not work if you want to number all the relatives of several different people. Some extra indicator is still
needed to identify the starting relative, e.g. REL1-5-1.4.2.

So Behold takes a simpler approach. Behold gives you a simple numbering system that identifies families with a number
and/or ID. Within each family, the people are simply numbered sequentially.

The purpose of numbering in Behold is simply to help find people in the report. This is NOT intended to be used as a
permanent ID for each person. The numbering is dynamic and will change depending on who you include and the order
you display them.

In our sample program, people in Stephen James McCarthy's family are numbered MCC-1 to MCC-137.  People in
Lawrence Cada's family are numbered CAD-1 to CAD-24. Those related through marriage are numbered RM-1 to RM-12.
These numbers are each assigned to both of the individuals in a two person marriage or partnership or to a single person
if there is no listed spouse or partner. The prefix of each number (MCC, CAD and RM) gives you a hint as to which family
the person belongs to, and the numeric part tells you whether you'll need to scroll up or down in the file to find them.
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The Numbering Page
 
 

 

This page defines how the Everything Report will be ordered and how the individuals will be numbered.

Ordering Within Families

You can choose the way the people will be ordered within their families. You do this using the Within Families
dropdown box. Its selections are: Down from Ancestors, Up to Ancestors, Descendants Only and Surname
Order.

Down from Ancestors will produce a list of descendants for each ancestor starting from the father's father's
father's... side and working down to the mother's mother's mother's... side. This is the normal ordering that you
will use most of the time.

Up to Ancestors will produce a list of descendants for each ancestor starting with the person and moving up to
their parents, then their paternal grandparents, their maternal grandparents, then to the great-grandparents and
so on. This is sometimes referred to as ahnentafel ordering.  It is a really good format when you are sending
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your information to a cousin. You can start with them, and then it will move up through their generations one
family at a time. They will easily be able to follow it and can send you back updated information written onto
a 2nd copy you send them.

Descendants Only will start with the person listed and just give their descendants. It will not include the ancestors
of the person. This is a good ordering if you want to finely customize the way the families are listed.

Surname Order will order the ancestors by their surnames. This is most useful if all families are considered
equal, for example if you are doing the genealogy of an entire town.

ID's and Numbers box

Behold gives you a useful but simple naming/numbering system. The IDs and Numbers box allows you to select
what Behold should use in the numbering.

You are allowed to select combinations of the Family ID, the Family Number and the Descendant Number. The
Family ID and Number for each family are listed on the Families page.

FamID Length

You can change how many letters of the Family ID are used for the numbering. This will only apply if FamID
is selected as part of the numbering.

FamID Format

You can select whether or not the FamID should be capitalized. This will only apply if FamID is selected as
part of the numbering.

Preview Box

The Preview box will always give you an idea of how a typical number will look as you have currently specified it.

Saving and Restoring Your Settings
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On the right side of the Numbering page are two buttons:  Load from... and Save into...

The Load from... button will retrieve and use the Numbering page settings that are saved in any Behold Organize
file.

The Save into... button will save your Numbering page settings into any Behold Organize file.

You might want to save a number of Behold Organize files with special names to contain the different settings
that you like to use. Then they will be easy to retrieve whenever you want to.
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The One-Click Organizing Tools
 
 

 
Now that you know how to use the GEDCOM, Families, and  Numbering pages to order and organize genealogy data
into the Everything Report, there are several very useful one-click organizing tools available to make this even easier.

If you go to the main window and select the Organize menu, the items shown above will be on the menu.

The icons shown also appear on the toolbar in the main window. You can either use the menu or the toolbar icons,
whichever you find easiest.

Instant Organize

 
Instant Organize is a great tool to focus in on one person. When you want to see who one person is related to,
or take what you have in your family tree to someone and show them everything you have from their point of
view, it will be the format you'll most likely want to use.

To do an Instant Organize, you must first select a person. There are several ways this can be done.

1. Click on a person in the Everything Report or on a person in the TreeView or move the cursor over a
hyperlinked person such as in the Index of Names (but don't click on it or it will take you there) and then select
the Instant Organize menu item or press the Instant Organize button on the toolbar.

2. Right-click on a person in the Everything Report or Right-click on a person in the TreeView or Right-click
on a person in the Index of Names and then select the option to Instant Organize that person from the right
mouse menu.

Instant Organize will change the following settings before recreating the Everything Report:
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1. The Within Families setting on the Numbering Page will be changed to "Up to Ancestors" Order.

2. Others Related Through Marriage on the Families Page will be set to unchecked.

3. Everyone Else on the Families Page will be set to unchecked.

If a pair of people was selected, then an Instant Organize will be done using both the people as the base for
two families.

Instant Org History

 
Every time you Instant Organize someone, they get added into the Instant Organize history. Selecting the Instant
Org History item on the Organize menu, or the drop-down arrow next to the Instant Organize button will give
you access to the last people who you Instant Organized. This Instant Organize history will also get saved in
the Behold Organize file along with the other organize information.

Add Family of

 
This will take the currently selected person and add that person to the Organize Families page. It will then
open the Organize Families page so you can view or change the information there.
 
If a pair of people was selected, then both will be added to the Organize Families page.
 

Reload

After you use the Instant Organize to generate a new view of the Everything Report, you may want to go back
to the previous view. Reload will load the data again the same way you last saved it from the Organize Pages.
If you haven't saved the file, then it will be reloaded the way it was originally loaded.

Ordering shortcuts

These four selections will allow you to quickly change the way individual are ordered within each family.

These are exactly the same as the four option that you'll find on the Organize Numbering page. They are also
presented on the Organize menu and on the toolbar for quick access to these options.
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The Tags Page
 
 

 
This page lists all the GEDCOM tags that were found in the genealogy data, along with the Text to display for that tag
and a count of the number of occurrences of that tag in the data.

Any tags that were read in the genealogy data but were not listed on the Tag Page are automatically added to the Tag
Page. The text they will display will be the Tag name, so you will want to go in and change them to make your Everything
Report read a bit better. The Log file in the GEDCOMs and Input Log window will list all the new tags found.

Sorting

Each column can be sorted by clicking on the column heading. Clicking again will reverse the sort.

Select a Tag
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If you click on a row with your mouse, it will select that row and the tag for that row.

Tag Name and Checkbox

The tag name is the name as used in the genealogy data. A checkmark beside the tag name specifies that
the information for that tag will be displayed in the Everything Report. Alternatively thinking, an unchecked item
means that this tag and all subordinate tags will be hidden.

The Select button (on the right side of this window) will change the checkmark or you use the spacebar, or you
can simply use your mouse and click.

Text to Display

The text to display for many of the tags is preset in Behold with reasonable values. For example, the BURI tag
will display as: "Burial:" followed by the BURI information. If the Text for the tag is blank, then nothing is shown
where the tag would be, but the information associated with the Tag is still shown.
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You can edit the text for any tag by double clicking on the text or if the line is selected, by using the Edit Text
button.

Tag Counts

The number of times each tag occurs in the data is given. Tags are counted as Records, Pointers or Data.

The number of Records tells you how many items of a given type are in the data. For instance, the number
of INDI records tells you how many people (individuals) there are and the number of SOUR records tells you
how many sources there are.

Pointers are links to records. For example the number of CHIL pointers tells you how many people have links
to their children.

Data tags are all tags other than Records and Pointers. Most often they contain information.

Used or Unused

Showing Used Tags will show those tags that occur at least once in the input files.

Showing Unused Tags will show those tags that don't occur in the input files. You may want to see these to
know what other tags are possible. This will allow you to customize all the text of all possible tags at once to
say what you want them to.

Merge from/into
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The Merge from... and Merge to... will allow you to maintain your own sets of master tags and text to display
in your own custom Behold Organize files.  You can use this to save different selections of tags that you often
use, or to save and use sets of tag descriptions in different languages.

The Merge from... button will merge the tags and text from a Behold Organize file into the current Tag page.

The Merge into... button will merge the tags and text from the current Tag page into a Behold Organize file.
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The Report Options Page
 
 

 
Here you can select other options for your report.  There are three sections: Contents, Extra Info, and Text to Display

Contents: allows you to specify which sections of the Everything Report to include and what the section headings should
be. Note that Section 2 is the main contents of the Everything Report, and that is always included.

Extra Info: are some additional information that you can include in the report.

Possible Data Problems: allows you to select what data problems you want Behold to check for you.

Relatives for Life Events: lets you specify what you want to call the different relatives in the report, e.g. for different
languages, or if you don't want to distinguish between sex or whether they are older or younger siblings.

Text to Display: are all the other text that is written into the Everything Report. You cannot deselect these, but you can
change the text that is displayed. This will be useful for displaying the contents of the Everything Report in different
languages, or to otherwise customize some of the text Behold displays.
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Saving Genealogy Data
 
 

Genealogy programs normally save genealogy data into their own database, one that can only be read by their own
program and maybe a few utility programs specifically written for it.

Version 1.0 of Behold doesn't work that way. Currently Behold loads its data into memory. Internally it uses an extended
version of the GEDCOM format to allow it to understand genealogy data from just about any source. Version 1.5 will be
differen, and Behold will then write its data to disk, which will be called project files. This will be the needed first step that
will allow saving your data and editing in Version 2.0.

Behold's Behold Organize files that it saves do not contain genealogy data. They only contain instructions on how to
open and organize other genealogy data files, currently just GEDCOM files. Soon, by Version 2.0, Behold Organize files
will be able to manipulate Behold's project files as well.
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Editing Genealogy Data
 
 

Editing your genealogy data is the important ultimate goal of Behold that will be added when Version 2.0 is released.

I am really excited about this because I know it will be absolutely wonderful to work with! Behold will be like a  word
processor customized for genealogy. You will type right into the Everything Report, and will have all sorts of tools and
shortcuts to take hours off your data entry time.

So what will it be like?

Just to get a feeling, go to the Everything Report and click on some information about a person:

You can just start typing anywhere. You can select text, copy text (or Ctrl+C), cut text (or Ctrl+X), or paste text (or Ctrl
+V). You can press the Insert key and go into Overwrite mode (the INS in the status bar will change to OVR) and press
it again to go back. On the Edit menu you can Undo any number of edits (Ctrl+Z) or redo them again (Shift+Ctrl+Z).

That should show you the ease of data entry that will be available. And that is without any of the many speed-up functions
for genealogy data entry that I'll be adding.

The important thing is that you are typing and updating right on your report. You'll be able to add new people, link
parents to children, add events, edit dates, copy notes, document sources, globally change place names, add repository
information ... and everything is done without leaving the report. Entering data into forms will be a thing of the past.

But again, I'm sorry. Right now you can manually make changes and print them and export them, but you can't save
them. You'll have to wait until version 2.0 for that.
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Printing Genealogy Data
 
 

One main goal of Behold is to allow you to print your genealogy data in a compact but usable form. The Everything
Report is set up so that it can be printed, hole punched and (assuming it's not a huge file) put into a binder and taken
with you wherever you need it.

Since it is a complete report, the Heading, Table of Contents, Information Area and various Indexes will be everything
you need. Behold's method of cross referencing always includes a number, so even in printed versions it will be easy
to find all the cross references.

Other programs usually allow you to print Family Group sheets, or Ancestor reports or Descendants reports, but it is very
difficult to find a way to print everything about everybody without having much of your information repeated over and
over again. You've now finally got that capability with Behold.
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Print Preview
 
 

 
Behold currently comes with a very basic Print Preview function that you can select from the File menu or toolbar.

It is fairly easy to use and is similar to most other Print Previews you'll be familiar with, so I won't go into detail about it here.
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Printing
 
 

 
Select Print from the File menu or click on the toolbar icon or press Ctrl+P to bring up the standard Print box.

There's not much to explain here, since it works just about same as in any other program.

Selection

One little tip:

If you select a range of text in the Everything Report and then do a Print Preview or Print, by default, only the
selection will be used.

This will make it easier for you to select small parts of your family information to be printed.

Note:  Until editing is added in Version 2.0 of Behold, selection is limited to only a few items (people, places,
sources) at a time.
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Exporting Genealogy Data
 
 

 
Select "Export" from the File menu.

Currently, Behold can Export data to two formats: HTML and RTF.

HTML Export

Behold currently exports the entire Everything Report into a single HTML file. These files are in a format that
can be read in a web browser and can be put on a website for viewing. HTML if you must know, stands for
Hyper Text Markup Language. This HTML uses Cascading Style Sheets (CSS) which preserve all formatting
as precisely as possible. The web page generated will have working hyperlinks.

You can place these files on a website, but this is something that I personally have great reservations about. I
don't believe you should publicly post all of your data. You should post what families you're looking for so that
other researchers can contact you, and then exchange relevant knowledge with them. So really, what is the
point in putting everything up? We can have a big debate on this if you'd like. In the meantime, check out My
Family Research to see what sort of information I think should be put up on a website.

In the future, I may allow some options to split the contents, families and indexes into different files. And once
editing is added, I hope to add ways to designate certain people, events, or data as private so that they may
be excluded from printouts or exports.

RTF Export

Behold can export its Everything Report to RTF (Rich Text Format). This is a format that Microsoft Word and
many other word processing programs can read.

Using the RTF export, you can load the exported file into your word processor and make additional changes
to it there if you wish.

Other Formats

http://www.lkessler.com/myfamily.shtml
http://www.lkessler.com/myfamily.shtml
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No other formats are currently supported.

Of course, GEDCOM is an important format. That will be added in Version 1.5.
 
PDF is the only other useful one I can think of at this time, and I may add it in the future if I get some requests for it.
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Staying Up To Date
 
 

If you've read this far, then I congratulate you.

Behold is a program still under development and there are many new and exciting enhancements coming.

If you purchased a lifetime license for Behold, then all future versions will always be available to you for free. I want
you to continue using Behold and be able to upgrade without having to worry about whether or not the upgrades are
"worth it".

There is a menu item on the Help menu to allow you to "Check Online for new Version". This is described in detail in
How to Upgrade to a New Version.
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Now Get To It!
 
 

I hope you found the tutorial worthwhile. You should now feel a bit more comfortable using Behold.

The rest of this User Guide contains How To's and a Reference Guide.

If you want even more information, check out Behold's website. You can find a guide to the website here. 

Thank you for your interest in Behold.

Lots more to come...

Louis



Behold's User Guide - How To's

- 111 -

How To's
 

This section contain sets of specific instructions on how to do the many of the things you'll want to do with Behold.
 
If there's some task you want to do with Behold, and you would like to see a How To about it, let me know (my email
address is below) and I might add it for you.
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Organize Your Families
 
The Everything Report in Behold is designed to organize all your data for you.
 
Auto Organize
By default, when you load data into Behold, it will get "Auto Organized". Behold will take the first person in the data file
and create the first "family" in the Everything Report to be all relatives of that person. The next "family" will be the first
spouse/partner of that person and the same for additional spouse. Following that, anyone related through marriage
and their families will be included in a "Related Through Marriage" family, and last there will be an "Everyone Else"
family.
 
95% of the time, the above arrangement will work for you. Most GEDCOM files are created with a significant person
(the researcher, or an ancestor of the researcher) as the first person. If the arrangement is good enough for you, then
you are done.
 
 
The Organize Families page
If you want to organize you families differently, you can do most of that on the Organize Families page:
 

 
You can select which families to exclude by unchecking them, you can move families up or down, and you can add or
remove families.
 
When you press the Add button, it will display the following information box and then take you back to the Everything
Report:
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You can then find the families to add, add them, and go back to the Organize Families page and move them around.
 
You can also quickly select or deselect the "Others Related Through Marriage" and "Everyone Else" families with the
following two items on the Toolbar:

 
 
Order Individuals Within Families
Within each family, you can organize the people in different ways. This you'll find on the Organize Numbering page in
the Order Individuals box:

 
That box has four choices:

with "Down from Ancestors" being the default. This is described in more detail on the the Within Families description
on the Organize Numbering page. These choices are also easily accessible from four buttons on the Toolbar:

 
 
Save your Ordering in a Behold Organize File
You may want to organize your families several different ways. Feel free to save each type of ordering you use in a
different Behold Organize file, so you can recall it quickly. Use the Save button to save a Behold Organize file.
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Instant Organize
 
Instant Organize is most useful when there is one person in particular you are interested in, and you want to know
about all the relatives of that one person.
 
You may have a cousin who is interested in your family. By Instant Organizing on your cousin, you will get all the
people you have in common between you and your cousin. You can send your cousin the report and they won't be
distracted or given access to all the people in your family tree that they are not related to.
 
Instant Organize produces a slightly different report that is centered on the person selected and then works up and
away, generation by generation. This way, the people earliest in the report will be the ones that the person will be most
familiar with.
 
 
There are three ways you can select a person and do an Instant Organize on them:
 
1.  In the Everything Report, click somewhere in the data about a person. (Don't click on a hyperlink, or you'll be
transferred elsewhere). You should see the Instant Organize Toolbar item get highlighted:

Click on the toolbar item, or select "Instant Organize" from the Organize menu.
 
2.  In the Everything Report, right-click somewhere over the data about a person. One of the right-click options will be
to "Instant Organize" about that person.
 
3.  In the Treeview, right-click somewhere over a person. One of the right-click options will be to "Instant Organize"
about that person.
 
You can also Instant Organize on a husband/wife pair at once. You will see this option if you are over family
information, or if you are over any title or link to a pair of people. If you do this Instant Organize, you will get two central
people, all relatives of the first following by all relatives of the second.
 
To learn more, see the descripton of the Instant Organize command.
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Customize the Numbering
 

There are dozens of different genealogy numbering systems. Sosa-Stradonitz, Register, Henry, D'Aboville, and many
others. Many are useful for ancestor reports, and many for descendant reports. Some combined systems are used for
a combined ancestor/descendant (i.e. relative) report. But none of them can be relied on to retain the same numbering
with the addition of a newly found individual. The new individual may get a previously assigned number, and many
previously assigned numbers will have to be reassigned. As a result, you should never use a numbering of ancestors/
descendants as your primary reference to the individuals in your family.
 
Behold magnifies the problem. Since Behold is very flexible in allowing you to move families and lines within each
family, it is impossible for any numbering system to retain the same numbers through these transformations. Every
reorganization of individuals in Behold will result in a different number.
 
Therefore the philosophy in Behold is to use numbering to help you simply:
1.  Identify which family the person is in,
2.  Identify where in the family the person is, and
3.  Make it easy in a printed version of the Everything Report, to use links to find a person.
 
To do this, Behold by default uses a simple two-level numbering system, with a family prefix and a number
representing the person in that family incremented in a sequential manner from first to last. This method especially
helps you in printouts, where you don't have access to the live hyperlinks to find people.

 
To customize the numbering, go to the Organize Numbering page and check out the IDs and Numbers section:

 
You have several choices, and the preview will give you an example of what a typical number will look like.
 
Generally, you will want to keep your numbering short. For the minimalist, you can just number everyone sequentially
by choosing "DesNum" from the drop-down box. But you will end up like having the family ID prefix there to help
identify the family.
 
Family IDs are assigned automatically by behold based on the surname of the central individual for the family. If more
than one family surname starts with the same letters, then a number is added at the end to distinguish the family IDs.
You can edit the individual family IDs yourself on the Organize Families page.
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Customize What Is Displayed
 

Behold reads in everything from your genealogy data file. It also can display everything.
 
Generally, you don't have to worry about how to display the data. Behold takes care of that and displays the events
and facts in a logical manner. But it is up to you to determine what to display.
 
Organize Tags
Each GEDCOM line has a GEDCOM Tag. Behold comes with a list of all valid GEDCOM Tags on its Organize Tags
page:
 

 
You can select which tags you want displayed (the checkboxes in the Tag column), and you can define what text you
want each tag displayed as (the Text column). Behold comes with reasonable defaults for what is displayed and the
text. A typical display might look like this:
 

 
The above text is shown with the "Display Selected Tags" setting.
 
You can very easily toggle between that and the "Display All Tags" setting which looks like this:
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The difference between the two settings is that in the "Display All Tags" mode, everything is displayed. The unselected
tags and their associated information are shown in grey text. The grey text is the text that will be hidden when you
change back to "Display Selected Tags" mode.
 
To switch immediately between the two settings, use the "Selected Tags / All Tags" command from the View menu or
click on the item on the Toolbar that looks like a checkbox:

 
In Behold, it is very important to know which mode you are in, because what you see (grey text and all) is what you'll
get when you export the Everything Report to other formats. In other words, in "Display All Tags" mode, everything
gets exported. In "Display Selected Tags" mode, only the selected tags get exported.
 
 
Organize Report
There is a second set of selections you can also make. These are on the Organize Report page.
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On this page you select what parts of the Everything Report you want displayed, you define how to display the section
titles, you can include or exclude some extra information, and you can change other text phrases that are used in the
Report.
 
 
Saving Your Display Settings
You can save your customized settings in a Behold Organize file using the Save button at the bottom of the page. Give
this file an appropriate name so you'll remember what customizations are in them. Then you can either load the entire
Behold Organize file, or just merge the Tags and/or Report settings from that file using the "Merge from" button on the
right panel of the pages.
 
A particularly good use of these settings is to change all the text Behold displays into another language. This
conveniently translates the Everything Report for you. There are two How To pages specific to Translation Files:  How
To Use a Translation File and How To Create a Translation File. However, do realize that Behold cannot translate your
data.
 



Behold's User Guide - Use a Translation File

- 119 -

Use a Translation File
 
 

If your genealogy data is recorded in some language other than English, you will probably want to use a translation
file. The translation file will allow all the text Behold adds to the Everything Report to be in the language you want. That
way the entire report, including your genealogy data, will be displayed in your language of choice.
 
At the Behold website, on the Download page at www.beholdgenealogy.com/download, there are free Language
Translation files that you can download. These are created by Behold users. If you would like to update one or create a
new one, please do so and other users will benefit from this.
 
You can select the translation file you want to be your default. On the File menu, select "Default Language".  The
following window will appear:
 

 
GEDCOM files will always use the default language you have specified.
 
However, when you save a GEDCOM as a Behold Organize file (.bho), the Behold Organize file will contain its own
translations. When reading in a Behold Organize file, it will first use its own translations, and it will only use the default
translations for text that it doesn't have.
 
If you find you want to update the translations in a Behold Organize file to use those of a translation file or other Behold
Organize file, you can do that with two simple steps.
 
1. Go to the Organize Tags page. Press the "Merge from" button, and select the translation/Behold Organize file to
use:
 

 
2. Go to the Organize Report page. Press the "Merge from" button, and select the translation/Behold Organize file to
use:

http://www.beholdgenealogy.com/download
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Behold Organize files can be used to create your own custom translation files and you can set one of them to be your
default if you so desire. It is not difficult to do this. See: Creating a Translation File.
 
 

Use English or Not?

If you want English as your default, then leave this box checked. The language translation file will not be
selectable.
 

Find Your Translation File

If you want a different language as your default, then first uncheck the "None (English)" box. Then you can
use the Browse button to find the location of the language translation file you want to use.
 
A language translation file can be any Behold Organize file (.bho). Behold uses the text on the Organize Tags
and Organize Reports pages for the translations.
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Create a Translation File
 
 
This is how you can create or update your own Translation File:
 
 

Organize Window

Start Behold. If you are updating a translation file, open the Behold Organize file with the translations you
want to modify. If you are starting fresh, don't open a file. Then go to the Organize Window.
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Tags Page

Go to the Tags Page.
 

Show All Tags

Ensure that "Show Used" and "Show Unused" are both checked.

Select First Row

Use your mouse and left click on the Text column. This will select the row and allow you to edit the text.

Insert your Translation

The text is what Behold will display for that GEDCOM tag. Replace the text with the translation to your
language. Behold uses Unicode and will accept any character and any accents that your keyboard allows.
 
When the text has a colon ":" or other punctuation at the end, you'll want to add the same to your translation.
 
When the text field is blank, simply leave it blank.
 
Once you've entered your translation, you can press Enter or press the down arrow to move to start entering
the translation for the next line.
 
There are about 300 text items on the Tag page to translate.

The Default Button

If you forget what the original text was, it will be shown below the "Use Default" button.
 
To reset a line back to its default, press the "Use Default" button.

Report Page

Once you've finished changing all the Text on the Tags page, then go to the Report page and do the same
and change all the "Display As" fields. There are about 60 items on the Report page to translate.

Save Translation File

After you've translated all the text on the Tags page and all the "Display As" values on the Report page, press
the "Save" button to save the translation file.
 
The translation is saved as a Behold Organize file and will have ".bho" at the end of its file name so Behold
can recognize it.
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It is best to name the file as the language you have translated to. e.g. French.bho, Russian.bho, Arabic.bho

 

Contribute
Please consider contributing your translation file so that others can use it. Send it to me (Louis Kessler) and
I'll add it to the download page at the Behold website

http://www.beholdgenealogy.com/download
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Find Data Problems
 
Behold will help you find many different types of problems with your data file:
 
1.  Non-Standard GEDCOM and Data Problems: There may be something wrong in the GEDCOM file, or your data
itself may have some problems. This includes logical problems, known as Consistency or Sanity checks. Behold
finds many of these problems for you. Here is a listing of everything Behold checks for.
 
2.  Ancestor Loops: Behold is one of the few programs that can find ancestor loops (where a person is their own
ancestor) and let you know about them in a way that will allow you to correct the problem. An example of an ancestor
loop message is:
    

Notice that the individual ID numbers are listed so that you can tell the people apart and try to figure out which parent/
child connection is incorrect.
 
3.  Unconnected People: After selecting the person of interest, the "Everyone Else" section are the unconnected
families, and the completely "Unconnected Individuals" are given their own special place among the Everyone Else.
You may see families or people here that should be connected, so now that you know about them, you'll be able to
correct them as they should have been.
 
4.  Duplicated People: Sometimes, especially if you've used some program to merge multiple data files together
(highly NOT recommended), your file may end up with duplicate entries for the same person. To find those, go to the
name index. Scan through the index looking for two people, one after another, with identical or near-identical names.
They could be people that are repeated. The birth and death dates after the people will be additional help. Behold will
make it easy for you to go back to their data and see if they are the same. e.g.:

      
In the above example, the two Heinrich Richard Niefts are probably different people, but the two Heinz Richard Nieft
are probably the same and may also be the same as the Heinz Nieft.
 
5.  Unreferences Sources, Repositories, Notes or Objects: Behold will list all references to any sources,
repositories, notes or objects. It will indicate those that are unreferenced. This may be okay if you entered one of these
items just to remember it, but these usually are referenced from individuals, families, or events within them. Behold
helps you identify these.
 
6.  Inconsistencies: These are slight differences in the spelling and use of surnames, placenames, and source
references. You can find these by scanning through the Name Index, Place Index, and Source Index. They will pop
right out at you.
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Print
 

You can print any part or all of the Everything Report. The printout should look almost identical to how the Everything
Report looks in the program. Major sections are separated with page-breaks so that each section will start on a new page.

To print a small part of the Report, select the text you want to print with your mouse.  To print everything, don't have any
text selected. Then select File -> Print or press the Print icon on the toolbar, or press Ctrl + P.  Up will pop the Print dialog
where you can decide to print all, certain pages, or the selection. See: Print Dialog.

You can Preview how your print will look prior to printing. From the menu, select File -> Print Preview. See: Print Preview
Window. I do admit that the Print Preview window is kind of primitive, but it works. I'll add a better Print Preview in a
future version of Behold.

Both the Print dialog and the Print Preview window will tell you how many pages you will be printing, so you can bail out
if you think it is too many to print. However, Behold will print your data using less paper than other programs, because
data is not repeated. Sometimes I still like a good old paper copy that I can put into a binder and take with me places
when I research, give to family members without computers, or keep as a hard-copy backup.

Note that currently, you cannot select more than a few screenfuls of the Everything Report because the "screenful" is
generated on the fly: it is not really there to select. For now, this will limit your selection size to a page or so. This will
be fixed when editing is added to Behold in Version 2.0.
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Work With Multiple Files
 
One of the concepts of Behold is to encourage genealogists to keep their data separate from other people's data.
 
I totally disagree with the idea of merging different people's conclusions together. The source of the data is very
important. It provides context into the data. By merging someone else's data with yours, you are doing a disservice to
both yourself and that other person. It is their data, containing their conclusions and assumptions, and you should not
copy it and treat it from then on as if it is yours. But in addition to that, you have no idea how valid or invalid their data
is.
 
Instead, it is my and Behold's philosophy to always keep different people's data separate. Yes, you should get their
GEDCOM files from them. But instead of physically merging theirs with yours, you should logically merge them. Behold
will let you load any number of GEDCOM files together and view them as if they are all one. All the indexes become
integrated. The families can be shown in any order.
 
The current limitation in Behold is that you cannot yet logically merge two people from different GEDCOM files together
so that they display as one. This is planned for a future version, as it requires specification in some way of which
people in which files you think are the same.
 
Please think long and hard about this concept, and you hopefully will agree with me that merging one person's data
into anothers is wrong. Many programs offer merging functions to make this easy to do. Don't do it!  Resist the urge.
You'll thank me later. Especially, don't sign up to any online databases that attempt to get everyone to merge their
data into one huge tree. It is absolutely the wrong way to go. Only use online systems that promise to keep your data
separate and will only logically merge your data with others.
 
Surprisingly, many of these programs that give you the ability to merge data do allow you to read multiple files at once.
Why do they encourage the wrong action when they have a capability for the correct action? Heed my warning.
 
On top of all that, merging data into yours is a lot of work. Why do it when you don't have to. Then, what do you do a
year later when your cousin sends you his updated file? Do you go through all that work again and merge everything
again? Isn't it easier to simply replace his old file with the new one? Duh!
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Save Your Organize Information
 
There are five tabs on the Organize pages, for GEDCOM info, Family info, Numbering info, Tag info and Report info:
 

 
Press the "Save" button at the bottom to save all this Organize info into a Behold Organize file with the suffix: .bho
 
No data is saved. Each time you open a Behold Organize file, Behold will load the the Organize Information back in,
and will follow that by loading the GEDCOM files specified on the GEDCOMs page which contain the data. Then the
Everything Report will be organized according to the Organize Information.
 
So remember, you can organize one file many different ways. So you can have many Behold Organize files based on
one GEDCOM file, e.g.:
 

MyRelatives.bho
AuntMabelsFamily.bho
FamiliesFromLondon.bho
MyDescendants.bho
MyRelativesNoIndexes.bho
MyRelativesNoDates.bho
MyRelativesMyTags.bho
 

and you can load all the relevant GEDCOMs you want together and save their organization into different Behold
Organize files, e.g.:
 

FourCousinGEDCOMs.bho
UnconnectedGEDCOMs.bho
AllGEDCOMs.bho
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Behold gives you the capability to separate the genealogy data itself from the specification of how to organize it. I hope
you make the most of this.
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Edit Data
 
You will find that you can make small edits to the Everything Report. Until Version 2.0 is released, these are only
temporary and cannot not saved. Once you scroll up or down more than a couple of pages and return to your edits,
you'll find they are no longer there.
 
Version 2.0 is when Behold turns from a genealogy data viewer into a full-featured genealogy editor. Behold's editing
will be report-based. That is, you will make your changes right onto Behold's Everything Report. A comprehensive set
of tools will allow you to make your edits easily and quickly, just like in a word processing document.
 
This is what will set Behold apart from the rest of the genealogy programs now out there. This is the goal, and its
coming.
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Upgrade to a New Version
 

To upgrade to a new version, either click on "New Version Available" on the menu bar (if it is there), or select the
"Check Online for New Version" item from the Help menu. Doing either will bring up the Web Update window. If there
is an update available, the window will look like this:

 

 
Click on the "Update" button. If you are not connected to the Internet, you will get the following Confirm box and you
should click on "Yes".
 

 
Behold will then show you a progress bar while it downloads the new version of the program:
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Once completed, you will get this confirmation box:
 

 
Click "Yes" and Behold will close and start the install. Prior to the install, you may (depending on your version of
Windows) encounter a message box similar to this:
 

 



Behold's User Guide - Upgrade to a New Version

- 132 -

This box verifies that the file about to be run is the Behold Setup program that will install the new version. If this box
does not say Behold Setup by Louis Kessler, then do not run it.
 
While the Behold Setup program is running, you will see the following Window:
 

 
Behold will then restart and indicate that it has correctly updated with the following Information box:
 

 
You now have the latest version of Behold.
 
If for any reason that process didn't work. You can always go to the Behold download page at
www.beholdgenealogy.com/download and press the "Click here to Download" link and get the new version that way.
You can simply reinstall the new version on top of the old one, and everything should work fine. Just make sure you
close Behold prior to doing the install. The install cannot update the program if it is open.
 

http://www.beholdgenealogy.com/download
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Behold's Reference Guide
 
 

This section documents all the windows, buttons, bits and bobbles you'll encounter when you use Behold.

You should be able to learn what every little thing does here. Hopefully, I've filled this section with useful information,
instead of useless things like: "The stop button stops the program".
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Behold's Main Window
 

 
 
 

Title Bar
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To the left is the Control Icon that represents Behold. If you left-click on that icon, the standard Windows
application menu will appear with the entries: Restore, Move, Size, Minimize, Maximize and Close (Alt-F4).
All standard Windows programs have this menu.
 
Following that is the name of the file that is open.
 
Finally that is followed by the program's name, and that of course is Behold.
 

Control Buttons

 
These are the standard Windows controls that most programs have at their top right corner.
 
First is the button to minimize the Behold window, and then comes the button to maximize the Behold
window. Last is the "x" which will close Behold.
 

Menu Bar

 
This is about as standard a menu bar you can get. You'll find the File, Edit, Search, View and Help items on
most program's menu bar.
 
Navigate and Organize have special menu items that pertain to Behold.
 

Toolbar Line 1

 
Behold has two toolbars. The one on top includes selected menu items from the File, Edit, Search and
Navigate menus. The toolbar items are shown in the same order they are in the menus, and each vertical
separator divides them into groups of related functions.
 
Hover your mouse over a toolbar item, and a short tool tip will pop up, and a longer tool tip will appear in the
status bar. If there is a keyboard shortcut available for the toolbar item, then it will show up in the short tool
tip.
 
See The Top Toolbar
 

Toolbar Line 2

 
Same as for toolbar 1, except these come from the View, Organize and Help menus.
 
See The Bottom Toolbar
 

TreeView
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Behold's TreeView is a directory of the contents of the Everything Report. It works just like Windows Explorer.
 
Click on a + symbol to expand an entry. Click on a - symbol to collapse an entry. The number to the right of
each line indicates how many entries there are to be expanded.
 
Clicking on any entry will move the Everything Report to that location.
 
The TreeView can be placed either to the left of the Everything Report, or above the Everything Report from
the "Tile" commands on the View menu, or their corresponding tools on the toolbar:

View -> Tile Top and Bottom | View -> Tile Left and Right 
 
For more info, see: The TreeView
 

The Everything Report
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This is what it's all about. All your data is displayed here. It is like one long word processing document.
 
There is a Table of Contents at the top, followed by all the your data, and then a bunch of indexes.
 
For detailed info about each section in The Everything Report, see the help section about The Everything
Report.

 

Status Bar

 
The status bar shows the status after certain operations, and will also show a hint when hovering your mouse
over some control.
 

 

Notification Area

 
The "INS" control is there ready for when editing is added. You'll be able to change from insert mode to
"OVR" overstrike mode.
 
Next is a progress bar that will show progress when loading a file. For small files, it will almost instantly go to
100%, but it is useful for larger files that may take longer.
 
The little computer symbol shows if you are connected to the internet or not. Behold will NEVER go to the
internet on its own. The only time it will go to the internet is when you request to download a new version of
Behold. A white computer says you are connected. A black computer says you are not. A green computer
means you are currently downloading a new version of Behold.
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Next are two memory indicator dials. The first shows the percentage of available RAM being used on your
computer, and the second shows the percentage of available swap files space being used on your computer.
If both of these go into the "red" zone, then your computer is overloaded and Behold and everything else will
run slowly. This was added so that you'll know if Behold is running out of memory for the processing it needs
to do.
 
The diagonal lines in the lower right corner of the Status Bar are what you grab with the mouse and drag to
resize the window.

 
 

Splitter

Left click the mouse on the splitter and you can drag it left or right (or up or down in top/bottom view) to
balance the sizes of the TreeView and Everything Report the way you like it.
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The Everything Report
 

The Everything Report contains all your data organized logically into a single report.
 
You can do a lot to customize the report exactly to your liking. You can select the families you want to display, how
to order them, how to number them, what indexes you want, what data tags you want to display, what text to use for
the tags, and the exact text you want to use for titles and other text in the report. These are all customized in Behold's
Organize Window, and this customization can be saved into a Behold Organize file so you can produce the same
report again later.
 

 

Everything

 
All your data is presented logically to you in one long organized report.
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You can type directly on the report and select ranges and cut and copy from it and paste to it. See Editing
Data.
 

Vertical Scroll Bar

 
To quickly and easily move up and down through the report, you can use the Vertical Scroll Bar. It works like
any normal Windows scrollbar.
 
Drag the elevator up or down to move quickly.
 
Click on the scrollbar below the elevator to move down a page. Click on the scrollbar above the elevator to
move up a page.
 
Click on the down arrow at the bottom to move down a line. Click on the up arrow at the top to move up a
line. Click and hold on either arrow to scroll continuously.

 

Hyperlinks

 
All text that is shown in a blue color is a hyperlink that can move the report quickly to another location. When
you hover your mouse over a hyperlink, the text will change to a violet color and become underlined and the
cursor will change to a pointing hand:
 

Then when you click on it, you will be taken there.
 

Hyperlinks can go to various places in the report. To an individual, to a pair of people, to a place, a source or
a repository.
 
If a hyperlink is a web address, it will open the specified web page in your browser.
 
If a hyperlink is an email address, it will execute a "send to" operation and open your default email program
and ready an email with the specified address.

 

Shortcuts
There are a number of keyboard shortcuts for the Everything Report.

 

There is no Horizontal Scroll Bar

The Everything Report is never wider than the Window it is in. The lines will automatically fold to the width of
the window so that you'll always see all your content.
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Top of Report
 

 
At the top of the Report is the Heading Section. There are eight Heading lines. Any can be turned on or off or
customized. By default, there is nothing in lines 2, 4, 6 and 8 and they are turned off, but you can add your own titles
there if you would like. All the Headings are customized on the Organize Report Page.

 

Heading Line 1

This is your overall title for the Report. By default it is "The Everything Report".
 

Heading Line 3

This line will include the primary person (or couple) who the report is about. If multiple GEDCOM files are
loaded, each file has their own primary people, so several lines of people may be listed indicating the primary
people in each file.
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Heading Line 5

 
This line will include the name of the licensed user of the program that is displayed in Behold's About
Window. You cannot change the name of the person listed here, but you can turn off the printing of this line
and include your own Line 4 or Line 6 to replace it.
 

Heading Line 7

 
This line will show the date this Everything Report was generated.
 

Heading Lines 2, 4, 6 and 8

 
Behold allows up to four custom heading lines after each of the standard lines (1, 3, 5, 7). You can even turn
off Behold's four standard lines and use your own custom four instead.
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Section 1 - Table of Contents
 

 

Section Title

You can change whether or not you want to show this section, or you can change this section's title on the
Organize Report Page.
 

Family
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The term "Family" is used in Behold to represent all the relatives of one specific person. There are many
ways to specify or change what people you want to use to organize your families and there is an Instant
Organize function that can quickly reorganize the entire report about one selected person.
 

Descendants

Every family is subdivided by the various ancestral lines of the "family" person. The earliest ancestors (both
spouses if known) are listed to begin each line.
 
There are various ways these lines can be ordered within a family, including "Down from Ancestors", "Up to
Ancestors", "Descendants Only" and "Surname Order". This can be specified on the Organize Numbering
Page.
 

Numbering

Since Behold is very flexible in how you can move families and lines within each family, it is impossible for
any numbering system to retain the same numbers through these transformations. As a result, Behold by
default uses a simple two-level numbering system, with a family prefix and a number representing the person
in that family incremented in a sequential manner from first to last. This is to make it easy to identify the
family of any individual and make it easy to find where that individual is within that family. This is especially
important in printouts, where you don't have access to hyperlinks to find people.
 
See Numbering for more detail.
 

Married Names

Behold is unconventional in its display of all married names for females. The person's maiden name (i.e. birth
surname) is shown first followed by each married name. All surnames except the person's last are shown in
square brackets. If she did not marry, the birth surname only is shown and not in square brackets.
 
This is done because most marriages in Western cultures during that past few hundred years have had
wives adopt their husband's surnames. Women are more often known by their married name and showing all
names makes it easier to identify the woman in the Everything Report.
 
You can turn this feature off on the Organize Report Page by deselecting the item: "Surnames: Show married
name".
 
Note: This example shows surnames in capital letters. Behold does not change the capitalization of your
surnames, but shows them as you have entered them. This sample file just happened to have all its
surnames capitalized.
 

Others Related Through Marriage

Behold's Family sections only include all direct relatives of the selected "family" people. Direct relatives
include any parent-child relationships made up of not only blood relations, but also adoptions and foster
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children and any other such relationships included in the data file. This means half-relatives (one parent in
common) are all included in the family. Also all marriages of these relatives are included so all step-families
and step-children are also included.
 
What is not included are the siblings and parents and other relatives of those who married into the family.
 
The Others Related Through Marriage "family" will list all the people related to those who married into
the family. They will (by default) be given the numbering prefix "RM". They will be grouped by the various
ancestral lines that make up the people related through marriage, and since there is no inherent "priority" to
these people, the ancestral lines are sorted by surname.
 

You can click on the  icon on the toolbar to very simply change whether or not you want to show Others
Related Through Marriage, and you can change this section's title on the Organize Report Page. The prefix
and whether or not to include these sections are customizable on the Organize Families Page.
 

Everyone Else

Once every family and all those related through marriage are taken into account, there still may be some
people not connected to any of the people already listed. This is usually because they are in disconnected
trees. Maybe these people were from other research that has not connected these people yet, or maybe
there are simply mistakes in the family connections in the file.
 
If there is no one else, then the title of this section says so and that's all there will be to this section.
 
But if there are other people, the section will be titled (by default - you can change it) "Everyone Else" and
they will be grouped by their various ancestral lines and sorted by surname and are (again by default) given
the numbering prefix "EE":
 

If there are any individuals or individuals only connected to a spouse with no other connections are separated
into an "Unconnected Individuals" section and are not individually listed in the Table of Contents (since there
may be a lot of them depending on the purpose of the research, e.g. Surname research) and are listed in the
Everything Report alphabetically by surname. They are given the numbering prefix "XXX".
 

You can click on the  icon on the toolbar to very simply change whether or not you want to show
Everyone Else. The titles are all customizable on the Organize Report Page. The prefix and whether or not to
include these sections are customizable on the Organize Families Page.

 

Other Sections
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All the other sections in Everything Report are then listed at the end of the Table of Contents. It includes
summary and detail information. If the GEDCOM file included custom records, then there may also be a
section for each custom record.
 
The titles of these sections and whether or not to include these sections can be specified on the Organize
Report Page.
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Section 2 - People and Facts
 

 

The Family Line

This line begins a new family and displays the name of the person whose relatives make up this family,
and his/her number to help manually locate this person in the report. The name is a hyperlink and will take
you directly to the person. If this person has parents, then he/she will not be first in the file. One of his/her
ancestors will be. 
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Note: Names are displayed in Behold as given in the data file. "McCARTHY" is capitalized only because it
was that way in the file. Behold tries to display your data as correctly as possible to help you identify errors
and anomalies.
 

The Descendant Line

This line starts each section and lists the earliest ancestor (and spouse if known) for this family line. The
details for this ancestor will immediately follow.
 

Separator and Number

The details for each person and their spouse are grouped together and separated from other people by a
dividing line.
 
The number identifying this person and spouse in this run is shown at the right of the dividing line. This
number is especially useful in printouts, making it easy to quickly locate someone.
 

Details for Each Person and their Spouse/Partner

 
The information is divided into one or two parts, using a blank line as a separator.
1. The person and all the details about the person, and
2. The person's spouse/partner who, if they had any children together, is the other parent of the immediately
following descendant lines.
 
If the person does not have a spouse/partner or if there is no information about the spouse/partner, then the
spouse/partner is not shown.
Information about both spouses, including events such as marriage and residence are included with both
spouses. This presents the events in each person's life in the context of that person.

 

Information

 



Behold's User Guide - Section 2 - People and Facts

- 149 -

Each item of information starts on a new line. Some information may take more than one line and those other
lines are indented and organized for best viewing.
 
Raw information is made up of pairs of tag text and data. The tag text can be customized on the Organize
Tags Page.
 
Some information is derived from linkages in the data and presented in a useful way, such as the birth
information of children.
 
Items shown in grey are "hidden" which means they are unchecked on the Tags Page. You can easily toggle
whether to display the hidden text in grey, or whether to hide the hidden text completely by selecting from
the menu: View -> Selected tags / All tags, or by clicking on its associated toolbar icon that looks like a
checkmark:

 The "Section 2 (continued)" of the screen shot shows more of the infrmation area with only Selected tags
showing (meaning the hiddent tags are really hidden.
 

Direct People Links

Within the details of a person will be links to other people: their spouse, children, parents and any other
people referenced within their data.
 
These direct links make it easy to navigate to another person, who may not necessarily be close by in the
report. The numbering for the person is a quick indication as to how far away physically in the report that
person may be, and allows you to find them more easily while scrolling through the report, or in a printout.
 

Source References

 
Source references are directly included with the data in Behold. This allows you to ensure that your sources
and data make sense together..
 
Behold numbers your sources for you to make it easy to find them in the Source Details section. (e.g. S5) and
then adds a sequential number to represent the specific information in that source (e.g. the -1). Together, the
Source Description is in blue meaning it is a hyperlink to take you to that source in the Source Details section.
Any other information included in the reference from the event to the source is also shown. This is where you
should include your analysis of the source and your reasoning about how you used the source to help derive
your current conclusion.

 

Event/Fact

 
Almost every item of information begins with a specific "event" or "fact".
 
The usual way an event is thought of is as something that takes place on a specific date or a specific place,
such as a birth or a marriage.  A fact is usually thought of as something that is constant over a certain time
period such as someone's sex or the color of their hair or their phone number.
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Usually you don't have to worry whether something is an event or if it a fact. The two are very similar and
quite interchangable.

 

Date

 
Events are usually followed by the date the event occurred on. Facts are sometimes followed by the date the
fact was true. But there are many variations of this. A date can be a period of time, an estimated time, a date
and a time, or one of many different forms. Behold, where possible, will also show the age of the person at
the time of the event.
 
Most dates are shown in "DD mon YYYY" format because that is the normal standard way they are stored in
most GEDCOM files. That is a good format, since there will never be a confusion between the day and the
month.
 

Place Link

 
Places should be listed in order of smallest jurisdiction up to largest separated by commas. The example
above lists City, County, State. Exactly what the jurisdictions should be is not always the same in different
genealogy files, but you should try to make them consistent within your data file.
 
If one jurisdiction is missing, normally two commas in a row would be a placeholder for it, e.g.:  Boston, , MA
 
Places are shown as a blue hyperlink and link directly to that place in the Place Details section.
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Family Organization
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Main Ancestor is Not Numbered

 
Each person and their spouse/partner except for the main ancestor has a number to the left of them.
 

Children are Numbered and Indented

 
Each generation is indented another level. On the 15th level of generations, the indenting is moved back 10
levels and a "+15" is placed on the separator to indicate that 15 generations are added to the level. This is
repeated every 10 generations deeper, so "+25", "+35",... etc. will prefix deeper generations.
 
The number to the left is the number of the child to their first-listed parent (father or mother). Simply stated,
the first child is 1, the second is 2, etc.
 

No Information is Repeated

 
Whenever a person is repeated, their information is not listed again. Instead, a link back to the first entry for
that person is given on a reference to "see above".
 
People can be repeated when they remarry, or if the arey connected to two or more different families on
different ancestral lines.
 

Spousal relationships have Special Prefix Codes

 
The spouse is prefixed by an "m." to indicate "married" or "mated" (where a mate would be a partner not
legally married, but may be the other physical or legal parent of their child/children or may have some other
close association).
 
There are other abbreviations as well:
 
"r." indicates a remarriage or re-mate of someone. The person is listed again, and they have a cross
reference back to their first listing. The spouse/partner of this person would then be prefixed by "m2." A third
marriage of someone would again have the "r." and their spouse/partner would be "m3.".
 
When a spouse/partner remarries, they are listed again with the prefix: "s.". Their spouse/partner will be listed
with the prefix "sm.".
 
You can change the abbreviations that are used for each of these on the Organize Report Page.
 

Descendant Order is Always Depth First
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This simply means that every person's descendants are listed before the next sibling of that person is listed.
This keeps closely related people as near to each other as possible.
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Parents, Spouses and Children
<TODO>: Insert description text here... And don't forget to add keyword for this topic

Parents

 
The parents of the person are listed following the person's birth or adoption event. The parents' ages and
length of marriage at the time are provided, if known.
 
If a person has multiple parents, e.g. a birth father and adoptive father, they will be numbered to differentiate
them:  Father 1, Father 2.
 

Spouses and Partners

 
All spouses for a person are listed. If a person had more than one spouse, they will be numbered to
differential them, e.g. Wife 1, Wife 2. 
 
The spouse is listed at the marriage event whenever possible, along with the spouse's age at the time of
marriage.
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Some data that many programs refer to as "family data" relates to both spouses. This data is repeated for
each spouse, but the spouse and the age of the spouse at the time are shown with a "With Husband/Wife"
prefix. This is important context to include and will allow you to identify if events between different spouses
are represented correctly.
 
Behold allows designation of non-married partners, e.g. common-law or maybe two people who had children
together without a relationship. They will be identified with "Partner" rather than "Husband", "Wife" or
"Spouse". In order for this partner designation to appear, the data must specifically include that the couple
was NOT married. The reason for this is that the absence of a marriage record does not necessarily mean
that the couple was not married. And for our ancestors, marriage was more the rule than the exception. So
Behold by default assumes marriage and designates Husband and Wife unless told otherwise. Once Behold
has editing capabilities, it will give you the capability to add the non-married designation.
 
For same sex couples, the designation is based on the sex of the person. So two males will both be
designated as Husband and two females both as Wife.
 

Children

 
Children are shown, where possible with their birth event.
 
If there is one child of a given sex, there is no numbering, e.g. Daughter, Son, Child.  If there are multiple
children of a given sex, they are numbered, e.g. Son 1, Son 2.
 
The first line designates the birth of a person's child. The date and place of the event is shown, and the age
and marriage status of the person at the time are shown.
 
The second line shows the other parent, and their age and marriage status at the time.
 
The third line shows the child who was born and is followed by additional birth information.
 
Adoptions and foster children are handled and displayed in a similar manner.
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Life Events
 

 
"Life Events" are the name given to the important events that happened to closely related people that likely had an
impact on a person's life. These would be significant events that the person may have attended or been listed in
records about that event. Even if the person did not care about this specific event (due to estrangement or other
reason), their lack of interest would have been a significant clue to aspects of the person's life. Including these events
with a person's information will help you see related events together and give you better insights as to what happened.
This will also make it easier to identify and correct inconsistencies in your data and conclusions.
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You can choose to display or hide all life events, selecting "Life Events" on the "View" menu, or clicking on the heart

icon on the toolbar. 
 

Life Event Information

 
Life events are designated with a green text. The first includes the relationship of the closely related person
who is involved and the event that happened to the closely related person. The date, age and marriage status
of the affected person, and place is shown.
 
The second line designates who the closely related person is. If it is not their birth event, their age if known if
known is given and if it is not their marriage event, their length of marriage if known is given.
 
Other lines give any other information pertaining to the event.
 

People Included

 
For each person, the following relatives are scanned for important events to be included as their Life Events:
 
1. Spouses/Partners
2. Stepchildren (only those prior to the marriage)
3. Children
4. Parents
5. Stepparents (only those following parent's marriage)
6. Stepsiblings (only those prior to the stepparent's marriage)
7. Half-siblings
8. Siblings
 

Events Included

 
For each relative, the following events are considered important events that are included as Life Events:
 
These change relationships:
1. ADOP - Adoption
2. BIRT - Birth
3. DEAT - Death
4. MARR - Marriage
5. DIV - Divorce
6. ANUL - Anullment
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These are often religious events attended by close relatives:
7. CHR - Christening
8. CHRA - Adult Christening
9. BLES - Blessing
10. CONF - Confirmation
11. FCOM - First Communion
12. BAPM - Baptism
13. BARM - Bar Mitzvah
14. BASM - Bas Mitzvah
15. ORDN - Ordination
 
These are other significant events in one's life attended by close relatives:
16. EMIG - Emmigration
17. IMIG - Immigration
18. GRAD - Graduation
19. RESI - Residence
20. CENS - Census
 
If there are any important events missing from this list, please let me know.
 

Scope of Events

 
Only events that would have been relevant at the time to the person are included. Some exclusions include:
 
1. Events before a person's birth.
2. Events after a person's death.
3. Events happening to a spouse prior to marriage or after remarriage.
 

"Who's Alive At" Events

Behold includes the following events that otherwise would not be included because they are not events in the
normal sense. They indicate new relationships at the time of a specific event.
 
Older siblings at the time of a person's birth are shown:
 

 
Stepchildren (spouse's children) at the time of a person's marriage are shown:
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Also, surviving relatives at the time of a person's death are shown. This is described in Survived By.
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Survived By
 

 
 

Follows a death event

After each death event, Behold will list all the close relatives who survive the person.
 

Order of survivors listed
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 This listing of survivors will be shown in the order generally followed by obituaries, so it should be relatively
easy to compare the people listed an obituary with those shown in the Survived By list..
 

Age and Marriage info

 
Age and marriage information of each survivor is provided.

Grandchildren

 
Grandchildren are listed in this report, after the children, but before the siblings.
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Section 3 - Index of Names
 

 

Sorted by Surname

 
People are grouped by surname. Surnames are ordered alphabetically. The surname shown here is in capital
letters, but that is only because it is this way in the data. Surnames in mixed case would be shown that way.
 

Full Name Including Married Names

 
The person's full name including their birth surname and all their married surnames for each of their
husbands are shown. All but the most recent surname are grouped within square brackets [ ].  This person is
in the index once for each surname.
 
The name is in blue and is a hyperlink that will take you to this person's data in the Everything Report.
 

Year Born - Year Died
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If the person has a birth event and/or a death event, then the year of the events are displayed here. This
helps identifiy that you have the correct person when there are two or more with the same name.
 

ID Numbers

 
The ID numbers of each person are listed.
 
The first is the primary reference where all that person's information will be found. The hyperlink for the
person's primary reference is on the person's name, so the first reference is not a hyperlink in blue text.
 
Other references show wherever else that person will be found. A person can occur again due to remarriages
or common ancestors. These other IDs are hyperlinked to those locations, and what you'll find there is a
cross reference back to that person's primary reference.
 

Earliest Ancestor

 
Anyone with no parents in the data file are shown in the index in bold text.  This means that they are one of
the earliest ancestors in their family line. Looking for the bolded people in the Index of Names makes it easier
to find these ancestors.
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Section 4a - Note Details
 

 
Notes are any descriptive text about anything.
 
They can either be inline with a NOTE tag and included with the information they pertain to, or they can be a link to a
NOTE record. The NOTE record allows the same note to be used multiple times.
 
The Note Details section only shows NOTE records that are used two or more times, or NOTE records that are unused
and thus unreferenced. NOTE records that are only used once are not included in the Note Details section, but are
shown inline where they were linked from.
 
The Note Details section is only shown if there is at least one NOTE record used 2 or more times or at least one
unused NOTE record. Not all genealogy software exports its notes as NOTE records, so often this section does not
appear.
 
This is how a note link to a NOTE record is displayed. It displayes the note as a link to the NOTE record along with the
note number Behold has assigned to it.
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If the NOTE record only occurs once, then the note is shown inline and looks like like a normal note but includes a
Note ID that is normally hidden text, like this:
 

 

Note Numbering

Note numbers have an "N" prefix and are numbered sequentially. 
 

Note Title and Order

 
The text of the note is used as its title. Notes are ordered by this title.
 

Note reference information

If there is information insubordindate to the note, it is listed as a sub-note under the note.
 

Note ID

 
The Note ID of the record is shown by default as hidden text, since usually you don't want to see it. It is
simply an internal identifier to the object in the genealogy file.
 

References

 
References to each record or event that links to that NOTE record are given. They include the name of the
person (as a hyperlink to the person), the number of the person, and if it is an event, then also the date
and the place of the event. Notes can also be attached to sources and objects, and if they do, then they will
include references back to them.
 

Unreferenced Notes

Any NOTE records that are not linked to are listed and are labelled as: "-unreferenced-". The label used can
be changed on the Organize Report Page.



Behold's User Guide - Section 4a - Note Details

- 166 -

 



Behold's User Guide - Section 4b - Object Details

- 167 -

Section 4b - Object Details
 

 
Objects are usually pictures, sound files, videos, or other physical items that may be associated with the genealogy
file.
 
Most information about objects in genealogy files are included inline. This is how object information will look:
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Only a few genealogy programs use objects more than once. They create an object record, and link to that record
instead. If there is only one link to a record, then Behold includes it inline where the link is and it is shown like the
object information just described.
 
But if there are two or more links to an object record, or if there are no links to the object record, then this information
is added into the Object Details section. This allows the information to be included only once, and will have references
back to the links.
 
The link to the Object Details section look like this:
 

      
 
 

Object Numbering

 
Object numbers have an "O" prefix and are numbered sequentially.
 

Object Title and Order

 
The first significant information for the object is used as its title. Objects are ordered by this title.
 

Object ID

 
The Object ID of the object information from the file is shown by default as hidden text, since usually you
don't want to see it. It is simply an internal identifier to the object in the genealogy file.
 

Object Information

 
Information about the object is listed.
 
When the "show all" text option is selected, then hidden text is shown in grey. Otherwise it is not shown.
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Subobject Info and Title

 
Sometimes, references are given to subinformation within the object information. In this case, the "1" refers to
the area 1 of the picture of Charles and Margaret Munro, and refers to the rectangle in the picture containing
Charles. The O1-1 will be the numbering used by Behold to represent that subintormation.
 
The details and style of this is very dependent on the information contained in the genealogy file. Behold
should be able to display the information and subinformation for any type of object.
 

References

 
References to each record or event that links to that object are given. They include the name of the person
(as a hyperlink to the person), the number of the person, and if it is an event, then also the date and the place
of the event.
 

Unreferenced Objects

 
Any object information that is not linked to is listed and are labelled as: "-unreferenced-". The label used can
be changed on the Organize Report Page.
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Section 5 - Place Details
 

 
The Place Details report is an index of all places. It is ordered by place heirarchy, and organizes the events by date.
This format is designed to make it easy for you to find out at a glance what information you have or don't have about
specific places.
 

Place

Places are shown in reverse order (using the comma to separate jurisdictions), and ordered by the reverse
place using a smart address sort, so that 3 Main Street will preceed 22 Main Street which will preceed 111
Main Street.
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Records, Events and Facts

All the records, events and facts that include this place are shown. They are sorted by date. Events without
dates are shown first.
 

References

 
The people involved in the event at this place are each listed, along with their age and marital status at the
time. All detail information about the event is also shown including notes and sources.
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Section 6a - Repository Details
 

 
A repository (rhymes with suppository) is the place where you found one or more sources. Behold lists all the sources
you obtained from each repository, so you will know what sources you've already investigated.
 
Usually a source will refer to the repository it was found in, and is often done with a Repository fact. This reference will
look like this:
 

        
 
 

Repository Numbering
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Repository numbers have an "R" prefix and are numbered sequentially.
 

Repository Title and Ordering

The first significant information for the repository, usually its name, is used as its title. Repositories are
ordered by this title.
 

Repository ID

The Repository ID of the record is shown by default as hidden text, since usually you don't want to see it. It is
simply an internal identifier to the repository in the genealogy file.
 

Repository Information

 
Information about the repository is listed. Every fact starts a new paragraph, with subinformation included and
indented.
 
When the "show all" text option is selected, then hidden text is shown in grey. Otherwise it is not shown.
 

References

References to all the sources that link to the repository are given. They include the title of the source
(hyperlinking to it) and the number of the source.
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Section 6b - Source Details
 

 
Behold lists all your sources together as a master reference letting you see all the data you have used and where
you've used each of them in your genealogy.
 
Sources describe where your information came from. A source can be any type of record, person, document, book,
etc. Within any particular source may be any number of source references that specify a particular location within the
source, e.g. a page number, an entry in a database, or a line in a census form.
 
The source references describe the location of the specific items of information you use to help you come to your
conclusions. Once some information is used to prove or disprove something, it becomes evidence.
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When information is obtained from a source reference, the link to the source reference includes both the source title
and the source reference and looks like this:
 

       
 
Sometimes the source itself provides the information. Then we will refer to the source rather than the source reference
and will then look like this:
 

        
 

Source Numbering

Source numbers have an "S" prefix and are numbered sequentially.
 

Source Title and Ordering

The first significant information for the source is used as its title. Sources are ordered by this title.
 

Source ID

The Source ID of the record is shown by default as hidden text, since usually you don't want to see it. It is
simply an internal identifier to the source in the GEDCOM genealogy file.
 
Note there's no such thing in a GEDCOM file as Source Reference ID. GEDCOM files include the Source
Reference with the information right after the link to the Source ID. This is cumbersome as it does not easily
allow one Source Reference to be used multiple times. Behold's internal format fixes this by creating a source
reference record that stands on its own.
 

Source Information

 
Information about the source is listed. Every fact starts a new paragraph, with subinformation included and
indented.
 

Link to Repository

 
This is the where the source was found.
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Object Information

 
Genealogy files may link to images, videos or other media. These are usually done as external objects.
Different genealogy programs produce these objects in different ways, but often they will use a link to the
object. The file suffix, in the example above being ".jpg", will define the type of object. Clicking on the link will
invoke the program to open that object for you.
 

Source Record Numbering

Source Record numbers begin with the source number they belong to, followed by a hyphen and are then
numbered sequentially for each source record within that source.
 

Source Record

The first significant information for the source record, usually the location within the source, is used as its title.
Sources records are ordered within its source by this title. A smart ordering is used, so that numbers will sort
correctly.
 

Information that is Sourced

 
Every record, event and fact that uses this source record is listed.
 

People Referenced

All the references back to the people referenced for this event for this source are listed (as a hyperlink to the
person) with the number of each person, and if determinable, their age and marital status at the time.
 

Source Evaluation and Reasoning

 
Information included in the source reference is then listed. This could include a user evaluation of the source
(e.g. Quality), reasoning leading to the conclusions, or any other user information or analysis that was based
on this source for this person for this event.
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Section 7 - (custom record) Details
 

 
Some genealogy programs use top-level custom records that are specific to their program. They may export these to
a GEDCOM file that you import to Behold. Any such records are displayed in the Custom Record Details section. Each
type of custom record has their own section and records within the section are numbered sequentially.
 
The above example is from a GEDCOM produced by the program GenoPro which adds additional information in many
different types of custom records.
 
References to a custom record looks like this, with the hyperlink on the record ID if the record does not have a title:
 

 
or like this with the hyperlink on the title if the record has a title:
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Custom Record Section Title

The title of the section is based on the record type used in the genealogy data. In this case the GEDCOM file
had a record type of "_LOC", where the leading underscore is the GEDCOM convention for allowing custom
tags.
 

Custom Record Numbering

Custom Record numbers use their record type as their prefix and are numbered sequentially.
 

Custom Record Title

The first significant information for the custom record is used as its title. Custom records are ordered by this
title. This particular example does not have any information that usable as the title.
 

Custom Record ID

The Custom Record ID of the record is shown by default as hidden text, since usually you don't want to see it.
It is simply an internal identifier to the custom record in the GEDCOM genealogy file.
 

Custom Record Information

 
Information about the custom record is listed. Every fact starts a new paragraph, with subinformation included
and indented.
 

Custom Record References

References to each person, event or fact that links to the custom record are given. They include the event/
fact, date, place (as a hyperlink to the place), name of the person (as a hyperlink to the person) and the
number of the person.
 



Behold's User Guide - Section 8 - Undefined Records

- 179 -

Section 8 - Undefined Records
 

 
Sometimes, some genealogy data files contain links to records that don't exist in the file. All that is available is the
link information. Since there is no record, there is no place to attach these references, so these are added into an
Undefined Records section. This section is only included if there is at least one undefined record.
 
If your file has undefined records, you should attempt to fix these in your genealogy software. Maybe you need to
define the note, source or object that the link is supposed to point to. Or maybe the link is simply pointing to the wrong
record. You'll have to be a detective to figure out what's wrong so that you can fix it.
 

Undefined Record Numbering

Undefined Record numbers use the word "UNDEF" as their prefix and are numbered sequentially.
 

The Link ID
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This is the ID in the genealogy data of the link for which there is no record for.
 

References to this Link

These are the records/events/facts that have this undefined link.
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Section 9a - File Information
 

File Numbering

Note numbers have an "F" prefix and are numbered sequentially. Remember that Behold can open multiple
genealogy data files at once, and this section will give the details of each of the files.
 

File Name

This is the name of the file. The .ged suffix is used for GEDCOM files.
 
Behold (.bho) files are simply organizational files with no data that point to one or more GEDCOM files. So if
you open a Behold Organize file, it will in effect open the GEDCOM files that it uses. Those GEDCOM files
opened will be listed in this section.
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File Information

 
This is the information that is contained in the HEAD section of the GEDCOM file.
 

Extra Information

This is extra information that Behold provides about the file.
 

Concatenate Method

 
GEDCOM has a standard for concatenating two lines. It requires that one word between the two lines be split
so that the first part of the word is at the end of the line and the last part of the word is at the beginning of the
second line. This way, the two lines can be put together without the need to worry about whether or not to
include a blank between them.
 
Unfortunately, many programs do not do this correctly, but put a complete word at the end of the first line and
start a new word at the beginning of the second. These programs add a space between the two lines.
 
Behold knows how many different programs handle concatenate, and then assumes what method is used.
This message tells you about the assumption, how to tell if it's wrong, and what to do if it is.
 
You can change the way Behold to handles the CONC tag independently for each GEDCOM you input by
changing its setting on the Organize GEDCOMs page.
 

Summary of Messages
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Behold does extensive error checking when inputting GEDCOMs. The messages are summarized here.
Abbreviated messages are given here. Complete messages are given in the log file. The number in
parentheses, e.g. (42) and (5) is the number of occurrences of each message.
 

Log File Information

 
The path to the log file is given. It is a hyperlink, and if it is clicked, the log file will open for your inspection.
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Section 9b - Submitter Details
 

 
GEDCOM files contain a submitter section. This is usually the name of the person who created the genealogy data file.
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Section 9c - Submission Details
 

 
This is information that is included with some GEDCOM files about submissions of the data to the Latter Day Saints
Church for religious purposes.
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Bottom of Report
 

 
The last few lines of the report give the version of Behold being used, as well as the processing time and memory used
to input and display the data.
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Everything Report Right-Click Menu
 

 
When you are in the Everything Report and you click on your right mouse button, this menu will pop up.
 

Instant Organize: Stephen McCARTHY

When you right-click on any person or couple, then the Instant Organize function on this pop-up menu item
becomes active and seeded with the names of who will be instant organized.
 

Add Family of: Stephen McCARTHY

When you right-click on any person or couple, then the Add Family Of function on this pop-up menu item
becomes active and seeded with the names of who will be instant organized.
 

Find in TreeView

Synchronizes the TreeView with where you are in the Everything Report, and will open the TreeView so that
the current entry and its children are visible.
 

Help

Brings up the Help page for the section of the EverythingReport you are in. Pressing the F1 key in the
Everything Report will do the same.
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The TreeView
 

 
The TreeView is like an expanded table of contents into the Everything Report. It is provided for quick and easy navigation.

You can place the TreeView either to the left of the Everything Report, or on top of the Everything Report. Use the Tile Top
and Bottom and Tile Left and Right commands to change the orientation. The TreeView cannot be removed or hidden
from the main window.

Clicking on any entry in the TreeView will bring up that entry in the Everything Report.

Right-clicking in the Everything Report and selecting "Find in TreeView" will set the active entry in the TreeView to the
correct node and bring it into view and highlight it.

There are also a number of keyboard shortcuts for the TreeView.
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Connecting Lines

 
Different generation levels are connected by dotted lines. Sort of like a tree.

 

Expand/Collapse Boxes

Click on a plus-box to expand the nodes it contains by one level. Click on a minus-box to collapse the nodes
it contains.
 

Numbering

The numbering is the same as in the Everything Report.
 

The Active Entry

When clicking on an entry with the mouse, or while moving from entry to entry with the arrow keys, the
current entry is the active entry and is highlighted with white text on a blue background. Also, when an entry
becomes active, the Everything Report will scroll to the corresponding location.
 
If the TreeView is not active, the active entry is still highlighted, but in less bold colors like this:

 

Number of Expandable Entries

 
There is a number at the end of a line in parenthesis for every node that can be expanded. This is the number
of nodes that can be expanded. Clicking the plus key will only expand one level of nodes at a time, which
may not be all the hidden notes. To expand all levels and all hidden nodes at once, make the node active by
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clicking on it, and use the Times key (also known as the asterisk, which is above the 8 on the keyboard and
also on the keypad).
 
Note that this number of hidden entries is not the same as the number of people. In Behold, one entry may be
two married/matched people, or it may be a person who is repeated because of a second marriage. So the
number of entries and the number of people, although sometimes close in number, are usually different.
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TreeView Right-Click Menu
 

 
When you are in the TreeView and you click on your right mouse button, this menu will pop up.
 

Instant Organize

When you right-click on a tree entry that is a person or couple, then the Instant Organize function on this pop-
up menu item becomes active and seeded with the names of who will be instant organized.
 

Add Family of: Stephen McCARTHY

When you right-click on a tree entry that is a person or couple, then the Add Family Of function on this pop-up
menu item becomes active and seeded with the names of who will be instant organized.
 

Help

This will bring up the Help page for the TreeView. Pressing the F1 key anywhere in the TreeView will do the
same.
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The Menu Bar
 

 
 

This is Behold's menu bar. Selecting one brings up its submenu.
 
If you press the Alt key and then press the underlined letter, you will activate the menu item with the underlined letter.
This is a standard Windows capability and is implemented in Behold for all menus and submenus.
 
 
Submenu items, e.g.:
 

 
Submenu items such as Open may show an icon on the left. This icon may appear on the toolbar.
 
Three periods following the item name tells you that this function will open a window asking for more information. Items
not followed by three periods are executed immediately.
 
If the command has a keyboard shortcut, then it is shown on the right.
 
If the item is greyed out, then that command is cannot be executed in the current context.
 

File

Open, close, and do other neat stuff with files. See: The File Menu
 

Edit

Currently doesn't do much, but it will do a lot more when editing is added in Version 2. See: The Edit Menu
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Search

From this menu, you can find stuff in the Everything Report. See: The Search Menu
 

Navigate

Move around the Everything Report ... or STOP! See: The Navigate Menu
 

View

Check out your input file, log file, and set options on what to display and how to display it. See: The View
Menu
 

Organize

Lot's of good stuff here. See the Organize Pages and view your data in different ways. See: The Organize
Menu
 

Help

Everything you'll need to know is here. See: The Help Menu
 

Check for New Version

This menu item will only appear when Behold somehow knows that a new version is available, either through
you checking manually, or through you allowing Behold to check automatically for you.
 
Clicking on this item will bring up the Web Update Window.
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The File Menu
 

 

New

Closes the current file and creates an empty Everything Report.
 

Open

Displays a standard Open File dialog. You can open either GEDCOM files or Behold Organize files.  See:
Open File Dialog.
 

Add GEDCOM(s)

Displays a standard Open File dialog so you can choose one or more GEDCOMs to add to any files that are
already open. Then the combined result is displayed in the Everything Report.  You select the files to add with
an Open File Dialog.
 

Save

Saves the current Behold Organize file. See: Behold Organize Files.
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Save As

Saves the current Organize Information into a Behold Organize file.  See: Save As Dialog and  Behold
Organize Files.
 

Export

Export's the current Everything Report into different formats:
 

 
HTML (Hypertext Markup Language) is for viewing in a web browser (like Internet Explorer or Firefox) and
can be put up on a website. See: HTML Export.
 
RTF (Rich Text Format) is a word processor format that can be loaded into WordPad, Microsoft Word and
similar programs and can then be further edited and saved from that package if you would like. See: RTF
Export.
 
You select the file to export to with a Save As Dialog
 
The entire Everything Report is exported as a single file that will look almost identical to way it looks in
Behold.
 
After the file is exported, Behold will ask you if you want to view the file:

 
If you say yes, then for an HTML export, the file will open in your default web browser. For an RTF export, it
will open in your default Rich Text Format handler (which will be Microsoft Word if you have that installed).
 
Note: Some genealogy data files can be quite large. A large file exported to HTML or RTF will also be large.
Your web browser or RTF reader may have trouble reading such a large file.
 

Close

Closes the current file and creates an empty Everything Report. (same as "New").
 

Print
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Prints all or part of the Everything Report.  See: Print Dialog.
 

Print Preview

Previews what the Print will look like. See Print Preview Window.
 

Associate

Brings up a window that will allow you to associate (or unassociate) Behold with GEDCOM files (.ged) or
Behold Organize files (.bho). See Associate Window.
 

Default Language

Lets you select the default language translation file that Behold should use. This will allow you to display the
Everything report in any language you choose. See Default Language Window. You can also make your own
translation files.
 

Find Files

Opens a window that will let you search your computer for GEDCOM or Behold Organize files and display
information about them. See Find Files Window.
 

Recent Files

Displays your most recently opened GEDCOM and Behold Organize files so that you can easily open them
again.
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Above is an example of what the list will look once you've loaded a number of files into Behold.
 
GEDCOM files end with ".ged" and Behold Organize files end with ".bho".
 
The currently active selection (which your mouse is pointing to) is highlighted, e.g. number 2 above.
 
Files that no longer exist on your computer (maybe they were deleted or moved) are greyed out and cannot be
selected, e.g. numbers A and B above.\
 

Exit

Bye bye.
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The Edit Menu
 

 
 
Behold does not yet allow you to save your edits. That will come in version 2.0.
 
However, you can make temporary on screen edits prior to copying to the clipboard or printing a selection.
 
This menu contains the standard windows clipboard functions: Cut, Copy and Paste, as well as Undo and Redo. They
also have toolbar entries and use the standard Windows keyboard shortcuts.
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The Search Menu

 

Find

Brings up the standard Find Dialog to allow you to search through the Everything Report for specific text.
 

Find History

This will allow you to repeat your most recent previous searches.
 

Find Next

The most recent search will be repeated. Using the F3 key is a quick and easy way to do this.
 

Find Prev

The most recent search will be repeated, but the search will be for the previous occurrence. Using the F4 key
is a quick and easy way to do this.
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The Navigate Menu
 

 
<TODO> Insert description text here... And don't forget to add keyword for this topic

Top and Bottom

Does what it says it does.
 

Back and Forward

These work like Back and Forward keys in an Internet Browser. Behold remembers everytime you use a
hyperlink to move to some other place in the Everything Report. You can use the Back command to move
to the previous place in the report, and once you've moved back, you can move forward again. Behold
remembers many steps back. The toolbar items for this command offer a dropdown box, where you can
select the location you want to go to.

 

Stop

This command is intended to stop loading files. If you have small files, they will load very quickly and you
probably won't have time to use this command. But if you have very large files that take a while to load, you
can use the Stop command to interrupt the loading.
 
Note that it may take a second or two after you press the stop command for the interruption to happen.
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The View Menu
 

 

Behold Organize Info

Opens the Organize Window. Using the F9 key is a quick way of doing this.
 

View GEDCOMs

Opens all of the loaded GEDCOMs using the the default program for text viewing for your computer. Usually
that is Notepad.
 

View Log File(s)

Opens all of the log files using the default program for text viewing on your computer. There is one logfile for
each GEDCOM loaded.
 

Tile Top/Bottom Left/Right

These two commands allow you to place the TreeView above the Everything Report, or to the left of the
Everything Report. Only one of these two commands is active at any time, since you are always in one mode
or the other.
 
Putting the TreeView on the left of the Everything Report makes it look like the standard Explorer window.
If you find too many of your tree items are cut off, or if you'd like more width to your Everything Report, you
might want to switch your view to top and bottom. You can switch any time you want. Behold will remember
the setting you last used the next time it starts.
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Text Size

Allows you to select the size of the text used in the Everything Report and TreeView. There are five different
settings you can choose from, ranging from smallest to largest.
 

Selected Tags / All Tags

This will instantly toggle the display of hidden text.
 
When hidden text is displayed, it is shown in grey text.  When it is not displayed, then it is hidden.
 
Printing or exporting the report will look exactly like the screen - in other words, hidden text will either be
included in grey or not included depending on this setting.
 

Related Through Marriage

 
Toggles the inclusion and exclusion of the Related Through Marriage section of the Everything Report.
Toggling this allows you to select or deselect the "Others Related Through Marriage" selection on the
Organize Families page without having to open that Organize window to do so.
 
If this is turned off, then these people will be added to the Everyone Else section. 
 

Everyone Else
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Toggles the inclusion and exclusion of the Everyone Else section of the Everything Report. Toggling this
allows you to select or desect the "Everyone Else" selection on the Organize Families Page withouth having
to open that Organize window to do so.

 

Life Events

Toggles the display of Life Events. Live Events start with a purple text. They are the events of close relatives
that may be important in the person's life and may give clues about the person.
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The Organize Menu

 

Open Organize Pages

 
These five commands will all open the Organize window and bring up the page with that specific name.
 

Reload

 
Reloads the file as it was as you first loaded it, unless you had saved it as a Behold Organize file in which
case it will take reload that Behold Organize file.
 
This command only gets activated once you've changed some some Organize window items and applied
them. Prior to doing the reorganize, Behold will bring up the following window to see if you want to save your
current settings before you revert back to the former ones.
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Instant Organize

 
Instant Organize will rebuild the report about a selected person or couple. The report will run with Related
Through Marriage turned off and Everyone Else also turned off.
 
The idea is that this will become a report that is specifically about a person or couple and all of his/her/their
relatives and only his/her/their relatives. Then you will be able to send the report to them, and ask them to
update the information which will be made up of only those people common to both your family trees.
 
The report will order the individuals within families starting with the selected person, and going up one
generation at a time. This keeps the person's closest relatives at the beginning of the report for them - and
those are the people they will have the most information about and be able to help you the most with.
 
If you do not want the within families individuals ordered this way, it is a simple one click step to press the
Down From Ancestors toobar item and switch the order back:

 
If a couple was selected, then it will then follow with the second person and continue in the same manner.
 
You can also do this function by right-clicking from the Everything Report and you will find "Instant Organize:
(person/couple)" on the menu that pops up.
 

Add Family of

 
Adds the family under the cursor to the Organize Families page. It will then open the Organize Families page
and allow you to make further edits, or apply the changes. You don't have to apply the changes right away.
You can go back to the Everything Report and add other families to get all the families you want prior to
applying the changes.
 
You can also do this function by right-clicking from the Everything Report and you will find "Add Family of:
(person/couple)" on the menu that pops up.
 
Families can also be added by using the Add button on the Organize Families page.
 

Order Individuals
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Within each family, there are four ways to order individuals. The main option for this is found on the Organize
Numbering page, but these four commands will allow you to instantly change the ordering. These commands
are also available for easy access on the toolbar.
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The Help Menu

 

User Guide

 
Brings up the first page of this User Guide.

 

Quick Start

 
Brings up the Quick Start page of this User Guide.
 

Good Ideas

 
Opens the Good Ideas window.
 

License and Readme
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Uses the default text file reader and opens Behold's Licence file or Readme file, depending on which was
selected.
 
The Licence file tells you what Behold is warrantied for.
 
The Readme file gives you important information about Behold.
 

Behold Website Links

 
Will open your browser and take you to some of the important pages on Behold's website.
 

Check Online for New Version

 
Goes out to Behold's website and reads a file that says what the most recent version of Behold is. It will then
tell you if you have the latest version with the following window:
 

 
If you do not have the latest version, a slightly different Window will appear asking you if you want to update
to the most recent version of Behold. This is described in detail in How to Upgrade to a New Version.
 
Since all future versions of Behold are free once you purchase a license, you can use this function to keep
your version of Behold up to date.
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If you check the "Check Automatically" box, then every time you start Behold and only if you are already
connected to the Internet, then it will go to the Behold website and look in a small text file that contains
the current Behold version number. If the version is different then a "New version available" menu item will
appear to the right of the Help menu as follows:

Clicking on the "New version available" menu item will bring up the Web Update window to get the new
version.
 

About Behold

 
This brings up the Behold information window. If you've purchased a licence, it will look like this:
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The Top Toolbar
 

 

File Menu Buttons

 Open: to open a file. It has a dropdown that allows you to select recent files you opened.

 

  Save: to save the current Behold Organize file.
 

 Print: to print the Everything Report.
 

 Print Preview: to preview what the print of the Everything Report will look like.
 

 Find Files: to search your disk for GEDCOM, Behold, or Behold log files.
 

 Exit: to quit Behold.
 

Edit Menu Buttons

 Cut - Cut the selection to the clipboard.
 

 Copy - Copy the selection to the clipboard.
 

 Paste - Paste from the clipboard.
 
See Edit Menu.
 

Search Menu Buttons

 Find: Open the Find Dialog to find text. Also a dropdown to select from your find history.
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 Find Previous: Search for the previous occurrence of the most recently searched text.
 

 Find Next:  Search for the next occurrence  of the most recently searched text.
 

Navigate Menu Buttons

 Back: Go to the previous location in the Everything Report, with a dropdown of recent locations.

 

 Forward: Go to the next location in the Everything Report, with a dropdown of recent locations.

 
See Back and Forward
 

 Stop: Cancel the loading of a file.
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The Bottom Toolbar
 

 

View Menu Buttons
 Behold Organize Info - Opens the Behold Organize pages.

 

 View GEDCOMs - Opens the input GEDCOM files in your default text browser.
 

 View Log File(s) - Opens the log files with detailed messages about the input GEDCOM files.
 

 Tile Top and Bottom - Put the TreeView on top of the Everything Report.
 

 Tile Left and Right - Put the TreeView to the left of the Everything Report.
 

 Text Size - Cycle through the allowed text sizes allowed in the Everything Report from smallest to largest.
 

 Selected Tags / All Tags - Toggle between showing information for your selected tags and showing all
information.
 

 Everyone Else - Toggle between showing or not showing non-related people.
 

  Life Events - Toggle between showing or not showing the important events of people closely related.
 

Organize Menu Buttons

 Reload - Regenerate the Everything Report using the last saved Behold Organize file, or if none, the
original file.
 

 Instant Organize -  Organize around a specific person/people. It has a dropdown containing past
selections:
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 Add Family of - Adds the selected family to the Organize Families page.
 

 Down From Ancestors - Orders people within families by descendant line.
 

 Up To Ancestors - Orders people within families going up one generation at a time.
 

 Descendants Only - Only shows the descendants of the the selected person/people.
 

 Surname Order - Orders people within families by ancestral surname.
 
See Order Individuals
 

Help Menu Buttons
 Help Contents - Opens the Behold User Guide and displays the First Page and Table of Contents

 

 Behold Home Page - Opens the Behold website's home page in your default web browser.
 

 Online Discussion Forum - Opens the Behold website's user forum in your default browser.
 
See Behold Website Links
 

 About Behold - Opens the window with information about Behold.
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Behold's Organize Window
 

 
Behold allows you to customize the way you organize your data for viewing in the Everything Report. You do this on
the Organize pages. This organize information can then be saved into Behold Organize files so you can store and
retrieve all the various ways you'll want to organize and view one or more files of genealogy data.
 

Tabs for Organize Pages

There are five organize pages. At the top of the pages is a tab index allowing you to select the page you
want.
 

Specific Page Content Area
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Each page has its own specific page content.
 
See:
GEDCOMs Page
Families Page
Numbering Page
Tags Page
Report Page
 

Specific Page Commands

Each page has its own specific page commands at the right of the page.
 
See:
GEDCOMs Page
Families Page
Numbering Page
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Tags Page
Report Page
 

Common Page Commands

Every page has the same commands at the bottom of the page.
 

Save button

Saves the organize information into a Behold Organize File.
 
A standard Save As window will pop up asking you for the name of the file you want to save it as. If a
filename is already provided, then that was the name of the Behold Organize file loaded or the last Behold
Organize file saved. This will allow you to overwrite the file, which you'll want to do if you are changing the
way you want that saved file to have different organize information. If so, you'll get a Confirm Save prompt, to
ensure you don't actually overwrite the Behold Organize file when you didn't intend to:

But some times, you'll want to save the organize information as a different file, so you can select "No", which
will bring you back to the Save As window, and you can change the file name to something else, e.g. "Only
Relatives of Stephen McCarthy in French.bho".
 

OK button

The OK button will accept all changes you made on any and all of the Organize pages, will update the
Everything Report to use the new organize information, and will then close the Organize page.
 

Cancel button

The Cancel button will cancel all changes you made on any and all of the Organzie pages, and will then close
the Organize page.
 

Apply button
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The Apply button will accept all changes you made on any and all of the Organize pages and will update the
Everything Report to use the new organize information. However it will leave the Organize pages open so you
can make more changes if you want.
 
There are two differences between the OK button and the Apply button. The first is that OK closes the
Organize pages, but Apply leaves them open. The second is that OK is always active, but Apply (and also
Cancel) is only active if changes have been made to the Organize information.
 

Help button

The Help button will bring up the page you are now looking at. The F1 key will do the same.
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GEDCOMs Page
 

 

GEDCOMs Tab Selected

The GEDCOMs tab will appear to be selected when you are on the GEDCOMs page.
 

GEDCOM Lines

 
Behold can load one or more GEDCOM file at one time. Each file has its own line on this page. Each line
includes:
 
1.  A file selection box. A checkmark in the box indicates the file will be included in the Everything Report.
An empty box means it will not be included in the Everything Report. This is a quick way to exclude the
information that makes it easy to add it again later. You can select/deselect by: Clicking on the box with your
mouse, activating the line and pressing the space key, or activating the line and pressing the Select button.
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2.  File: The filename
 
3.  Path: The file directory
 
4.  Num: A sequential numbering of the selected files.
 
5.  ID: A short identifier you can assign to easily recognize which GEDCOM file it is. You can edit this identifier
by clicking on it with your mouse, or by activating the line and pressing the Edit ID button. The GEDCOM ID is
used on the Organize Families page to indicate which GEDCOM each family comes from.
 
6.  CONC: An indicator of how to handle the Concatenate tag in this GEDCOM file. A zero "0" will add zero
spaces between CONC lines. A one "1" will add one space between lines. A blank indicates Behold will try to
decide which method to use the next time you load this file, and will fill in its guess (0 or 1) after you load the
file. If Behold is not correct, you can change the value here by clicking on it with your mouse, or by activating
the line and pressing the Edit CONC button. Behold's File Information explains more about the inconsistent
implementation of the CONC tag.
 
To activate a line, click on it with your mouse. Once a line is activated, you can use the mouse or the up and
down arrow keys to change the activated line.

 

Add Button

This will bring up a standard Open File dialog that will let you select one or more GEDCOM files to add one to
the GEDCOM selections list.
 
Another way to add GEDCOM files is with the Add GEDCOM(s) command on the File Menu.
 

Remove Button

When you've activated a GEDCOM line, you can completely remove it from the list with this button.
 
Note that this is very different than deselecting a line, which leaves the GEDCOM file in the list, but just does
not display it in the Everything Report.
 

Move Up/Down Buttons

When a line is activated, these buttons will move the GEDCOM file up or down one line. When you move a
GEDCOM, the GEDCOMs involved in the move will switch numbers.
 
This is used mainly to number the GEDCOMs in the order you want. A few items in the Everything Report
(such as File Information) are displayed in the GEDCOM order. But most of the ordering in the GEDCOM file
is based on families and is controlled by the order of the families on the Organize Families page.
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Select Button

When a line is activated, this button will select or deselect the GEDCOM for that line. You'll notice the effect in
the checkbox for that line. Selected GEDCOMs are included in the Everything Report. Unselected GEDCOMs
are not.
 

Edit ID Button

When a line is activated, this button puts the ID for the line into edit mode.
 

Edit CONC Button

When a line is activated, this button puts the CONC for the line into edit mode.
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Families Page
 

 

Families Tab Selected

The Families tab will appear to be selected when you are on the Families page.
 

Family Lines

 
Behold organizes your data into families. A family is made up of all the people related to some individual. This
includes all that person's blood relatives, spouses or partners of their blood relatives, and descendants of
the spouses/partners of their blood relatives. So half-families and step-families are included. If the data file
includes adopted parents or other parent relationships, then their families are considered part of the family as
well.
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So in the example above, there are two family lines. The first is the Family of Stephen James McCARTHY
and the second is the family of Stephen's wife: Dianne Marie [JACK] McCarthy. The Everything Report
displays the families in the order given.
 
The last two lines are always: Others Related Through Marriage and Everyone Else. Both are optional, and
allow you to also include the other people in the data files, but not in any of the other previously specified
families.
 
Each family line contains:
 
1.  A family selection box. A checkmark in the box indicates the family will be included in the Everything
Report. An empty box means it will not be included in the Everything Report. This is a quick way to exclude
the family that makes it easy to add it again later. You can select/deselect by: Clicking on the box with your
mouse, activating the line and pressing the space key, or activating the line and pressing the Select button.
 
2.  Family of: The person whose relatives will make up the family (but remember that the last two lines are the
special ones).
 
3.  GEDCOM: The ID of the GEDCOM file that this family comes from. The GEDCOM ID is specified on the
Organize GEDCOMs page.
 
4.  Num: A sequential numbering of the selected families. The family number can be optionally used in
Numbering.
 
5.  ID: A short identifier you can assign to easily recognize the family. You can edit this identifier by clicking on
it with your mouse, or by activating the line and pressing the Edit ID button. The family ID is by default used in
numbering, but you can change this on the Organize Numbering page.

 
To activate a line, click on it with your mouse. Once a line is activated, you can use the mouse or the up and
down arrow keys to change the activated line.
 

Add Button

This will show you the following information box:

After you click OK, the main Behold window will be brought forward, and you can find the families you want
either in the TreeView or the Everything Report, and use the Add Family Of command to add the families you
want.
 

Remove Button
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When you've activated a family line, you can completely remove it from the list with this button.
 
Note that this is very different than deselecting a line, which leaves the family in the list, but just does not
display it in the Everything Report.
 

Move Up/Down Buttons

When a line is activated, these buttons will move the family up or down one line.
 
The Everything Report is generated in the order of the family lines given here, so the first families listed will
be first in the Everything Report. Also, when you move a family, the families involved in the move will switch
numbers.
 
Related Through Marriage and Everyone Else are always the last two families and cannot be moved.
 

Select Button

When a line is activated, this button will select or deselect that family line. You'll notice the effect in the
checkbox for that line. Selected families are included in the Everything Report. Unselected families are not.
 

Edit ID Button

When a line is activated, this button puts the ID for the line into edit mode.
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Numbering Page
 

 

Numbering Tab Selected

The Numbering tab will appear to be selected when you are on the Numbering page.
 

Within Family Ordering

This is how Behold will order all the people within every family. Choices are:
 
1.  Down from Ancestors:  This is the default method. Every ancestral line begins with the earliest ancestor.
The ancestral lines are chosen with a father bias, so that in a two generation ancestry: "father's father" comes
first, followed by "father's mother", followed by "mother's father", followed by "mother's mother".
You'll want to use Down from Ancestors most of the time. It will easily allow you to see where all the ancestral
lines start.
 
2.  Up to Ancestors:  This is the default for an Instant Organize. It starts with the individual and his/her
spouses/partners. It then selects the next ancestral lines by working up generation by generation. The
second line is that of the individual's parents. The third is of the spouse/partner's parents. The fourth is of the
individual's father's parents, fifth is the individual's mother's parents, etc. It follows the order of your typical
pedigree chart, moving up on a generation by generation basis.
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Typically, you'll use Up to Ancestors when you want to concentrated first on the individual at hand, and then
slowly move from the closer relatives to the less related relatives. This is a great format to send to your
relatives, because they'll see first the information they know most about that they can correct for you.
 
3.  Descendants Only:  This starts with the individual and his/her spouses/partners as the only ancestral line.
You'll want this if you don't want to include all the relatives of someone. Maybe you want only a certain family.
By specifying the ancestors you want as families on the Organize Families Page, you can customize your
initial ancestral lines exactly as you want.
 
4.  Surname Order: This will take each ancestral line, but order them by the ancestors' surname.
To be honest, I'm not sure why you'd want this, but the option is there. Maybe you've got the genealogy
of a whole town and don't want to prioritize the ordering. The disadvantage is that the first lines (first in
the alphabet) will tend to have the most complete set of descendants, whereas the later lines (last in
the alphabet) will have a lot of cross references back to the first lines, because Behold does not repeat
information but instead hyperlinks back to it.
 
Those four options define how to select and order each of the lines within the family. Then within each
ancestral line, the descendants are listed with an eldest child bias, so that in a two generation descendancy:
"eldest child's eldest child" is followed by "eldest child's youngest child", followed by "youngest child's eldest
child" followed by "youngest child's youngest child".

 

ID Style

There are five choices for how you want IDs assigned to people:
 
1.  FamNum  e.g. 147.  This will number the people sequentially thoughout the Everything Report. This makes
it easiest to find an individual person.
 
2.  FamID-DesNum  e.g. FAM-26  will be the 26th entry in the family with the ID "FAM". You specify the family
ID on the Organize Families page. This is the default method and makes it easy to identify both the family
and where within the family you are.
 
3.  FamNum-DesNum  e,g, 5-26  will be the 26th entry in the 5th family. This is will be still indicate the family,
but is easier to find then FamID-DesNum.
 
4.  FamNum-FamID-DesNum  e.g. FAM-5-26  is good if you want both a family identifier and a family order
indicator.
 
5.  FamID-FamNum-DesNum  e.g, 5-FAM-26  or maybe you like this better.
 
There are reasons why Behold does not use standard genealogy numbering systems, described on the How
To Assign IDs (Numbering) page.
 

FamID Length

This specifies how many characters the default ID for a family will be. The default ID is selected using the
surname of the person who defines the family. e.g. If this is the family of Steve McCarthy, then a 3-character
family ID would be "McC" and a 5-character family ID would be "McCAR".
 
These defaults are added on the Organize Families page when the family is added. You can edit and
customize the ID on that page.
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FamID Format

Specifies whether you want the default ID for a family to use the surname of the person exactly as it is given,
or if you want it capitalized. e.g. For the familyof Steve McCarthy, a 3-letter FamID would be "McC" in mixed
case, and "MCC" in all caps.
 

Preview

This preview gives you an example of what the ID will look like using the ID Style, FamID Length values and
FamID Format values.
 

Load From Button

Opens a standard Open FIles dialog and allow you to specify a Behold Organize file. The numbering options
from that Behold Organize file will be loaded.
 
If you have different numbering systems you like to switch between, you can save them in appropriately
named Behold Organize files to make them easy to load from.
 

Save Into Button

Opens a standard Save As dialog and allows you to select one or more Behold Organize files. The
numbering options from this page will be saved to all of those Behold Organize files.
 
This makes it easy to update the settings in a number of Behold Organize files at once.
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Tags Page
 

 

Tags Tab Selected

The Tags tab will appear to be selected when you are on the Tags page.
 

Tag Lines
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Each GEDCOM line contains a tag that defines the data on the line. It is usually a 3 or 4 character word in all
caps.
 
You can sort by any column by clicking on the column header. Clicking the same header again will sort in
reverse order. The small arrow up or down (shown above in the Tag section of the column header) tells you
what is currently the sort column and whether it is sorted up or down.
 
You can make columns wider or narrower by grabbing and moving the small line between the column
headers, or you can double-click on that line to make the column the right size to show the widest entry.
 
Each tag line contains:
 
1.  A tag selection box. A checkmark in the box indicates this tag will be displayed in the Everything Report.
An empty box means it will be hidden from the Everything Report. You can select/deselect by: Clicking on the
box with your mouse, activating the line and pressing the space key, or activating the line and pressing the
Select button.
You can use the Selected Tags/ All Tags command on the File Menu to display only the hidden tags, or
display all the tags with the "hidden" ones shown with grey colored text. A quick way of alternating between
the two is with the Selected/All Tags toolbar item which looks like a checkbox:

 
2.  The Tag: This is the GEDCOM tag used. Custom tags that some programs include usually begin with an
underscore "_".
 
3.  Text: This is the text to display in the Everything Report for that tag. Behold has default text values (in
English) that should be reasonable for most purposes. You can edit this text by clicking on it with your mouse,
or by activating the line and pressing the Edit Text button. You can also load in a translation file if you want to
use a different language.
 
4.  Number of Records: If a GEDCOM line is at level 0, then it is the beginning of a GEDCOM record, such as
0 HEAD, 0 @I1@ INDI or 0 @S1@ SOUR.
 
5.  Number of Pointers: If a GEDCOM line refers to a record, then it is a pointer. e.g. 1 HUSB @I1@ or 2
SOUR @S1@
 
6.  Number of Data items: These are normal GEDCOM lines, not the beginning of records, and not pointers.
e.g. 1 PLAC Winnipeg, Manitoba, Canada
 
7.  Total = Number of Records + Number of Pointers + Number of Data items.
 

Merge from Button

Opens a standard Open Files dialog and allow you to specify a Behold Organize file. The tag selections and
tag text from that Behold Organize file will be loaded.
 
If you have different sets of customized tags you like to use, you can save them in appropriately named
Behold Organize files to make them easy to load from.
 

Merge into Button
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Opens a standard Save As dialog and allows you to select one or more Behold Organize files. The non-
default tag selections and non-default tag text from this page will be saved to all of those Behold Organize
files.
 
This makes it easy to update the settings in a number of Behold Organize files at once.
 

Select Button

When a line is activated, this button will select or deselect that tag. You'll notice the effect in the checkbox for
that line. Selected tags are displayed in the Everything Report. Unselected tags are hidden.
 

Edit Text Button

When a line is activated, this button puts the text for the line into edit mode.
 

Use Default Button

Below the button is the default text for this tag. If the text is for the activated line is the same as the default,
then the button is not enabled. But if it is different, then this button becomes enabled, and clicking on the
button will set the text to the default value.
 

Show Used/Unused

The tag lines can show the tags that are used at least once, or not show them. The tag lines can show the
tags that are not used, or not show them.
 
Normally you'll want to see just the used tags, but sometimes you may want to see other tags that are
available in GEDCOM files that Behold knows about. These include some custom tags that some other
programs generate.
 
These two checkboxes are independent. Either or both may be checked.
 
 

Invalid Tag (in Bold)

If the tag is not a valid GEDCOM tag, then the tag name will be shown in bold text. This sample screen does
not show any non-valid GEDCOM tags.

Changed Tag Text (in bold)
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Any tag text that you edit and is now different than the default will be shown in bold. This sample screen does
not show any changed tag text.
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Report Page
 

 

Report Tab Selected

The Report tab will appear to be selected when you are on the Report page.
 

Report Customization Options

 
Behold allows you to decide what to include in the Everything Reports and also customize all the text that it
adds into the Everything Report.
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The Report Customization Options are divided into 5 parts:
 
1.  Contents:

  
This part lists the sections of the Everything Report, and allows you to decide whether or not to include that
section and what to display each title as. The Heading Lines are in the Top of Report section and the Trailer
lines are in the Bottom of Report section.
 
2.  Extra Info:
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The extra info items are worthy of more explanation: See the next page.
 
3.  Possible Data Problems
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You can select the data problems you want Behold to display, and the text to display with them. When the
text contains a number at the end that is used as the age condition, such as age < 14, or old > 106, you can
change that number to whatever you want, and the number you enter will be the age checked for.

 
4.  Relatives for Life Events
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You can specifiy how you want Behold to display relationships. Each relationship has three forms, female,
male and unknown or either sex. If you do not want to differentiate sex, or if the language you are using does
not differentiate, you can give all three the same name, as is doen by default as shown above for "Partner. "
 
5.  Text to Display
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The left item is some specific text, and the right item is what you want to display it as. These may be
displayed at various places in the Everything Report. There is no checkbox to select whether or not to include
each item, because these items normally need to be displayed.
 
 
You can sort by Item or by the "Display As" field by clicking on the column header. Clicking the same header
again will sort in reverse order. The small arrow up or down (shown above in the Item section of the column
header) tells you what is currently the sort column and whether it is sorted up or down.
 
You can make columns wider or narrower by grabbing and moving the small line between the two column
headers.
 

Merge from Button

Opens a standard Open Files dialog and allow you to specify a Behold Organize file. The item selections and
the item "display as" fields from that Behold Organize file will be loaded.
 
If you have different sets of report items you like to use, you can save them in appropriately named Behold
Organize files to make them easy to load from.
 

Merge into Button

Opens a standard Save As dialog and allows you to select one or more Behold Organize files. The non-
default report item selections and non-default report item text from this page will be saved to all of those
Behold Organize files.
 
This makes it easy to update the settings in a number of Behold Organize files at once.
 

Select Button
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When a line is activated, this button will select or deselect that report item. You'll notice the effect in the
checkbox for that line. Selected report items are displayed in the Everything Report. Unselected report items
are not shown. Some report items cannot be deselected. Their check box is shown in a grey color.
 

Edit Text Button

When a line is activated, this button puts the "display as" field for the line into edit mode.
 

Use Default Button

Below the button is the default "display as" field for this report item. If the "display as" field for the activated
line is the same as the default, then the button is not enabled. But if it is different, then this button becomes
enabled, and clicking on the button will set the "display as" field to the default value.
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Extra Info
 

 
 

Extra Info is a bit like Options in other programs. You can check which items you want and in some cases, what text to
use.
 
The difference is that in Behold, you save these options into a Behold Organize file with all your other settings. Then
every time you run that Behold Organize file, you'll always have the options you want, and you can save lots of files
with different sets of options
 
The default selections are shown above with checkmarks in the boxes for the selected items, and empty boxes for the
unselected items.
 

Alternate Events
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The GEDCOM 5.5.1 standard suggests using separate events when there is conflicting information for the same
event, and recommends including the preferred one first in the GEDCOM file. However GEDCOM does not
differentiate between the same event with multiple event entries, and multiple events of the same type.
 
Behold treats just 4 specific events to be unique events that can only happen once. For a person, they can only
be born or die once (except maybe in science fiction). For a partnership, they can only be married once and
divorced once within one marriage. Yes, they can marry each other again after the divorce, but that should be
added as a second partnership. So within one partnership, there is only one marriage and one divorce.
 
Behold considers all other events in a person's life to be separate events, e.g. Education or Residence or
Census.
 
For the 4 events, Birth, Death, Marriage and Divorce, the first event (not necessarily the earliest) is considered
the primary (preferred) event. The others are called the alternate events.
 
This option allows to to specify whether to include the alternate events and the text to display before them.
Alternate events are not necessarily shown together, but are shown in date order mixed among the other events.
 
Here's an example of an alternative event along with it's primary event:
 

 

Current Age

For people who are still living or who have no death date, their age at the time the Everything Report is run is
calculated and is listed at the end of their individual information.
 
It will look like this:

 
This is not shown if people do not have a birthdate. Also see the "Would have been" option below. If the
person would be as old or older than the age specified in that option, then the current age is not printed, and
the "Would have been" option is printed instead.
 

Display Life Events

There is a menu and toolbar option to turn on and off the display of life events. But this can also be done here
in Report page.
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Generation Depth

 
Adds a generation number prefixed by the specified text to the beginning of separator lines. The default is to
not show it, e.g:

 
If you select it, then you'll get:

 

HTML Title

 
This is for the HTML file produced when you Export to HTML. There two settings let you set the webpage title
to what you want.
 
The first part of the title is set by the Title prefix which, by default, is "The Family of". You can then specify if
you want Behold to add the names of the main people in the file to be appended.
 
If both are selected, then your title in the McCarthy test file will look like:

 

ID Numbers

 
Level 0 records in GEDCOM files all have internal ID numbers. A level 0 line might look like this:

GEDCOM ID numbers are always between two 'at signs', so the ID number in this case is: I1.
 
Normally, you do not need to know the ID numbers of GEDCOM records. They normally will not have
meaning to you, but are just used to cross-reference records internally in the GEDCOM.
 
By default the option to show ID numbers is off and will not be displayed. However if the All Tags option is
selected, then the ID numbers will be displayed as hidden text in a grey color.
 
If you are familiar with GEDCOM files, and always want to include the GEDCOM IDs, then you can check this
option.

 

Show Possible Data Problems

 
Behold includes its data problems inline right with your data. Data problems are shown in red and are prefixed
by whatever text is given as the option here.
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Here's an example of a data problem:

 
The use of two asterisks (**) as a prefix allow you to easily search for data problems using Behold's find
function. If you use a lot of asterisks in your notes, you can change this to be another set of characters you can
look for, e.g. two plus signs (++).
 
This documentation has a list of all data problems that Behold can search for.
 

Max 100 Messages

 
Many GEDCOM files use non-standard GEDCOM formats. Behold can produce a message in the Log file for
every occurrance of those and other problems so that every single one of them can be identified.
 
But producing thousands of messages will slow down Behold's input processing. That's because Behold
writes each message to the log file as it occurs instead of buffering them. Buffering would speed this up, but if
for any reason Behold crashed, the Log file would not contain all messages up to the point the error occurred,
since they would not have been written from the buffer.
 
So to compensate, Behold by default will only include any one particular message in the Log file for its first
100 occurrences.
 
If you want, for any reason, to include the 101st and the rest of all these messages included in the Log file,
then simply uncheck this option.
 

Birth/death Years

 
By default, the name index will display birth and death years, like this:

 
If only the birth year or the death year is given, then only that year will be shown. If there is more than one
birth or death event for the person, then the year on the first event will be shown. If the person has neither a
birth date or death date specified, then then nothing is shown for the person.
 
If you don't want to show the birth and death years in the name index, then uncheck this option.
 

Married Names

 
This is a biggie. Behold by default adds all spouse surnames (where the spouse in the GEDCOM is
considered to be a "husband") to the end of the persons name in the GEDCOM file. The surname in the
GEDCOM file should only be their birth surname. Doing this will follow the culture of most Western societies
of the last few hundred years where wives took on their husband's surname. It provides very usefully
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information that allows you to more easily identify people, who are often known by their married surname(s)
rather than by their maiden name, e.g.:

 
Obviously, this will not be true for all people in many genealogies. Behold, when editing is added, will provide
a way to customize every individual marriage/partnership and allow overriding this option for individual
people.
 
Or you can uncheck this option, and only birth surnames (i.e. the surname included in the GEDCOM file with
the person) will be included in their name, e.g.:

 
The surnames shown will carry forward to the Name Index as well. If this option is checked, then all
surnames will be indexed. Otherwise, only the birth surname will be indexed.

Counts

 
By default, the number of nodes available for expansion under each TreeView entry, if there is at least one, is
shown in parenthesis in the TreeView:

 
By unchecking this option, the counts will not display:

 

Survived by

 
Anyone who died, who has both a birth date and a death date, will show a list of their close relatives who
were living on the date they died.
 
This is described more fully in the Survived By section of this Reference Guide.
 

Would have been

For people who are still living or who have no death date, their age at the time the Everything Report is run is
calculated and is listed at the end of their individual information. If they are younger than the age given in this
"Would have been" option, then their age is printed with the "As of" option (see above).
 
But if they would prove to be at least the age given in this option, then they are instead printed with a
statement that indicates they may not currently be living.
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It will look like this:

 
You should likely check these people to see if they may already have passed away. Note that they may have
events in their life at ages older than this age. Those events are still shown along with their age at the event.
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Common Dialog Windows
 
These are windows that are common in many programs that you are probably familiar with. They look and work in
Behold basically the same as in other programs.
 
However, they appear different in different Operating Systems, e.g. Windows Vista versus Windows 7 versus Windows
8 or 8.1.
 
The screenshots in this documentation are taken from Windows 8.1.
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Open File Dialog
 

 
The Open File dialog allows you to select the file(s) to open. They may be GEDCOM (.ged) files or Behold (.bho) files.
Behold Organize files tell Behold what GEDCOM files are to be opened along with how to display them.
 
Behold can open any number of GEDCOM files at one time, but you can only open one Behold Organize file.
 

Folder

The initial default folder used for the first time is the Behold Sample Files folder. After that, the last folder
opened is shown. The dropdown arrow will allow you to select from previously opened folders.

File List
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All files in the folder matching the file type are shown. If you've associated .ged and/or .bho files to Behold,
you will get the icons shown for these file types. Otherwise, your icons will be different.
 

File Name

When you select a file from the file list, it will be shown in the file name box. Or you can type into the box
yourself (with autocompletion). The drop down arrow will allow you to select from previously opened files.
 

File Type

By default, Behold will show all Behold and all GEDCOM files in the file list. The dropdown arrow allows you
to select from other options.
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Save As Dialog
 

 
The Save As dialog allows you to select the Behold Organize file to save the current Organize Information into.
 

Folder

The initial default folder used for the first time is the Behold Sample Files folder. After that, the last folder
opened is shown. The dropdown arrow will allow you to select from previously opened folders.
 

File List

All Behold Organize files in the folder are shown. If you've associated .bho files to Behold, you will get the
Behold Organize file icon that is shown. Otherwise, your icon will be different.
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File Name

When you select a file from the file list, it will be shown in the file name box. Or you can type into the box
yourself (with autocompletion). The drop down arrow will allow you to select from previously saved files.
 

File Type

Currently, you can only save to Behold Organize files. The ability to save to GEDCOM files will be added to
Behold prior to Version 2.0 when editing will be added.
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Find Dialog
 

 
This is the common Find Dialog, and is used in Behold to search the Everything Report.
 

Text to Find

Enter what you want here. It can contain spaces in it, and the spaces will be part of the text searched for.
 
If text is selected in the document when the Find command is called, then this field will be filled with the
selected text.
 

Whole Word

Check this box if you don't want the text to be part of a larger word.
 
e.g. Unchecked, it will select "babelfish", "mybabelfish" and "babelfisherman".  Checked it will only select
"babelfish".
 

Match Case

Check this box if you don't want the text to match all capital and small letters exactly. Leave it unchecked if
capitalization doesn't matter.
 
e.g. Unchecked, it will select "babelfish", "BabelFish" and "BABELFISH".  Checked it will only select
"babelfish".
 

Direction

Select the direction to look from the current position of the cursor in the Everything Report.
 
To go to the top of the file quickly to start from there, press Ctrl+Home. To go to the end of the file, press Ctrl
+End.
 
To quickly repeat a "Down" search, press F3. To quickly repeat an "Up" search, press F4.
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Print Dialog
 

 
This is the common Print Dialog, and is used in Behold to print all or a part of the Everything Report.
 
To preview what the print will look like, use the Print Preview command.
 
 

Select Your Printer

Select your printer and its properties the way you normally do for any print job.
 

Print Range

If you have a range selected in the Everything Report, then after you bring up the Print dialog, the Selection
button will be activated and chosen for printing.
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Otherwise (as shown above), the All option will be chosen to print the entire Everything Report. The page
range will tell you how many pages it will print, You can select the Page option and manually set "from" and
"to" to be the range you want.
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Other Windows
 

These are all the other windows that Behold can display.

A few of these windows have a Help button. If you press the F1 key in any of these windows, the help page in this
Reference Guide for that window will be opened.
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Print Preview Window
 

 
This is the Window that opens when you run the Print Preview command.
 

Page Navigation

Use these buttons to change the page the preview is viewing.
 

Page Range

Here you can see how many pages there are in total.
 

Magnification

Behold will auto select the correct sized preview that will fit the window, and will enter the magnification used
for the preview.
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You can either enter your own magnification, or select from the drop down box entries:

 

Page Image

The image is a very accurate representation of how the page will look when it is printed.
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Associate Window
 

 
This is the Window that opens when you run the Associate command.

 

Open With Behold

 
You can choose to make Behold your default program to open GEDCOM files or Behold Organize files. If you
do so, then the icons Windows uses to represent these two files will be as shown above.
 
You may or may not want to set Behold to be your default program to open GEDCOM files. Only do so if you
don't have another genealogy program that you primarily use.
 
Normally, you will want to associate Behold Organize files with Behold, since no other program uses them.
 
Note that if you install another genealogy program, it may take over the the default program status for
GEDCOM files without asking you. That is bad behavior. Behold will never do that, but requires that you make
the decision to set the defaults.
 

Use Current/Previous Association

Behold remembers the previous program that was associated with GEDCOM and Behold Organize files. If
you want to, you can go back to that previous association.
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Default Language Window
 

 
This is the Window that opens when you run the Default Language command. It specifies the default language file you
want to use when opening GEDCOM files.
 
This will not apply to Behold Organize files, which contain their own language information in them. To change the
language of a Behold Organize file, open the Behold Organize file, and then first on the Organize Tags page, merge
from your language file, and second on the Organize Report page, merge from your language file. Your Behold
Organize file will now include the information from that language file and you can save it for easy access later.

 

Use the Default

This box is checked if you want to use the default English language.
 

Your Language File

A language file is a Behold Organize file that only contains the text that should be used to display GEDCOM
Tags and Report information. This text is, of course, specific to the language of interest. You can think of this
as a translation file.
 
Various user-created language translation files are available free on the Behold download page at: http://
www.beholdgenealogy.com/download
 

Browse For It

Brings up an Open File dialog to allow you to locate where your translation file is. Note that you will have to
uncheck the default box prior to the Browse key becoming active.

http://www.beholdgenealogy.com/download.php
http://www.beholdgenealogy.com/download.php
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Find Files Window
 

 
This is the Window that opens when you run the Find Files command.
 
This window will search through the directories you specify to find all the files Behold can open and provides
information about these files. You can then double click on the files to easily open them with Behold.
 
The Find Files function is also available as a standalone program called the GEDCOM File Finder. It is available for
free at: http://www.beholdgenealogy.com/gedcomfilefinder
 
The advantages this being a standalone program is that you won't have to open Behold to access it, and it won't close
when you close Behold. Feel free to download and install it.
 

Type of File To Find

http://www.beholdgenealogy.com/gedcomfilefinder
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The default selection is to select all files with .ged extensions. Usually they will be GEDCOM files. GEDCOM
File Finder will always look in all .ged files when this is selected and will indicate in the Type column of the
Results Area what they are.
 
There are other choices on the dropdown box:

 
All Files:  Sometimes, GEDCOM files may have been renamed and have an extension other than .ged.
Selecting "All Files" will look at the beginning of every file to see if it is actually a GEDCOM file. Only those
files found to be GEDCOM files will be listed in the Results Area. Searching for All Files will take longer than
the GEDCOM Files search because every file will need to be opened to see if it is really a GEDCOM file.
 
All Files except *.ged:  Use this to find just those files that may have been renamed or have an extension
other than .ged.
 
Behold Organize Files:  This option only will appear if you have the program Behold installed on your
computer, and will allow you to search files with names ending in .bho which should be Behold Organize
Files.
 
Behold & GEDCOM FIles:  This option will only appear if you have the program Behold installed on your
computer, and will allow you to search files with names ending in .bho or .ged.
 
All Files except *.bho and *.ged:  This option will only appear if you have the program Behold installed on
your computer, and finds the files containing GEDCOM data that have non-standard extensions.

Directories to Look In

This is the directory you want to start looking in.  Click on the Browse button to help you find the directory you
want. Use the dropdown to select a directory you previously used.
 

Text in the Filename

If you know the name of your file, or part of the name, but just don't know where it is, you can enter that in
this box and only filenames with that text in the name will be listed. Use the dropdown to select text you
previously used. To select files of a given extension, e.g. .txt files, then enter the extension here.
 

Only Files Containing
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If you specify something in the "Files Contain" box, then the Results Area will only include files containing the
specified text string somewhere within the file. You may also add conditions to the text (match case and/or
whole word). You can use the dropdown to select text you previously used.

 
The "In What" selection will only appear if you have the program Behold installed on your computer. It allows
you to search for the text in Data Files (GEDCOM or Behold Organize files), in Behold Log Files, or in any
kind (All Files). If Behold is not installed, then you likely don't have any Behold log files to search and this
option is not required.
 
The text is a simple string with spaces allowed in it. There are no wildcards. It can be names, places or any
text that might or might not be in the files.
 
Specifying containing text will reduce the search speed since it every file will have to be scanned to see if it
contains the desired text.
 

Control buttons

Press "Find" to start the search. While searching, the "Stop" button becomes active and you can use it to
interrupt the search. Use "Clear" to clear the selection options and the search results area. Use "Help" to
display this help page.
 
Help is also available on the menu that appears if you click the right mouse button.
 

Animation

This little flashlight will move side to side while searching. This was just a fun thing I added and I liked it so I
kept it.
 

Results area

 
The results area include a number of fields with information about each file. This was actually created to help
find test files of certain types for Behold, and was left in to be a useful tool for anyone using Behold.
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You can sort by any column by clicking on the column header. Clicking the same header again will sort
in reverse order. The small arrow up or down (shown above at the right of the Path section of the column
header) tells you what is currently the sort column and whether it is sorted up or down.

 
You can make columns wider or narrower by grabbing and moving the small line between the column
headers, or you can double-click on that line to quickly make the column the right size to show the widest
entry.

 
There are other columns to the right. Use the horizontal scroll bar at the bottom of the Results Area to view
those columns. For the above example they look like this:

 
Each row contains:

 
1.     Name: the file name.

 
2.     Path: The folder it is in.
 
3.     Size: The size of the file.

 
4.     Date modified: The same as what Windows explorer gives you.

 
5.     Log File Date:  This column will only appear if you have the program Behold installed on your computer.
When you read a file with Behold, Behold creates a log file. The date and time the log file was created will be
in this column. This allows you to see the last time you loaded that file into Behold.
 
6.     Type: Tells you the type of file. The determination of the type of file is non-trivial, and makes use of
many of the best practices developed by Tamura Jones on his Modern Software Experience website at:
www.tamurajones.net. The type will identify and display important information about the file. Some genealogy
software may have trouble reading or not be able to some of these types of files. Type information includes:
 

GEDCOM - if it is a standard GEDCOM file
 
FTW TEXT - a file created by early versions of Family TRee Maker that used full-word descriptive
tags instead of short GEDCOM tags
 
Event GEDCOM - an alternative to GEDCOM created by CommSoft
 
GEDCOMsp - is a GEDCOM file, but the first line "0 HEAD" has a space at the end of the line, which
is technically illegal
 
Embedded GEDCOM - is a GEDCOM file where the file contains data prior to the "0 HEAD" line that
should be first. These files can be created by saving a web page that displays a GEDCOM file to
one's computer, or through other accidents.
 
Version number  - The version number of the above file types is displayed. GEDCOM File Finder can
display versions right back to GEDCOM 1.0 using the rules of Tamura Jones.

http://www.tamurajones.net
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(Not Version number) - The program may claim in its GEDCOM header to be one version, but it
sometimes states the wrong version. If this is so, then the incorrect version it states will be listed in
parentheses after the correct version, e.g.:  5.5.1 (Not 5.5) - GEDCOM File Finder only searches
the header section of the file and if it cannot disagree with the claimed version, then it will not be
corrected, e.g.:  5.5. If the program did not claim its version when it should have, then GEDCOM File
Finder will display:  (not provided)
 
LINEAGE_LINKED: The GEDCOM header should state in a specific place that it is LINEAGE-
LINKED (case does not matter, but the dash does). Some programs mispell the word. If they do, this
is displayed after the version number.
 
Nothing found - is displayed if none of the above is found in a file with a .ged extension.

7.     Program: This program and the version number of the program that created the file.
 

8.     Dest: This is the program that the GEDCOM was destined for. Some programs can export their
GEDCOM into slightly modified version of GEDCOM that will allow intended programs to read some data in
extended formats, but few do this properly. That doesn't really matter though, because most programs do not
do take into account the Dest value when reading the data.

 
9.     Char: This is the character set that the GEDCOM specifies it is using. Behold can read all the different
character sets. Legal character sets specified in GEDCOM files are: ANSEL, ASCII, UNICODE and UTF-8.
Illegal character sets include ANSI, IBM, ISO, LATIN, MAC and variations of both the legal and illegal sets.
Typically, most genealogy programs will read files with illegal character sets. Most illegal character sets use
the same coding for the basic alphabet, numbers and punctuation. But they may incorrectly display accented
characters and other special characters not in common with ASCII. 

 
10.     BOM (Byte Order Mark): These are extra characters that are added at the beginning of some files
to indicate the encoding of the characters in the file to the operating system. Unicode files usually require
these to allow correct interpretation of the particular Unicode format being used. BOMs for most GEDCOM
files include: none, UTF-8, UTF-16 big-endian, and UTF16 little-endian. The BOM may or may not conflict
with the character set specified in the GEDCOM file if the file was modified in some way, as the BOM and
overall encoding of the file can be changed by text editing, emailing, or other means. Usually the BOM can
be ignored because the operating system handles it invisibly, but it can cause problems for some genealogy
programs.
 

Selected File

Click on a filename with your mouse, and that will select it and it will be highlighted. 
 
Double-click on the filename and you will open it.  See the "Open button".
 
 

Open button

Opens the selected file with the program that is the default program on your computer for opening and
displaying the data in .ged (GEDCOM) files. You can also double-click on a file in the Results Area to open it.
 
Typically the genealogy software you use will set itself as that default program. If no default program is set
then GEDCOM File Finder will inform you. In that case, see if there is a way to set your genealogy software to
be that default program.
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If you have Behold on your computer, you can set Behold to be your default program through its Associate
Window.
 
Open is also available on the menu that appears if you click the right mouse button.
 

View button

Opens the GEDCOM file for the selected file in your default text file viewer. This way, you will see the actual
GEDCOM file. If no default is set on your computer, then Notepad will be used.
 
View is also available on the menu that appears if you click the right mouse button.
 

Log File button

This button will only appear if you have the program Behold installed on your computer. It will opens the
Behold log file for the selected file in your default text file viewer. If no default is set on your computer, then
Notepad will be used.
 
Log File is also available on the menu that appears if you click the right mouse button.
 

Status bar

Shows the progress during the search and shows final statistics after the search is completed. If you specify
something in the "Files Contain" box, then the status bar will additionally show how may files out of the files
found had that text.
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User Guide Window
 

 
This is the Window that opens when you run the User Guide command. The exact look and structure of this help may
vary depending on your version of Windows. The above image is from Windows 8.1.
 
This is a standard Microsoft Compiled HTML Help file, stored in the file: behold.chm.
 
An online version of Behold's User Guide is available at: http://www.beholdgenealogy.com/userguide

http://www.beholdgenealogy.com/userguide
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Good Ideas Window
 

 
This is the Good Ideas window. Other programs call it "Tip of the Day", but I like "Good Ideas" better. It will appear
whenever you start up Behold, until you uncheck the "Show this at startup" checkbox. There are a few useful tips for
new users of Behold listed here. You can manually bring up this window with the Good Ideas command.
 

Show At Startup

Once you've seen these, you'll want to turn them off so they don't annoy you every time Behold starts up.
 

Next Idea Button

Use this to quickly cycle through the ideas.
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Web Update Window
 

 
This is the Window that opens when you run the Check Online for a New Version command and there is a new version
available. By clicking the "Update" button, Behold will update to the new version for you. For the sequence of events
that occur after you press the "Update" button, see How To Upgrade to a New Version.
 
If no new version is available, you will see the following window instead:
 

 
If you select the "Check Automatically" option, then each time you start Behold, it will go to Behold's website and find
out what the is the latest version available. If a new version is available, then Behold will add "New version available"
onto the menu bar to the right of "Help" as shown here:

 

 
You can then click on the "New version available" menu item to bring up the Web Update Window and start the update
process.
 
The "New version available" menu item will also appear after manually checking for a new version, finding there is one,
but not doing the update.



Behold's User Guide - Web Update Window

- 269 -

 
Note: The "Check Automatically" option will only go to Behold's site to download a single one-line file that it uses to
compare with your version. Behold does not do anything else and does not track your accesses in any way.
 
Also, Behold will not perform this check unless you are already connected to the Internet. Behold will never connect
you to the Internet itself. When you do anything in Behold that requires Internet access when you are not connected, it
will ask you first if you want to connect with the following confirmation box:
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About Behold
 

 
This is the Behold information box that includes the version, license information, and link to the Behold website. It
opens when you run the About Behold command. It will also open when the program starts for those who have not
purchased Behold and entered their license key.

 

Your Version

This is the version of Behold that you are running and the date of that version.
 

Licensed User Information

 
When you first download Behold, the program is not yet licensed and you will see this instead:
 

 
You cannot run Behold until you enter your User name and license Key.  You can register online on the
Behold download page to get your key emailed to you.
 
 

How Many Genealogy Programs PromiseThis?



Behold's User Guide - About Behold

- 271 -

 

I Need A Name

This is Behold's logo. Bright, cheerful, and so far unnamed.
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Internal Error Window
 

 
Nothing is perfect, and Behold may have some programming errors in it. If you encounter an internal error (which can
be an out of range message or something like that), then an Internal Error window as shown here may pop up.
 

Internal Error Information

This shows what the error is, where in Behold it occured, and also has information about the Operating
System and the version of Behold. This will help to track down and correct the error.
 

Instructions
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If you get one of these Windows, I'd very much appreciate it if you would take the time to send it to me so that
I can try to fix the problem so that it won't occur for you or anyone else in the future.
 

Options On What To Do

Once this error window occurs, it is possible that some of Behold's memory space has been compromised.
You can try to continue, but depending on the severity of the error, other problems may occur and some
functions in Behold may cease to work. Your best bet is to exit Behold and restart. That will clean up the
address space and everything should be fine again.
 
If the same error continues to occur, then it is definitely something that needs to be fixed in Behold. Please let
me know about it.
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Input and Output Files
 

Behold works with files.

There are two types of files Behold can input that contain genealogy data:
- GEDCOM files (*.ged) - The commonly used file format for Genealogy data transfer.
- FTWText files (also *.ged) - A similar file format to GEDCOM but with different Tags.

For each *.ged file, Behold produces a log file:
- Log files (*.ged.log) - Contains information and messages about what was encountered during input.

Behold allows you to save your settings and then reload them:
- Behold Organize files (*.bho) - Contains links to your data and information on how to organize it.

(Note that Language Translation files for Behold are simply Organize Files)

There are currently two export formats:
- HTML files - to display the Everything Report in a web browser and/or on a web site.
- RTF files - to be able to load the Everything Report in a word processing program.

(Note: GEDCOM export will be added soon, prior to Version 2.0 and editing)
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GEDCOM Files (.ged)

 
A GEDCOM file (pronounced "Jed-com") is an acronym for GEnealogical Data COMmunications and is a standard file
format that genealogy applications use to share data. They usually use the ".ged" suffix on their filename.
 
Behold reads in GEDCOM files, interprets them for you, and presents them logically in its Everything Report.
 
GEDCOM files are sometimes problematic because not all genealogy programs export or import them perfectly. As
a result, data does not always transfer smoothly using GEDCOM files. Behold is a very flexible GEDCOM reader
allowing many variations and displays every bit of data that is possible to display. Behold also produces a log file that
identifies problems with the GEDCOM file.
 

A GEDCOM Line

 
Most GEDCOM lines contain 3 parts.  A level number, a GEDCOM tag, and a data item or pointer.
 
In the above example, the level number is 1. Information at level 1 belongs to records at level 0. Information
at level 2 belongs to the information at level 1, etc.
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A GEDCOM Record

 
GEDCOM records begin with a level 0 line and include all the data up to the next level 0 line which starts
the next record. A record is a complete unit. The above example has a HEAD record (GEDCOM Header), a
SUBM record (LDS Submission), and an INDI record (information about an individual, i.e. a person).
 
All records (except the HEAD and TRLR records) have a record ID. Record ID's are surrounded by "@"
characters. The record ID for the above SUBM record is "S0" and the record ID for the above INDI record is
I1.
 

Events and Facts

 
Most level 1 lines contain an event or a fact. The subsequent lines, with a level greater than 1, add
information about the fact. Each tag has a meaning, and Behold lets you specify which tags to include and
the how to display them on the Organize Tags page.
 

A Pointer

 
Sometimes a GEDCOM line has a pointer after the tag. A pointer is the ID of the record that it points to. In
this example, this line points to a source record with the ID S64.  Here is the source record that the above
pointer points to:
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Log File
 

The Log files lists information about the input file. You use the View Log File(s) command to view the Log file, and it is
opened in your default text file viewer,
 
Behold does a lot of checking of the data for non-standard GEDCOM structures and for data problems that need your
correction. The next page of this User Guide contains a complete list of the messages Behold can generate in the Log
file.
 

Filename
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The log file by default will be the GEDCOM file name with ".log" appended on the end. This makes it easy
to identify the log file for any GEDCOM file and it will follow the GEDCOM file in a Windows Explorer
alphabetical listing of a directory.
 

Preamble

Preamble is a great word to mean the beginning of a file. The log file starts with "how", "who" and "when", and
then goes into "what" and gives info about the "what".
 

Input Messages

 
Behold will list everything that it finds that is not quite right in the input file. Each message consists of:
 
1.  The line number in the GEDCOM file followed by a colon. e.g. 246:
 
2.  The GEDCOM line in question, e.g. 2 MAP
 
3.  The message, preceeded by two asterisks to set it off, along with an indication as to how Behold will handle
this.
 
4.  The number of occurrences so far of this message, in parenthesis preceeded by #, e.g.: (#1)
 
Many messages are simply incorrect GEDCOM syntax that Behold understands and interprets properly. These
messages are included in the log file to let you know what is non-standard about the GEDCOM file, because
other programs may not be able to read them. Because of this, you should be aware that you may lose this data
if you read this into other programs.
 
Behold understands many exceptions and extensions to GEDCOM. Behold will read all of your data, and is
unaffected by the problems in the file that are listed.
 

The Rest Of It
Following the messages is additional summary information:
 
1.  A summary of all Messages, with the count of the number of each message in parenthesis , e.g.:
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2.  Summary of GEDCOM Tags with the text they'll display as,and the number of each. The tags are divided into 3 sections: Records,
Pointers and Data Tags, e.g.:

     
          ...

     
 
3.  Processing Time, e.g.:
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Behold Organize Files (.bho)
 

A Behold Organize file contains all the information in the five Organize Pages that define what to display and how to
display it in Behold's Everything Report.
 
The GEDCOMs page tells what files to load. The Families page says how to arrange the families. The Numbering
Page defines how they'll be numbered and ordered. And the Tags page and Report page says what data to include
and various text strings to use.
 
The Behold Organize file contains all this. It does so, but only includes items that changed from their default value.
That keeps the file smaller, and allows for a default to be changed in the future with effect, if that happens to be
necessary.
 
Behold Organize files use the suffix ".bho", and they are text files. Physically, they use the old ".ini" file format using in
early versions of Windows. That just happened to be a simple format that was convenient and easy to implement. It
also allowed for manual editing during Behold testing.
 
Normally you would not want to look at a Behold Organize file. But if you did, here is what it looks like:
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What Behold Organize files do is give you great flexibility. You can have many different .bho files describing different
ways to present the data from a single GEDCOM. Or, you can use .bho files to load several files together and view
them different ways.
 
After this information is stored in a Behold Organize file, you can load the Behold Organize file to recreate the
Everything Report just as you had it.
 
Language Translation Files are nothing more than Behold Organize files that contain just redefinitions in a new
language of the Tag text and Report text. This User Guide has instructions on How To Create a Translation File and
How To Use a Translation File. An example of a language translation file is:
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HTML Export
 

 
HTML (HyperText Markup Language) is a format used for web pages. Behold can produce HTML output that can
then be put up on a website. This is done with the File -> Export -> HTML command. The webpage reproduces the
Everything Report almost exactly.
 
Behold produces the HTML output as a single web page. Currently there is no option to produce the output as multiple
pages.
 
Note that very large genealogy files will correspondingly result in very large HTML files. Web browsers may have
trouble loading very large HTML files.

 

Webpage Title
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You can set the webpage title to what you want with the on the Organize Report page using the HTML Title
settings.
 

Filename

 
This is where the HTML file is physically located. It can have the .html or .htm or .shtml or any other legal file
suffix that works in web browsers.
 

The HTML Output

 
The HTML output looks almost exactly the same in a web browser as the Everything Report looks in Behold.
Behold makes use of embedded CSS (Cascading Style Sheets) in the HTML file to do this.
 

Hyperlinks

The hyperlinks in the HTML output all work properly. Most hyperlinks are blue in most browsers. When the
mouse is over a hyperlink, the hyperlink may change color, may get underlined, and the cursor may change
to a pointer, e.g.:
 

 



Behold's User Guide - RTF Export

- 284 -

RTF Export
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RTF (Rich Text Format) is a format used for word processing files. Behold can produce RTF output that can be read
into most Word Processor programs. This is done with the File -> Export -> RTF command. The webpage reproduces
the Everything Report almost exactly.
 
Behold produces the RTF output as a single document, with page breaks between major sections.
 
Note that very large genealogy files will correspondingly result in very large RTF files. Word Processors may have
trouble loading very large RTF files.

 

Filename

This is the name of the file being viewed.
 

The RTF Output

 
The RTF output looks almost exactly the same in a web browser as the Everything Report looks in Behold.
 

Hyperlinks

The hyperlinks in the RTF output all work properly. In Microsoft Word, you use Ctrl+Click to follow a hyperlink.
 

Page Breaks
Major sections in the document begin with a page break so they can start conveniently on a new page.
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Data Problems
 

Behold does lots of checking of your data. There are currently two types of messages:
 
1.  Possible Data Problems are indications of something that is likely wrong in the data. You'll want to look at
these and fix those needing to be fixed. They are shown in red and included in the Everything Report with
your data where the error is. An example is:
           
An easy way to scan for these reported problems is to search for the double asterisk ** using the Find tool. 
If you want, you can change the ** to something else from the "Indicate data problems" item in the Organize
Report page.

 
2.  GEDCOM messages are non-standard constructs in the GEDCOM file. Behold can understand these,
but other programs may not and those other programs may not read that data correctly from the GEDCOM
file. Errors indicate invalid GEDCOM. Warnings are for valid constructs that may not be handled by many
programs. These messages are listed in the log file along with the GEDCOM line the message pertains to and
an explanation of what Behold does about the problem. An example is:
         

These messages provide the line number from the GEDCOM file, the GEDCOM line, the message, what
Behold will do about it, and in parenthesis the message number of this type of message.
GEDCOM messages are also summarized in alphabetical order at the end of the File Information section near
the end of the Everything Report. It lists each message type and the count of them. An example is:

 
Below is the list of all the data problems that Behold will report.
 

 
These are the Possible Data Problems:
 
Invalid Date:
**Calendar Roman is invalid
**Calendar unknown
**Date invalid
**Date >= second date
**Day > days in month
**Double year is not 1582 to 1918
**Double year is not consecutive
**Double year only valid with Gregorian calendar
**Double year must have 2 digits after slash
**Double year not allowed with B.C. dates
**Interpreted date must be followed by original in parenthesis
**Word after first date can only be "AND"
**Word after first date can only be "TO"
**Month must be in leap year
**Month invalid
**Month invalid for Hebrew calendar
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**Month requires Hebrew calendar
**Month invalid for French calendar
**Month requires French calendar
**Month not allowed with B.C. dates
**Year is missing
**Year must be 3 or 4 digits
 
Date Consistency Checking:
**Occurs in the future
**Occurs before birth
**Occurs before marriage
**Occurs after marriage
**Occurs when old > 106
**Occurs before death
**Occurs after death
**Occurs too long after death
**Occurs before child-bearing age < 14
**Occurs after child-bearing age > 56
 
Self-Referential
**Ancestral loops need to be fixed
**Self-related as own
 

 
These are all the GEDCOM messages:
 
Error: This FAM record has HUSB and WIFE links that point to more than 2 people. Behold will accept them
all.
Error: This FAM record has 2 HUSB links but GEDCOM only allows 1 HUSB link. Behold will accept them all.
Error: This FAM record has 2 WIFE links but GEDCOM only allows 1 WIFE link. Behold will accept them all.
Warning: This FAM record has CHIL records with birth dates out of order. Behold will reorder the child.
Warning: This INDI record has FAMS records with marriage dates out of order. Behold will reorder the
marriage.
Warning: This INDI record has FAMS records with an inconsistent spouse death date. Behold will reorder the
marriage.
Error: This line has no level number and/or no tag. Behold will ignore the line.
Error: A valid HEAD record is not at the start of this file. Behold will assume a HEAD record and continue
reading.
Error: This record is referred to, but the record has not been defined. Behold will generate the record.
Error: A TRLR record is not at the end of this file. Behold will display what it found.
Error: An EOF record is not at the end of this file. Behold will display what it found.
 
Warning: This is a PAF date phrase. Behold will convert it to a NOTE.
 
Warning: This line contains one or more invalid Unicode character codes. Behold will read what it can.
Warning: This line contains invalid UTF-8 character codes. Behold will read what it can.
Warning: This line contains invalid UTF-8 character codes. Behold has replaced it with the Unicode
"replacement character".
 
Warning: The character set is ANSEL, but the file has a Byte Order Mark. Behold will read the file as ANSEL.
Warning: The character set is UTF-8, but the file Byte Order Mark is missing. Behold will read the file as
UTF-8.
Warning: The character set is UTF-8, but the file Byte Order Mark is not UTF-8. Behold will read the file as
UTF-8.
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Warning: The character set is Unicode, but the file Byte Order Mark is missing. Behold will read the file as
Unicode.
Warning: The character set is not UTF-8 or Unicode, but the file has a Byte Order Mark. Behold will read the
file in the character set specified by the Byte Order Mark.
Error: The character set is not specified in the header. The file has a a Byte Order Mark. Behold will read the
file in the character set specified by the Byte Order Mark.
Error: The character set is not specified in the header. The file does not have a Byte Order Mark. Behold will
read the file as ANSEL.
Warning: An illegal HEX 00 character is embedded in this line. Behold will display this character as a period.
 
Error: This link has already been defined. Behold will combine the data for these links.
Error: This record has already been defined. Behold will create a new record.
Error: There is extra data on the HEAD record. Behold will ignore it.
Error: This blank or invalid line is after the TRLR record. Behold will ignore it.
Error: There is extra data on this level 0 record. Behold will include and display this.
Error: This possibly valid line is after the TRLR record. Behold will attempt to process this.
Error: There is extra data on the TRLR record. Behold will ignore it.
Error: There should be no blank lines. Behold will ignore it.
Error: This line should not be indented. Behold will ignore the leading spaces and tabs.
Error: This line including the end of line delimiter is longer than 255 characters. Behold will read the entire line.
Error: This tag is missing a required link to a record (enclosed in "@"). Behold will treat any data value on the
line as a data value for that tag.
Error: The note text should begin on the NOTE record. Behold will allow this.
Error: There is no place name on the PLAC tag. Behold will assign "unspecified".
Error: There is no record type on this level 0 record. Behold will include it as an unspecified record type.
Error: This FAM record has a HUSB or WIFE link that points to this INDI record, but the INDI record does not
link back with a FAMS link. Behold will assign the link back.
Error: This FAM record is pointed to by a FAMS link in this INDI record but does not link back with a HUSB or
WIFE link. Behold will assign the link back.
Error: This FAM record has a CHIL link that points to this INDI record, but the INDI record does not link back
with a FAMC link. Behold will assign the link back.
Error: This FAM record is pointed to by a FAMC link in this INDI record but does not link back with a CHIL link.
Behold will assign the link back.
 
Error: There is no space between the identifier and the tag. Behold will allow this.   { In a GEDCOM 2.0 file
gedr283.ged }
Error: This tag is not allowed to be used to define a GEDCOM level 0 record. Behold will allow this.
Error: Invalid GEDCOM tag. Behold will accept this tag.
Error: This tag is not a valid FTW TEXT tag. It is not a GEDCOM tag either. Behold will accept this tag.
Error: This tag is not a valid FTW TEXT tag, but it is a GEDCOM tag. Behold will accept this tag.
Error: Tag includes lowercase letters. Behold will try using the uppercase equivalent.
Warning: There is no text on the line to Concatenate. Behold will ignore this line.
Error: Tag was not added to GEDCOM until Version 5.4 Behold will accept this tag.
Error: Tag was not added to GEDCOM until Version 5.5 Behold will accept this tag.
Error: Tag was not added to GEDCOM until Version 5.5.1 Behold will accept this tag.
Error: Tag was removed from GEDCOM Version 5.3 and later. Behold will accept this tag.
Error: Tag was removed from GEDCOM Version 5.4 and later. Behold will accept this tag.
Error: Tag was removed from GEDCOM Version 5.5 and later. Behold will accept this tag.
Error: Tag was removed from GEDCOM Version 5.5.1. Behold will accept this tag.
Error: Tag was removed from GEDCOM Version 2.1. Behold will accept this tag.
 
Error: Invalid date. Behold understands the problem and is able to use this as a date.
Error: Invalid date. Behold will not use this as a date but just as text.
Error: This date value is longer than the 35 characters allowed in GEDCOM 5.5 or 5.5.1. Behold will accept
this.
Error: This date value is longer than the 90 characters allowed in GEDCOM 5.4 and earlier. Behold will accept
this.
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Warning: This is a GEDCOM EL file that includes extensions to GEDCOM. Behold will correctly read this file
including its extensions.
Warning: This version of GEDCOM is not the standard 5.5 or the de facto standard 5.5.1. Behold will correctly
read this version of GEDCOM.
Warning: This an FTW TEXT file. It is not a GEDCOM file. The FTW tags will be mapped to their GEDCOM
equivalent. Behold can read this file amd will map the FTW tags onto their GEDCOM equivalents. Most
programs won''t.
Warning: This is a GEDCOM 2.0 file. It is very different than later GEDCOM files. Behold can read this file.
Most programs won''t.
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Editing Data
 

Behold will be a lot of help to you when editing of data is added in Version 2.

This aspect of Behold is what will set it apart from all other programs. Its unrestricted formless data entry will feel like a
word processor and will allow you to enter your data in a fraction of the time it would take you in other programs. The
efficient Ribbon that Microsoft invented for its Office suite of products will allow easy selection of input and editing options.

I am very excited about this myself. My many boxes full of source material in my closet are waiting impatiently for me
to complete this.
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Keyboard Shortcuts
 

Shortcuts in the Main Window

Ctrl+N:  File -> New
Ctrl+O:  File -> Open
Ctrl+S:  File -> Save
Ctrl+P:  File -> Print
Alt+F4:  File -> Exit

Ctrl+Z:  Edit -> Undo
Shift+Ctrl+Z:  Edit -> Redo
Ctrl-X:  Edit -> Cut
Ctrl-C:  Edit -> Copy
Ctrl-V:  Edit -> Paste

Ctrl+F: Search -> Find
F3:  Search -> Find Next
F4:  Search -> Find Previous

Ctrl+Home:  Navigate -> Top of File
Ctrl+End:  Navigate -> Bottom of File
Alt+Left:  Navigate -> Back
Alt+Right:  Navigate -> Forward
Esc:  Navigate -> Stop

F9:  View -> Behold Organize Info
F10:  View -> View GEDCOMs
F11:  View -> View Log Files(s)

F1: Context Sensitive Help

Additional Shortcuts in the Everything Report

Ctrl+Home:  Go to the start of the report
Ctrl+End:  Go to the end of the report

Home:  Go to the end of the line
End:  Go to the start of the line

Page down:  Scroll the TreeView down a page
Page up:  Scroll the TreeView up a page

Arrow down:  Go down to the next visible entry
Arrow up:  Go up to the previous visible entry
Arrow left:  Go left one character
Arrow right:  Go right one character

Insert:  Switch between Insert and Overstrike editing mode

Shortcuts for the TreeView

Plus key:  Expand one level below the current selection
Minus key:  Collapse one level below the current selection
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Times key:  Expand all levels below the current selection
Divide key:  Collapse all levels below the current selection

Right arrow:  If not expanded, then expand one level below current selection. Otherwise move to the first child
Left arrow:  If not collapsed, then collapse one level below current selection. Otherwise move to the parent.

Home:  Go to the first entry
End:  Go to the last entry

Page down:  Scroll the TreeView down a page
Page up:  Scroll the TreeView up a page

Arrow down:  Go down to the next visible entry
Arrow up:  Go up to the previous visible entry

Backspace:  Move up to the parent
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